
3746 Nways Multiprotocol Controller
Models 900 and 950
(For CCM Version F64810) ���

 

Controller Configuration
and Management
User's Guide

 
 
 
 SH11-3081-08



 



3746 Nways Multiprotocol Controller
Models 900 and 950
(For CCM Version F64810) ���

Controller Configuration
and Management
User's Guide

 
 
 
 SH11-3081-08



  
 

 Note 

Before using this information and the product it supports, be sure to read the general information under “Notices”
on page xiii.

Ninth Edition (September 2000)

This edition applies to the Controller Configuration and Management application (CCM) Version F64810 and to all subsequent
releases and modifications until otherwise indicated in new editions.

Order publications through your IBM representative or the IBM branch office serving your locality. Publications are not stocked at the
address given below.

A form for readers’ comments appears at the back of this publication. If the form has been removed, address your comments to:

Department CGFA
Design & Information Development
IBM Corporation
PO Box 12195
Research Triangle Park NC 27709
U.S.A.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information in any way it believes
appropriate without incurring any obligation to you.

 Copyright International Business Machines Corporation 1996, 2000. All rights reserved.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.



  
 

 Contents

Notices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiii
Trademarks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiv

About This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xv
Who Should Use This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xv
How This Guide Is Organized . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xv

Conventions Used in This Guide . . . . . . . . . . . . . . . . . . . . . . . . .  xvi
| What Is New in This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xvii

Additional Information on the Web . . . . . . . . . . . . . . . . . . . . . . . . . .  xvii
Year 2000 Statement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xvii

Part 1. Introducing the CCM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Chapter 1. Welcome to the CCM . . . . . . . . . . . . . . . . . . . . . . . . . .  3
Operating Environments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Service Processor Environment . . . . . . . . . . . . . . . . . . . . . . . . . . .  4
Stand-Alone Environment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Installing CCM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
CCM Levels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Level compatibility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Installing CCM in Service Processor Environment . . . . . . . . . . . . . . . .  8
Installing CCM in the Stand-Alone Environment . . . . . . . . . . . . . . . . .  8

CCM Password Protection from MOSS-E . . . . . . . . . . . . . . . . . . . . . . .  8
Starting the Service Processor CCM . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Starting the Stand-Alone CCM . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Stopping and Exiting from CCM . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Becoming Familiar with the Main Panel . . . . . . . . . . . . . . . . . . . . . . .  10

Menu Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Header Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Coupler Icons  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Information Area  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Working in the Main Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12
Working with the Main Panel Menu Choices . . . . . . . . . . . . . . . . . .  12
Working with the Coupler Icons . . . . . . . . . . . . . . . . . . . . . . . . . .  12
Working from the Pull-Down Menus . . . . . . . . . . . . . . . . . . . . . . .  13

Chapter 2. About the Configuration Process . . . . . . . . . . . . . . . . . .  15
An Easier Way to Configure . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
What You Can Do with a CCM Configuration . . . . . . . . . . . . . . . . . . .  17

Creating Configuration Files . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
Modifying Configuration Files . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
Copy a Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18
Export/Import a Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . .  18
Activate a Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

Configuring the Controller . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18
Creating a Configuration in Different Environments . . . . . . . . . . . . . . . .  19

In the Service Processor Environment . . . . . . . . . . . . . . . . . . . . . .  20
In the Stand-Alone Environment . . . . . . . . . . . . . . . . . . . . . . . . .  21

 Copyright IBM Corp. 1996, 2000  iii



  
 

Chapter 3. Performing Generic Configuration Tasks . . . . . . . . . . . . .  23
A Word about the Buttons, Worksheets, and Online Help . . . . . . . . . . . .  23

The Generic Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23
Getting Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

Generic Configuration Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26
Creating a New Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . .  26
Importing an ESCON Configuration . . . . . . . . . . . . . . . . . . . . . . . .  26
Viewing a List of Available Configurations . . . . . . . . . . . . . . . . . . . .  27
Importing a CCM Configuration . . . . . . . . . . . . . . . . . . . . . . . . . .  28
Opening and Modifying a Configuration . . . . . . . . . . . . . . . . . . . . .  28
Saving a Configuration to Diskette or Hard Disk . . . . . . . . . . . . . . . .  29
Activating a Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29
Migrating Configurations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Moving the MAE Coupler Connection . . . . . . . . . . . . . . . . . . . . . .  29

Working with the CDF-E . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Comparing Couplers and Ports in a Configuration with a Reference CDF-E  31
Setting or Clearing the Coupler Type . . . . . . . . . . . . . . . . . . . . . . .  32
Loading a CDF-E . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Chapter 4. Working with the CCM Configuration Files from a Remote
Workstation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Using the File Transfer Facility . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35
File Transfer Major Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35
Using the Java Console Program . . . . . . . . . . . . . . . . . . . . . . . . .  37
Using DCAF  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

| Using the CCM Remote Configuration Application on AIX Software . . . . . .  40
What You Need . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Installing the Client Workstation . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Checking or Customizing the User Information . . . . . . . . . . . . . . . . .  41
Before You Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Starting the Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Starting the Client Application . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Connecting to the Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Switching Between the Local and Remote Environments . . . . . . . . . . .  43
Listing the Configuration Files . . . . . . . . . . . . . . . . . . . . . . . . . . .  43
Downloading a Remote Configuration . . . . . . . . . . . . . . . . . . . . . .  43
Extracting the ASCII Configuration Files . . . . . . . . . . . . . . . . . . . . .  44
Creating a New CCM Configuration . . . . . . . . . . . . . . . . . . . . . . .  44
Checking a Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44
Uploading a Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Activating a Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Choosing the Interactive or Script Mode . . . . . . . . . . . . . . . . . . . . .  45
Summarizing the Commands . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

| Using the CCM Remote “light” Configuration Application on OS/2 . . . . . . . .  48
| What You Need . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48
| Installing the Client Workstation . . . . . . . . . . . . . . . . . . . . . . . . . .  48
| Checking or Customizing the User Information . . . . . . . . . . . . . . . . .  48
| Before Using the CCM Remote “light” Configuration Application . . . . . . .  49
| User Operations Description . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

Part 2. Resource Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Chapter 5. Beginning a CCM Configuration . . . . . . . . . . . . . . . . . .  57

iv 3746-9X0: CCM User's Guide  



  
 

Configuring Stations on Coupler/Port 2080 . . . . . . . . . . . . . . . . . . .  59

Chapter 6. Configuring an ESCON Coupler . . . . . . . . . . . . . . . . . . .  61
Before You Start... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

If You Need Help... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61
Configuring the ESCON Port Parameters . . . . . . . . . . . . . . . . . . . .  61
Configuring the ESCON Host Link Parameters . . . . . . . . . . . . . . . . .  64
Configuring ESCON Station Parameters . . . . . . . . . . . . . . . . . . . . .  65

Chapter 7. Configuring a Token-Ring Coupler . . . . . . . . . . . . . . . . .  69
Before You Start... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69

If You Need Help... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
Configuring Token-Ring Ports . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
Configuring Token-Ring Stations . . . . . . . . . . . . . . . . . . . . . . . . .  73

Chapter 8. Configuring Serial Line SDLC Resources . . . . . . . . . . . . .  77
Before You Start... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  77

If You Need Help... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  77
Configuring the SDLC Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  77
Configuring SDLC Stations . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80

Chapter 9. Configuring Serial Line Frame-Relay Resources . . . . . . . .  83
Before You Start... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83

If You Need Help... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83
Configuring a Frame Relay Port . . . . . . . . . . . . . . . . . . . . . . . . . .  83
Defining Frame-Relay DLCIs and Stations . . . . . . . . . . . . . . . . . . . .  88
Configuring APPN over Frame-Relay Stations . . . . . . . . . . . . . . . . .  91
Configuring Frame-Relay Frame Handler Sets . . . . . . . . . . . . . . . . .  94

Chapter 10. Configuring Serial Line PPP Resources . . . . . . . . . . . . .  95
Before You Start... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95

If You Need Help... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95
Configuring a PPP Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95

Chapter 11. Configuring Serial Line X.25 Resources . . . . . . . . . . . . .  99
Before You Start... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  99

If You Need Help... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  99
Configuring a X.25 Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  99
Configuring X.25 Stations . . . . . . . . . . . . . . . . . . . . . . . . . . . .  103

Chapter 12. Configuring the MAE . . . . . . . . . . . . . . . . . . . . . . . .  107
Before You Start... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  107
Understanding the Navigation and Configuration Panels . . . . . . . . . . . .  107

Using the MAE through the MOSS-E . . . . . . . . . . . . . . . . . . . . . .  108
The Navigation Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  108
The Configuration Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110

Navigating Through the MAE Configuration Program . . . . . . . . . . . . . .  112
Using the Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  112
Using the Keyboard in the Configuration Program . . . . . . . . . . . . . .  113
Selecting Multiple Items in a List . . . . . . . . . . . . . . . . . . . . . . . .  114

Chapter 13. Configuring IP Parameters . . . . . . . . . . . . . . . . . . . .  115
Configuring General IP Parameters . . . . . . . . . . . . . . . . . . . . . . . .  115

General IP Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  115

  Contents v



  
 

PPP NCP Default Parameters . . . . . . . . . . . . . . . . . . . . . . . . . .  115
IP Static Routes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116
IP Access Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116
IP Filters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
IP Route Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116
Bootp Forwarding Parameters . . . . . . . . . . . . . . . . . . . . . . . . . .  116

Configuring OSPF Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . .  117
OSPF General and Multicast Parameters . . . . . . . . . . . . . . . . . . .  117
OSPF Parameters for Each IP Address . . . . . . . . . . . . . . . . . . . .  117
OSPF Areas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
OSPF Imported and Default Routes . . . . . . . . . . . . . . . . . . . . . .  118
OSPF Virtual Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  118

Configuring RIP Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . .  119
RIP General Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  119
RIP Parameters for Each IP Address . . . . . . . . . . . . . . . . . . . . . .  119

Configuring BGP Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . .  120
BGP General and Excluded AS Parameters . . . . . . . . . . . . . . . . . .  120
BGP Receive Policies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  120
BGP Send Polices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  120
BGP Originate Policies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
BGP Neighbors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
BGP Aggregate Routes . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121

Configuring ARP Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
ARP Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Configuring SNMP Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
SNMP Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Make Sure SNMP Access Is Enabled When Filtering Packets . . . . . . .  122

Chapter 14. Configuring APPN Parameters . . . . . . . . . . . . . . . . . .  123
Configuring General APPN Parameters . . . . . . . . . . . . . . . . . . . . . .  123

Coupler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Network Nodes, Focal Points, and DLURs . . . . . . . . . . . . . . . . . .  124
Network Node Characteristics . . . . . . . . . . . . . . . . . . . . . . . . . .  124
Backup Focal Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  124
Rapid Transport Protocol/Path Switch Parameters . . . . . . . . . . . . . .  124
Coupler/Port 2080 Stations . . . . . . . . . . . . . . . . . . . . . . . . . . .  125
3745/3746  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Frame-Relay Frame Handler Set . . . . . . . . . . . . . . . . . . . . . . . .  125

Configuring Specific APPN Parameters . . . . . . . . . . . . . . . . . . . . . .  125
Adjacent Node Remote LUs . . . . . . . . . . . . . . . . . . . . . . . . . . .  126
Session Mode Classes of Service . . . . . . . . . . . . . . . . . . . . . . .  126
Classes of Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  126
Node Rows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Transmission Group Rows . . . . . . . . . . . . . . . . . . . . . . . . . . . .  127
Multilink Transmission Group . . . . . . . . . . . . . . . . . . . . . . . . . .  127
Specifying Multilink Transmission Group Stations . . . . . . . . . . . . . .  127

Part 3. Resource Management  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

Chapter 15. Dynamic Activation and How It Affects Your Network . . .  131
Dynamically Activating Modifications to a Configuration While Saving . . . .  131

Network Traffic Disruption and Dynamic Activation . . . . . . . . . . . . . .  133

vi 3746-9X0: CCM User's Guide  



  
 

Chapter 16. Resource Management  . . . . . . . . . . . . . . . . . . . . . . 139
Management Using Resource Filters . . . . . . . . . . . . . . . . . . . . . . .  140
Managing Ports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

Displaying a List of Configured Ports . . . . . . . . . . . . . . . . . . . . . .  141
Displaying the Resources on a Selected Port . . . . . . . . . . . . . . . . .  141
Viewing Details of a Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  142
Displaying the Connectivity Counters . . . . . . . . . . . . . . . . . . . . . .  142
Activating and Deactivating Ports . . . . . . . . . . . . . . . . . . . . . . . .  143
IP Resource Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145

Managing Stations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Displaying a List of Configured Stations . . . . . . . . . . . . . . . . . . . .  148
Displaying a List of Sessions for a Selected Station . . . . . . . . . . . . .  149
Viewing the Details of a Station . . . . . . . . . . . . . . . . . . . . . . . . .  149
Activating and Deactivating Stations . . . . . . . . . . . . . . . . . . . . . .  149

Displaying Information about Sessions . . . . . . . . . . . . . . . . . . . . . .  152
IP-Specific Port/Processor Commands . . . . . . . . . . . . . . . . . . . . . .  153

Available Commands Depend on IP Resource DLC . . . . . . . . . . . . .  154
CCM IP Results Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  154
Buffer Use and Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  155
Protocol and Port Configurations . . . . . . . . . . . . . . . . . . . . . . . .  155
ESCON and Token-Ring Port Dump . . . . . . . . . . . . . . . . . . . . . .  155
Current Processor Memory Use . . . . . . . . . . . . . . . . . . . . . . . . .  155
Port Queue Length . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  155
All Parameters of a X.25 Port . . . . . . . . . . . . . . . . . . . . . . . . . .  156
X.25 Physical Level Port Parameters . . . . . . . . . . . . . . . . . . . . . .  156
X.25 Frame Level Port Parameters . . . . . . . . . . . . . . . . . . . . . . .  156
X.25 Packet Level Port Parameters . . . . . . . . . . . . . . . . . . . . . . .  156
Error Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Interface Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
All X.25 Port Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  157
X.25 Physical Level Port Statistics . . . . . . . . . . . . . . . . . . . . . . .  157
X.25 Frame Level Port Statistics . . . . . . . . . . . . . . . . . . . . . . . .  157
X.25 Packet Level Port Statistics . . . . . . . . . . . . . . . . . . . . . . . .  157
All Statistics for a Serial Line Interface . . . . . . . . . . . . . . . . . . . . .  158
Statistics for a DLCI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  158
LMI Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158
Frame-Relay Physical Line Parameters . . . . . . . . . . . . . . . . . . . .  158
Frame-Relay COMRATE Parameters . . . . . . . . . . . . . . . . . . . . .  158
Frame-Relay DLCI IP Address . . . . . . . . . . . . . . . . . . . . . . . . .  159
X.25 PVC Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  159
SVC Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
X.25 IP Address Table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  159
PPP IP Control Protocol Information . . . . . . . . . . . . . . . . . . . . . .  159
PPP Link Control Protocol Information . . . . . . . . . . . . . . . . . . . . .  159
PPP Error Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
PPP Link IP Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
PPP IP Control Protocol Statistics . . . . . . . . . . . . . . . . . . . . . . .  160
General Port Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
Clearing Statistics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
Router Status Information . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
Router Up-Time Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
IP Access Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161
IP Routing Table Cache . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161
IP Counters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

  Contents vii



  
 

Router IP Addresses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161
Routing Table Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161
Clearing ARP Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161
ARP Cache  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162
ARP Registered Networks . . . . . . . . . . . . . . . . . . . . . . . . . . . .  162
ARP Registered Address Protocols . . . . . . . . . . . . . . . . . . . . . . .  162
Statistics about ARP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  162

Chapter 17. Viewing Node-Level APPN Information . . . . . . . . . . . .  163
View Details of the APPN Network Topology . . . . . . . . . . . . . . . . .  163
View Details of the Network Nodes . . . . . . . . . . . . . . . . . . . . . . .  163
View Details of the Network Directories . . . . . . . . . . . . . . . . . . . .  163
View Details of the Connection Networks . . . . . . . . . . . . . . . . . . .  164

| View Details of the HPR Connections . . . . . . . . . . . . . . . . . . . . .  164
Aping  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164

Chapter 18. Managing IP Router Data . . . . . . . . . . . . . . . . . . . . .  165
General IP-Specific Commands . . . . . . . . . . . . . . . . . . . . . . . . . .  166

Viewing the Protocol and Interface Configuration . . . . . . . . . . . . . . .  166
View (Dump) the Router Routing Table . . . . . . . . . . . . . . . . . . . .  166
Verifying the Reachability of a Resource: Ping . . . . . . . . . . . . . . . .  166
Restarting the IP Router . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  166
Viewing the Route to a Resource . . . . . . . . . . . . . . . . . . . . . . . .  167
Tracing the Route to a Resource . . . . . . . . . . . . . . . . . . . . . . . .  167

IP OSPF Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  167
OSPF Link State Advertisement . . . . . . . . . . . . . . . . . . . . . . . . .  167
OSPF Area  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
OSPF AS-External Information . . . . . . . . . . . . . . . . . . . . . . . . .  167
OSPF Area Link State Database . . . . . . . . . . . . . . . . . . . . . . . .  168
OSPF Interface Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  168
Adding an OSPF Router to a Multicast Group . . . . . . . . . . . . . . . .  168
Removing an OSPF Router from a Multicast Group . . . . . . . . . . . . .  168
OSPF Multicast Cache . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  168
Router OSPF Membership Groups . . . . . . . . . . . . . . . . . . . . . . .  168
OSPF Multicast Routing Statistics . . . . . . . . . . . . . . . . . . . . . . .  169
Details of Active OSPF Neighbors . . . . . . . . . . . . . . . . . . . . . . .  169
OSPF Router Routes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  169
Link State Advertisement Database Statistics . . . . . . . . . . . . . . . . .  169
OSPF Routing Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  169
Changing the Cost of an OSPF Interface . . . . . . . . . . . . . . . . . . .  169

IP BGP View Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170
BGP Routing Table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170
Details of Active BGP Neighbors . . . . . . . . . . . . . . . . . . . . . . . .  170
Path Description Database . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170
Size of the BGP Databases . . . . . . . . . . . . . . . . . . . . . . . . . . .  170

Appendix A. CCM Remote Configuration Application: Options, Script
Commands and Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . .  171

CCMCLI Options and Variables . . . . . . . . . . . . . . . . . . . . . . . . . .  171
Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

Script Commands  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
label and goto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  172
include  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172

viii 3746-9X0: CCM User's Guide  



  
 

interactive_mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
onerror   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
Substitution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173

Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
Assigning a Value . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  173
Expanding Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Deleting a Variable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  174
Example  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
Example  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175

Appendix B. Bibliography  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
Customer Documentation for the 3746 Model 950 . . . . . . . . . . . . . . . .  177
Customer Documentation for the 3745 (All Models), and 3746 (Model 900) .  182
Additional Customer Documentation for the 3745 Models 130, 150, 160, 170,

and 17A  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188

List of Abbreviations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  189

Glossary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191

Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195

  Contents ix



  
 

x 3746-9X0: CCM User's Guide  



  
 

 Figures

1. Main Panel Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
2. CCM Main Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
3. Files Created by the CCM during the Configuration Process . . . . . . .  16
4. Creating a Configuration in the Service Processor Environment . . . . .  20
5. Creating a Configuration in a Stand-Alone Environment . . . . . . . . . .  21
6. Main Panel File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27
7. Configurations List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
8. Reference CDF-E Comparison Menu . . . . . . . . . . . . . . . . . . . . .  30
9. CCM Configuration/Reference CDF-E Comparison Panel . . . . . . . . .  31

10. File Transfer Major Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36
11. Java Console File Manager Panel . . . . . . . . . . . . . . . . . . . . . . .  37
12. DCAF File Transfer Utility Panel . . . . . . . . . . . . . . . . . . . . . . . .  38
13. Main CCM Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57
14. 3745/3746 Parameters Panel . . . . . . . . . . . . . . . . . . . . . . . . .  58
15. CCM Coupler/Processor Type Panel . . . . . . . . . . . . . . . . . . . . .  58
16. Stations on Coupler/Port 2080 Panel . . . . . . . . . . . . . . . . . . . . .  59
17. ESCON Port Configuration Panel . . . . . . . . . . . . . . . . . . . . . . .  61
18. Input Packet Filter Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62
19. Output Packet Filter Panel . . . . . . . . . . . . . . . . . . . . . . . . . . .  63
20. ESCON Host Links Configuration Panel . . . . . . . . . . . . . . . . . . .  64

| 21. ESCON Station Configuration - APPN Parameters Panel . . . . . . . . .  66
22. Token-Ring Port Configuration Panel . . . . . . . . . . . . . . . . . . . . .  69

| 23. Token-Ring Port Configuration - APPN Parameters Panel . . . . . . . . .  70
24. IP Over Token-Ring Parameters Panel . . . . . . . . . . . . . . . . . . . .  71
25. Token-Ring Connection Network Panel . . . . . . . . . . . . . . . . . . . .  72
26. Token-Ring Station Configuration Panel . . . . . . . . . . . . . . . . . . .  73
27. Token-Ring Station Configuration - APPN Parameters Panel . . . . . . .  74
28. Serial Line Port Configuration Panel . . . . . . . . . . . . . . . . . . . . .  77
29. The First DLC Port Parameters Panel for SDLC . . . . . . . . . . . . . .  79
30. SDLC Station Configuration Panel . . . . . . . . . . . . . . . . . . . . . . .  80
31. First SDLC Station Configuration - DLC Parameters Panel . . . . . . . .  81
32. Serial Line Port Configuration Panel . . . . . . . . . . . . . . . . . . . . .  84
33. Frame-Relay Port - DLC Parameters Panel . . . . . . . . . . . . . . . . .  85
34. Frame-Relay Port - DLC Parameters 2/2 Panel . . . . . . . . . . . . . . .  85
35. IP over Frame-Relay Parameters Panel . . . . . . . . . . . . . . . . . . .  86
36. Frame-Relay DLCI/COMRATE Parameter Panel . . . . . . . . . . . . . .  88
37. Frame-Relay DLCI/CIR Parameters Panel . . . . . . . . . . . . . . . . . .  89
38. APPN over Frame Relay – Station Configuration Panel . . . . . . . . . .  91
39. Frame-Relay Frame Handler Set Configuration Panel . . . . . . . . . . .  94
40. Serial Line Port Configuration Panel . . . . . . . . . . . . . . . . . . . . .  95
41. PPP Port DLC Parameters Panel . . . . . . . . . . . . . . . . . . . . . . .  96
42. Serial Line Port Configuration Panel . . . . . . . . . . . . . . . . . . . . .  99
43. X.25 Port - DLC Parameters Panel . . . . . . . . . . . . . . . . . . . . .  100
44. First X.25 PLP Parameters Panel . . . . . . . . . . . . . . . . . . . . . .  101
45. IP over X.25 - Port Parameters Panel . . . . . . . . . . . . . . . . . . .  102
46. X.25 Station Configuration Panel . . . . . . . . . . . . . . . . . . . . . .  103
47. X.25 Station Configuration - DLC Parameters Panel . . . . . . . . . . .  104
48. IP over X.25 - Station Parameters Panel . . . . . . . . . . . . . . . . . .  105
49. Navigation Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
50. Example Configuration Panel . . . . . . . . . . . . . . . . . . . . . . . .  110

 Copyright IBM Corp. 1996, 2000  xi



  
 

51. Access Control Packet Filtering Panel . . . . . . . . . . . . . . . . . . .  111
52. APPN Interfaces Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . .  111
53. IP Configuration Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . .  115
54. OSPF Configuration Menu . . . . . . . . . . . . . . . . . . . . . . . . . .  117
55. RIP Configuration Menu . . . . . . . . . . . . . . . . . . . . . . . . . . .  119
56. BGP Configuration Menu . . . . . . . . . . . . . . . . . . . . . . . . . . .  120
57. IP Access Controls Panel . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
58. Configuration Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
59. APPN Configuration Menu . . . . . . . . . . . . . . . . . . . . . . . . . .  125
60. Operations Menu in Ports Management Panel . . . . . . . . . . . . . . .  139
61. Session Management Filters Panel . . . . . . . . . . . . . . . . . . . . .  140
62. Ports Management Panel . . . . . . . . . . . . . . . . . . . . . . . . . . .  141

| 63. Connectivity Counters Panel . . . . . . . . . . . . . . . . . . . . . . . . .  142
64. Operations Menu for APPN Ports Management . . . . . . . . . . . . . .  143
65. APPN Stations Information Display Panel . . . . . . . . . . . . . . . . .  148
66. Sessions Information Display . . . . . . . . . . . . . . . . . . . . . . . . .  152
67. Example IP Port Management Menus . . . . . . . . . . . . . . . . . . .  154

| 68. Example CCM IP Results Display . . . . . . . . . . . . . . . . . . . . . .  154
69. Example Management Panel for APPN . . . . . . . . . . . . . . . . . . .  163
70. Example of an IP Command Panel . . . . . . . . . . . . . . . . . . . . .  165

 Tables

1. Functions Supported by each CCM Level . . . . . . . . . . . . . . . . . . .  5
2. Copy, Search, and Sort Availability . . . . . . . . . . . . . . . . . . . . . .  24
3. CCM Remote Configuration Commands . . . . . . . . . . . . . . . . . . .  46
4. Configuration Program Keyboard Functions . . . . . . . . . . . . . . . .  113
5. Network Traffic Disruption - Adding a Resource . . . . . . . . . . . . . .  134
6. Network Traffic Disruption - Modifying a Resource . . . . . . . . . . . .  134
7. Network Traffic Disruption - Deleting a Resource . . . . . . . . . . . . .  137
8. Post-Command Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
9. Customer Documentation for the 3746 Model 950 . . . . . . . . . . . .  177

10. Customer Documentation for the 3745 Models X10 and X1A, and 3746
Model 900  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182

11. Additional Customer Documentation for the 3745 Models 130 to 17A .  188

xii 3746-9X0: CCM User's Guide  



  
 

 Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area.

References in this publication to IBM products, programs, or services do not imply
that IBM intends to make these available in all countries in which IBM operates.
Any reference to an IBM product, program, or service is not intended to state or
imply that only IBM’s product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any of IBM’s
intellectual property rights may be used instead of the IBM product, program, or
service. Evaluation and verification of operation in conjunction with other products,
except those expressly designated by IBM, are the user’s responsibility.

IBM may have patents or pending patent applications covering subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
 IBM Corporation

North Castle Drive
Armonk, NY 10504-1785

 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
 Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country
where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this publication
at any time without notice.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

 Copyright IBM Corp. 1996, 2000  xiii



  
 

 Trademarks
The following are trademarks of IBM Corporation in the United States, or other
countries, or both:

NetView and Tivoli are trademarks of Tivoli Systems, Inc. in the United States, or
other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other countries.

Other company, product, and service names may be trademarks or service marks
of others.

AIX
Advanced Peer-to-Peer Networking
APPN
Extended Services
ESCON
IBM
the IBM logo

MVS
Nways
Operating System/2
OS/2
OS/2 Warp
Presentation Manager

xiv 3746-9X0: CCM User's Guide  



  
 

About This Guide

This guide introduces and explains how to use the IBM Controller Configuration and
Management (CCM) application to configure the resources used by an IBM 3746
Nways Multiprotocol Controller Model 900 or 950 for handling network traffic.

It provides instructions on how to navigate through the application panels and
provides a series of guidelines that are useful when configuring an IBM 3745 or
3746 communication controller for the first time.

The information in this guide complements the online help.

Who Should Use This Guide
This guide has been written for anyone who uses the CCM to configure or manage
an IBM 3745 or 3746 communication controller and its associated resources.

How This Guide Is Organized
This guide is organized into three parts:

Part 1, “Introducing the CCM”

This part introduces the CCM and:

� Explains the operating environments

� Gives some information about the user interface (menus and panels)

� Gives an overview of the configuration process

� Explains some of the configuration tasks that are generic, that is the tasks that
are available for the configuration of many or all of the data link control (DLC)
types.

Part 2, “Resource Configuration”

This part describes the configuration process and explains how to navigate through
the CCM to the panels where you configure your network resources. Each chapter
covers some of all the resources for a given DLC type.

Part 3, “Resource Management”

This part explains how to navigate to the panels where you manage Advanced
Peer-to-Peer Networking (APPN) and IP network resources by viewing
operational information, and activating or deactivating resources.

The bibliography, list of abbreviations, glossary, and index are at the back of this
guide.
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Conventions Used in This Guide
The following typographical conventions and graphics are used in this guide:

Typeface, Graphics Used for

Italics
Bold italics

Word emphasis

  
Bold Menu bar and drop-down menu choices

Pushbuttons
Field names
Panel titles

  
Monospace � Text entered by user
  

 � Important notes

 Menu Conventions
This guide uses a short format to direct you to a particular menu choice. This
format does not distinguish between drop-down menus (from the menu bar) and
side-opening, cascaded menus; it only gives the chronological order of the menu
openings. For example, to go to the IP Static Routes panel used to configure IP
static routes:

Main panel Configuration menu → IP → Static routes → IP Static Routes panel

This means:

1. To select the Configuration drop-down menu from the CCM main panel menu
bar

2. To select IP in the Configuration drop-down menu

3. To select Static routes in the IP cascade-menu to open the IP Static Routes
panel.
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| What Is New in This Guide
| This guide has been revised to include the following changes and enhancements:

| � Addition of the CCM remote “light” configuration for OS/2 software that allows
| the user, using an editor on a remote workstation, to modify an already-existing
| CCM configuration file directly.

| � Addition of more dynamic capabilities for Multiaccess Enclosure (MAE) users so
| that, after the IP configuration changes, the MAE re-IMLs only when necessary.

| � Addition of the ability to dynamically change the maximum number of PUs per
| TIC3 port without affecting active users.

| � Support of the Branch Extender (BEX) function, reducing the network node
| (NN) load on large APPN networks. BEX support includes the following two
| new parameters:

| – APPN Branch Extender, which indicates whether the BEX function is
| activated on this node

| – Permit Search for Unregistered LUs, which indicates whether this node
| (when acting as an end node) can be searched for LUs even if the LUs
| were not registered with the network node server of the BEX.

| � Support for dynamic windowing on Token-Ring Processors Type 3, allowing the
| NNP and NCP to regulate traffic over token-ring ports more efficiently.

| The technical changes and additions are indicated by a vertical line (|) to the left of
| the change.

Additional Information on the Web
You can access the latest news and information about IBM network products,
customer service and support on the Web at:

 http://www.ibm.com/networking

You can also directly access the 3746-9x0 technical support Web site at the URL:

 http://www.lagaude.ibm.com/3746pe

Year 2000 Statement
This product is Year 2000 ready. When used in accordance with its associated
documentation, it is capable of correctly processing, providing, and/or receiving
date data within and between the 20th and 21st centuries, provided all other
products (for example, software, hardware, and firmware) used with the product
properly exchange accurate date data with it.

For more information, refer to:

http://www.ibm.com/year2000

The 3745 and 3746 controllers require a certain level of microcode to be Year 2000
ready. For more detailed information, access the URL listed above and click
Product Readiness.
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Part 1. Introducing the CCM
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Chapter 1. Welcome to the CCM

The IBM Communication Configuration and Management (CCM) application is
designed to help you configure and manage an IBM 3746 Nways Multiprotocol
Controller Model 900 or 950 and its associated network resources.

When you configure your controller and its resources, the CCM creates a
configuration file, referred to as the 3746 controller configuration file. Using the
CCM, you can create several configurations.

The CCM runs under the control of the Operating System/2 (OS/2) and features
a Presentation Manager graphical user interface, where you can perform a wide
range of tasks.

The CCM tasks are divided into two main categories:

Configuration for defining configuration parameters such as coupler type, mode,
class of service, transmission group, and others. When a group of configuration
parameters has been defined, it can be saved to file on disk. This file can then be
immediately activated for use by the network, or it can be saved for later use.
Configuration parameters are defined by specifying values in CCM panels.

Management that involves viewing operational information about the currently
defined network resources, and activating or deactivating network resources to
maintain optimal network performance. Tasks requesting network resource
information use commands that only specify the resource address.

Note:  This is a “how-to-find-it” guide that only shows a few, key panels that help
you go to a panel used for specific configuration task; the actual panel used for the
task is normally not shown in this guide.
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 Operating Environments
The CCM can be used on either:

� The service processor, where it is accessed via the MOSS-E. (The service
processor may be accessed via a Distributed Console Access Facility (DCAF)
remote console). This environment is referred to as the service processor
environment.

� A stand-alone workstation. This environment is referred to as the stand-alone
environment.

Service Processor Environment
With the CCM installed and running on the service processor, you access it through
the MOSS-E user interface. In this type of installation, both the configuration and
the management functions can be used.

 Stand-Alone Environment
When the CCM is running in the stand-alone environment, the management part of
the application and the coupler with the 2080 address are not available for use
(they are greyed-out).

However the configuration part of the application is fully available for configuring the
controller and its resources before your machines arrive.

If several controllers are operating on the network, a good strategy is to configure
all controllers from a centralized location, using the stand-alone CCM. The
configurations can then be sent (exported) to each service processor when
complete.

Minimum Hardware and Software Requirements
The minimum requirements for workstations running the stand-alone version of the
CCM are:

� 80486 microprocessor or higher.

| � 60 MB of hard disk space free.

 � VGA display.

Note:  The CCM panels are designed for a VGA resolution (640x480), higher
resolutions might cause minor column alignment problems. However, the MAE
configuration program will be easier to use because both of its panels are
visible at the same time.

� 24 MB of virtual memory. The actual amount of virtual memory needed
depends on the size of the configuration (does it have tens of lines or hundreds
of lines).

 � Mouse.

� 3.5-in. diskette drive.

� IBM Operating System/2 (OS/2), Version 2.1 or later.
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 Installing CCM
This section explains the CCM driver levels and describes the MOSS-E and
stand-alone installation procedures.

 CCM Levels
This User’s Guide is for the CCM functions in ECA 170, which are listed in Table 1.

Table 1 (Page 1 of 3). Functions Supported by each CCM Level

ECA Number

Microcode
EC Level
(See note 1)

CCM Version
(APPN BLPU
EC Level) Functions Supported

144
146

D22560A
D22560D

D22561
D22561

APPN configuration and
management

155 D46100 D22571

The above functions plus:

 � IP
� Frame relay over APPN

 � HPR/ANR
� IP configuration for

ESCON and token-ring.

157
159
159

D46120
D46120A
D46120B

D46121
D46121.005
D46121.010

The above functions plus:

 � IP management
 � PPP
� Frame relay over IP

 � HPR/RTP
� Second expansion enclosure
� A CCM password

 � NetView Performance
Monitor (NPM).

167 D46130 D46131 000

The above functions plus:

| � HPR/RTP and ARB on
| token-ring, Ethernet, SDLC,
| frame relay, and ESCON

� APPN/ISR (5000 PUs +
15 000 sessions)

� Display of 3746 EC/ECA
microcode level

 � CDF-E checking

170
(See note 2)

D46130D D46131.024

The above functions plus:

� X.25 support on 3746 (under
NNP control)

� HPR MLTG on token-ring,
SDLC, frame relay, and
ESCON

� BRS for 3746 PPP lines
� FRFH on 3746 lines
� CIR on 3746 frame-relay

lines.
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Table 1 (Page 2 of 3). Functions Supported by each CCM Level

ECA Number

Microcode
EC Level
(See note 1)

CCM Version
(APPN BLPU
EC Level) Functions Supported

175
(See note 2)

F12380 F12381.000

The above functions plus:

� APING function added (like
IP PING, but for APPN
traffic)

� ESCON adapter re-IML is
now optional when activating
a configuration

� Increased management of
remote IP addresses

� Make DLCI copies function
added

� IP access controls now
available at port level.

180 F12430 F12431.000

The above functions plus:

� Multiaccess enclosure (MAE)
configuration

� Management of MAE
configurations (import,
export, change coupler
number, and others)

185 F12720 F12721.000

The above functions plus:

� IP route table filtering
� RIP V2 support.

190 F64810 F64811.000

The above functions plus:

� CCM Remote Configuration
Application

� Connectivity counters for
PUs, SSCP-LUs, LU-LUs.
(see note 3 on page 7)
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Additional, level-specific information is available in the README file that comes
with the stand-alone CCM.

Table 1 (Page 3 of 3). Functions Supported by each CCM Level

ECA Number

Microcode
EC Level
(See note 1)

CCM Version
(APPN BLPU
EC Level) Functions Supported

| 250
| 280
| H10000
| H100100
| H10000.000
| H10010.000

| The above functions plus:

| � CCM batch light
| � CCM more dynamicity for
| MAE User
| � Dynamic change of
| maximum PU per TIC3 port
| � Branch Extender (BEX), only
| for ECA 280
| � Enhanced support for LENs
|  � Token-ring dynamic
| windowing improvement
| � Maximum number of IP
| routes increased to 10K on
| CBSP3

Notes: 

1. This is the minimum functional EC level as of the General Availability date of the
CCM level.

2. This ECA must not be ordered, the corresponding microcode is automatically
shipped with any features requiring this level. In particular, the 3746 Extended
Functions 1 (feature number 5800) must be ordered to operate any the functions
listed.

3. 5810/5811 FC must be ordered and activated to make the CCM remote
configuration application available for use.

 4. Legend:

BLPU build logical program unit
EC engineering change
ECA engineering change announcement

 Level compatibility
Different levels of CCM are upwardly compatible only. For this reason, a
configuration that has been generated at CCM one level can only be exported to a
CCM at the same or higher level.

When you display the configuration list, check the level compatibility column. It
indicates the CCM level with which a configuration is compatible. If this level is
different from the running CCM level, then the configuration is to be first migrated
before being opened (To know the running CCM level, select Product Information
from the Help pull-down menu). The migration is automatically proposed when you
want to open or activate the configuration. Once migrated, the level compatibility
for the migrated configuration changes to the running CCM level. When there are
several configurations, you can migrate them at the same time.

IBM recommends that the same level of the CCM should be maintained in the
service processor and the stand-alone environment. This is important if
configurations generated on the stand-alone CCM are to be exported to a CCM
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running in a service processor. Details of the APPN BLPU level are displayed in
the Product Information panel.

Viewing the CCM Product Information
You can view information about this release of the CCM: its version, EC (APPN
BLPU engineering change), and the date of general availability of this EC version.
To view the product information:

Main panel Help menu → Product information

Figure 1. Main Panel Help Menu

Installing CCM in Service Processor Environment
Installation of the CCM in the MOSS-E is a task that is performed by an IBM
customer engineer. The CCM is installed when the MOSS-E is installed.

Installing CCM in the Stand-Alone Environment
The IBM customer engineer creates the CCM installation diskettes that you use for
installing the CCM.

Note:  Before installing CCM, ensure that your workstation has the correct
hardware and software requirements (see page 4). The installation procedure is in
the README files that comes with the CCM and might be different according to the
level of the CCM that is being installed.

CCM Password Protection from MOSS-E
The CCM on a service processor can be protected by a password using the
MOSS-E CCM/Telnet User Profile Management function in the Manage Passwords
menu.
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Starting the Service Processor CCM
To start the CCM in the service processor environment:

Step 1. Open the MOSS-E 3746-9xx group of menus.

Step 2. In the 3746-9xx Network Node Processor Management menu select
the CCM-Controller Configuration and Management function.

Starting the Stand-Alone CCM
Note:  When the CCM is running in the stand-alone environment, the management
part of the application and the 2048 coupler are not available for use (they are
greyed-out).

To start the stand-alone CCM, you can use either the mouse or the keyboard.

Using the Mouse

Step 1. Double-click the CCM folder icon CCM

Step 2. Double-click the CCM icon 

3745
NN

CCM  to start the application.

Using the Keyboard
Step 1. Open an OS/2 panel.

Step 2. Type CCM and press Enter.

Stopping and Exiting from CCM
To stop the CCM:

Main panel File → Exit.
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Becoming Familiar with the Main Panel
The CCM provides a graphical user interface with which you will quickly become
familiar.

When you start the CCM, the main panel is displayed (see Figure 2).

System Menu
Icon

Menu
Bar

(with Pull-Down Menus)

Information Area

Coupler
Address

Coupler
Icons

Second Expansion Enclosure
Row of Coupler Icons

First Expansion Enclosure
Row of Coupler Icons

Basic Enclosure
Row of Coupler Icons

A Selected
Coupler

Header Information

Figure 2. CCM Main Panel

As shown in Figure 2, the main panel includes the following features:

 � Menu bar
 � Header information
 � Coupler icons
 � Information area

 Menu Bar
Five pull-down menus are available from the menu bar:

 � File
 � Configuration
 � Management
 � Options
 � Help

 Header Information
The header information is dynamically updated, and shows the following
information:

� The active configuration (if one exists), not available in stand-alone CCM
� The opened configuration (if one has been opened)
� The opened reference CDF-E file (if one exists in the opened configuration).
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 Coupler Icons
The coupler icons represent a schematic view of the couplers in the basic
enclosure and expansion enclosures within the controller.

The lower row of coupler icons represents the 10 coupler slot addresses in the
basic enclosure, which can hold up top five adapters.

The middle row of coupler icons represents the 12 coupler slot addresses in the
first expansion enclosure, which can hold up to six adapters.

The upper row of coupler icons represents the 12 coupler slot addresses in the
second expansion enclosure, which can hold up top six adapters.

An adapter consists of one processor connected to one or two couplers: each
adapter has a pair of coupler icons. Adapters configured for ESCON channels only
use one of a coupler pair.

The shape and color of the coupler icons give information about the couplers they
represent.

 Icon Shape
There are two shapes for the coupler icons:

Means that the coupler has been configured in the CCM.

Means that the coupler has not been configured in the CCM.

For example, if the first coupler configured on a processor is a TIC3, the
second slot on the processor is automatically labeled as an
unconfigured TIC3, because only a TIC3 can be installed in the second
slot.

In the same manner, if a LIC (LIC11 or LIC12) is configured on a
processor, the other slot is labeled as a LIC.

Blue and White Icons
These colors indicate the status of a coupler after a comparison has been made
between the actual, physical configuration of the coupler slot (as given in the
reference CDF-E file) and the CCM configuration of the coupler slot:

Blue Means that, when the CDF-E file was compared to the CCM
configuration file, no discrepancies were found between the two for that
coupler slot.

Note:  While a coupler is blue, its DLC type cannot be changed in the
CCM configuration unless it is “cleared,” see “Setting or Clearing the
Coupler Type” on page 32.

White Means one of the following:

� The reference CDF-E/CCM configuration comparison has not been
made.

� During the comparison, the CCM coupler DLC type was not found
in the reference CDF-E file.
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� During the comparison, the CCM coupler DLC type was found in the
reference CDF-E file, but there are configuration discrepancies that
would prevent the coupler from operating properly.

 Grey Icons

Means that the coupler can be neither selected nor configured because
it is the:

� Second, unused slot in an ESCON adapter.

� 2048 slot, which is never available because of the amount of traffic
for the NNP and service processor handled by the 2080 TIC3
attached to the service LAN. The 2048 and 2080 slots are for
CBSP (type 2 or 3).

Note:  In the 3746-900, the 2048 is used to connect the 3745 to the
3746. This connection does not handle (route) a large amount of
traffic, most of it just passes through and is handled by other 3746
processors.

 Information Area
The information area is located at the bottom of the main panel and displays
navigation and processing status information.

Working in the Main Panel
This section briefly explains how to work with the coupler icons and the menus in
the main CCM panel.

Working with the Main Panel Menu Choices
In a stand-alone environment with no configuration currently opened, you can:

� Create a new configuration: File menu → New
� Open an existing configuration: File menu → Open
� Import a configuration: File menu → Import

Note:   All choices on the Options and Help menus are also available.

Working with the Coupler Icons
Select a coupler icon to begin configuring a coupler. If you are using a mouse,
double-click on the icon for the coupler you want to configure. If you prefer to work
with the keyboard, use the arrow keys to highlight the desired coupler and press
Enter.

If the coupler type has already been defined, you go directly to the panel needed to
continue the configuration process.

If the coupler type has not been defined, CCM opens the Coupler type panel,
where you must specify the coupler type. CCM then opens panel needed to
continue the configuration process.

If the configuration is new, the first time you select a the coupler, CCM opens the
3745/3746 Parameters panel, where you must specify the 3746 model used and
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give information about the 3745 if a 3746 Model 900 is being used. CCM then
opens the Coupler type panel to continue the configuration process.

Working from the Pull-Down Menus
For some pull-down menu choices, you do not have to select a coupler icon,
instead just select the option from the menu. For example, any of the File
pull-down menu choices can be selected without first selecting a coupler icon.
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Chapter 2. About the Configuration Process

The CCM enables you to configure the controller and all the associated resources it
uses for handling network traffic.

An Easier Way to Configure
The CCM is designed to provide a much simpler method of configuring the
controller and its resources, when compared with the NCP generation process.

About 80% of the parameters have predefined default values. These values can be
used, or modified and saved as new default values if required. This saves time
and effort when you configure several identical lines, ports, or stations.

Configuration files can also be copied or exported (or printed as listings). The CCM
ensures that the configuration is internally consistent by dynamically cross-checking
the validity of parameter values while you are entering them.

This dynamic checking allows CCM to help you, when you choose a value for a
parameter, by immediately disabling (greying-out) all the other CCM parameters
that are:

� No longer relevant to the configuration you are working on.

For example, if you start to configure an ESCON port for a SNA/subarea
network, the APPN and IP name parameters are greyed-out as they do not
apply to a SNA/subarea ESCON Channel.

� Automatically selected by the CCM and cannot be changed.

For example, for a serial line port, if you choose the DLC as SDLC, the network
parameter is automatically set to APPN and the set of choices is greyed-out.
But, if you choose the PPP DLC, the network is automatically set to IP and,
again, the set of choices is greyed-out.

During the configuration process, the CCM creates a set of output files which are
then compressed into a single file known as the 3746 configuration file (the .CCM
binary file, see Figure 3 on page 16).
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Figure 3. Files Created by the CCM during the Configuration Process

Legend:

.CCM 
Name: CCM Configuration File
Contents: Complete CCM configuration (compressed) with all the above

files and others
Destination:  Hard disk that contains the CCM program

.CMD 
Name: SNMP Definition File
Contents: SNMP definitions
Destination:  Network Node Processor (NNP)

.NDF 
Name: Network Definition File
Contents: APPN and IP resource configurations
Destination:  Network Node Processor (NNP)

.IDF 
Name: Internet Definition File
Contents: IP resource data
Destination:  Processors that handle IP traffic

.IOC 
Name: I/O Configuration Program file
Contents: Defines the ESCON channel paths
Destination:  Destination: Host (IOCP or the MVS Hardware Configuration

Definition (HCD) tool)

Note:  The CCM produces this file as output from a 3746
configuration file to be used as input for the host.

.NCP 
Name: Network Control Program (NCP) file
Contents: ESCON definitions for NCP
Destination:  Host (NCPGEN)

Note:  The CCM produces this file as output from a 3746
configuration file to be used as input for the host.

.ESC 
Name: ESCON Definition File
Contents: SNA/subarea, APPN, and IP ESCON definitions
Destination:  Used to configure ESCON processors
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.ACF 
Name: ASCII Configuration File
Contents: MAE resource configurations
Destination:  User: this is text version of MAE configuration.

What You Can Do with a CCM Configuration
With the CCM, configuration files can be created, modified, copied, imported,
exported, and activated as required.

Creating Configuration Files
Different configuration files can be created for different controller configurations and
environments (but only a single configuration file can be active at a given time).

You can create a configuration file in the service processor environment or in
stand-alone environment.

Though possible, it is preferable not to create CCM configurations using the CCM
remote configuration application.

Before starting the initial configuration, use:

� The hardware configuration worksheets to record the controller hardware
topology, including details of coupler position and type.

� The CCM parameter worksheets to record the configuration information for
each controller and its associated resources.

These worksheets are located in the CCM Planning Worksheets.

Modifying Configuration Files
If resources are changed (for example, if a coupler is added or a coupler is
replaced with one of a different type) the configuration file must also be updated.

This can be done in the service processor environment or in stand-alone
environment. This procedure is explained in “Opening and Modifying a
Configuration” on page 28.

You can also use the CCM remote configuration application to modify CCM
configurations from a remote workstation. Read “Using the CCM Remote
Configuration Application on AIX Software” on page 40 for more information.

After modifying a configuration, you can activate the changes in the configuration
either:

� Immediately, using the CCM Dynamic Configuration Update function on
individual ports and stations without disrupting the rest of the network. For
more information, see Chapter 15, “Dynamic Activation and How It Affects Your
Network” on page 131.

� Later, by activating the whole configuration, see “Activating a Configuration” on
page 29.
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Before modifying a configuration, ensure that you:

� Know the file name of the configuration to be modified.

� Have the hardware configuration worksheet, if the hardware topology of the
machine has changed.

� Have the parameter worksheets with the details of the changes to be made in
the configuration.

Copy a Configuration
You can make one or more copies of a given configuration by saving its file under
different names.

This is used, for example, if several controllers on the network have similar
configurations and a "master" configuration contains most of definitions needed by
all these controllers. This master configuration can be changed as needed for an
individual controller and saved under a unique name that corresponds to this
controller. This can be repeated for each of the other controllers, giving you a
group of configurations each customized for a specific controller.

This method can also be used to produce several configurations for the same
controller. For example, to handle traffic over a coupler differently at night, the
active configuration could change at 8:00 p.m. to the night version and change
again at 7:00 a.m. to the day version.

Export/Import a Configuration
If you configure in the stand-alone environment, the configuration file must be
exported from the CCM to a diskette and then imported onto the service processor
hard disk of the destination controller. See “Importing a CCM Configuration” on
page 28.

Note:  In order to export CCM configurations from one environment to another one,
you can also use the file transfer facility provided by the DCAF program or the
JavaTM Console application. See “Using the File Transfer Facility” on page 35.

Activate a Configuration
You can do this:

� In the service processor environment CCM, see “Activating a Configuration” on
page 29.

� From a remote workstation using the CCM remote configuration application.
Read “Using the CCM Remote Configuration Application on AIX Software” on
page 40 for more information.

A single configuration can only be active at a given time.

Configuring the Controller
To configure a controller, you define the parameters for the:

Controller itself:

� Controller frame information
� Its network focal point
� As a dependent LU requester (DLUR)
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� Its mode of CCU operation (for a 3746-900)
� Class of service (COS) for its traffic

 � Communications protocol.

Controller resources:
The couplers.

To configure a coupler, you define parameters for its ports and stations.

The controller and its resources must be configured when they are first installed
and when modifications are made to the network.

Creating a Configuration in Different Environments
The procedure for creating a configuration depends on the environment in which
you are working (service processor or stand-alone).

Notes:

1. In the following figures, the activation step has been included to show the
difference between the two environments.

2. The procedure for creating a configuration using the CCM remote configuration
application is not described here. Read “Using the CCM Remote Configuration
Application on AIX Software” on page 40 for more information.
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In the Service Processor Environment
If you are using the service processor environment, follow the steps shown in
Figure 4.

Figure 4. Creating a Configuration in the Service Processor Environment
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In the Stand-Alone Environment
If you are using the stand-alone environment, follow the steps shown in Figure 5.

Figure 5. Creating a Configuration in a Stand-Alone Environment. 
1See “Configuring Stations on Coupler/Port 2080” on page 59.
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Chapter 3. Performing Generic Configuration Tasks

This chapter explains how to find the panels where you perform generic tasks such
as manipulating configurations, and comparing coupler and port configurations to
the definitions in the CDF-E file.

A Word about the Buttons, Worksheets, and Online Help
The buttons Search, Copy, Save as Defaults, Modify and Cancel provide useful
functions when working with the CCM.

The parameter worksheets can be used during the pre-configuration planning to
note the values needed for the configurations. Once the CCM configuration
process is finished, these worksheets provide an easy-to-consult, permanent record
of the configuration. They should be kept up-to-date.

The CCM online help provides detailed information about the parameters, their valid
values, and the rules for their use.

The Generic Buttons

 Copy
Use Copy to make copies of a resource that is already configured.

Copying ports and stations that have previously been configured is a useful
time-saving feature when working with a configuration that contains many port and
station parameters.

For example, after configuring the first of 30 ports on a LIC11, you could
automatically make 29 copies and then modify them as needed.

To copy a port or station, you specify the number of ports or stations and up to four
common initial characters of the port or station names. The system then generates
a list of proposed new ports or stations with names that consist of the common
initial characters plus an incremented hexadecimal number.

The copies can be renamed and their currently configured values modified as
needed.

 Search
Using Search, you can find all the configured resources of a given type that
corresponding to search criteria that you define, such as the name, address,
comments, dial number, or MAC address.

 Sort
Using Sort, you can sort resources (such as OSPF or RIP IP addresses, MLTGs,
CDF-E couplers and ports) according to criteria that you define (DLC type, port
number, port name, dial circuit number, or IP address).
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Copying, Searching, and Sorting Resources
Table 2 shows which resources can be copied, searched for, or sorted.

The changes made to a list using Modify and Delete are changed in the CCM
configuration after you click OK.

Table 2. Copy, Search, and Sort Availability

Resource Function Available

Copy Search Sort

Port configurations:
LIC11 (Serial Line)

 
X

 
X

 

Station configurations:
LIC11 (Serial Line)
LIC12 (Serial Line)

 Token-ring

 
X
X
X

 
X
X
X

 

MLTGs  X X

DLCIs X X  

IP configurations:
 OSPF addresses
 RIP addresses

  
X
X

 
X
X

Managing resources:
 Ports
 Stations
 Sessions

The CCP IP display

 X
X
X
X
X

 

CDF-E resources   X

Save as Defaults
Use Save as defaults button to save the current panel parameter values as the new
default values in that panel.

The new default values apply to all ports and stations of the current DLC type that
you configure later–each DLC type has its own default values.

All ports and stations configured before the defaults were changed use the original
default values. Before making major changes, you should carefully check the
proposed new defaults to avoid having to make time consuming corrections later.

 Modify
Use Modify to change a parameter value. Enter the new value, then press Modify
to save it.
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 Cancel
Use Cancel to exit the current panel without saving any changes that have been
made to and through this panel.

 Attention 

When you click Cancel, be careful because the system does not
request confirmation. Not only is any modified information lost in the
current panel, any changes to any other panels that you have
accessed via the current panel are lost.

Note:  If you have used Save as defaults anywhere, the new default
values are not lost when Cancel is used.

Getting Online Help
If you need additional information while using the CCM, use the online help by:

� Clicking on Help at the bottom of the panel.

The global help for the current panel is displayed; it provides information about
the panel controls (buttons, lists, and so on) and parameters (values, ranges,
and rules for use).

� Selecting a parameter in the panel and pressing F1.

The contextual help for the parameter (value, range, and rules for use) is
displayed.
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Generic Configuration Tasks
The following tasks are not related to any specific DLC type.

Creating a New Configuration
To create a new configuration:

Step 1. Main panel File menu → New.

Step 2. In the Configuration Description panel, enter the configuration file name
and a short description in the Comment field.

Step 3. Press OK to return to the CCM main panel.

Importing an ESCON Configuration
You can import an ESCON channel configuration output file (.SBS) from the
ESCON Generation Assistant. To import a .SBS file, you must create a new CCM
configuration.

To import an ESCON configuration:

Step 1. Main panel File menu → New.

Step 2. In the Configuration Description panel, enter the configuration file name
and a short description in the Comment field.

Step 3. Select the Import ESCON SBS file created with EGA checkbox.

Step 4. Provide the full path information of the .SBS file, including the file name.

Step 5. Press OK to import the .SBS file and return to the previous panel.

Step 6. Press OK to return to the main panel.
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Viewing a List of Available Configurations
You can select a configuration and perform various tasks with it, such as activate,
delete, modify, or open it.

To view the list, main panel File menu → Open:

Figure 6. Main Panel File Menu

Figure 7. Configurations List
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Importing a CCM Configuration
You can import a configuration into the CCM by selecting it from the list of available
configurations.

To import a configuration:

Step 1. Main panel File menu → Import a configuration.

Step 2. In the panel Path Selection, specify the location of the file to be imported
and press OK.

Step 3. In the Import a Configuration panel, select the required configuration
and press Import selected configuration to confirm the importation.

Opening and Modifying a Configuration
To open and modify a configuration:

Step 1. Main panel File menu → Open (see Figure 6 on page 27)

Step 2. From the configuration list, select the configuration you want to modify
(see Figure 7 on page 27).

 Attention 

When you select a configuration, check the level
compatibility column in order to know whether this
configuration is compatible with the running CCM level. If
the level indicated is different from the running CCM level,
the configuration is migrated before being opened or
activated. You are prompted to start the migration when
you try to open or activate such a configuration. After the
migration completion, the level compatibility for the
migrated configuration changes to the running CCM level.
If you have several configurations that are not compatible
with the running CCM level, you can migrate these
configurations at the same time (See “Migrating
Configurations” on page 29).

To check the running CCM level, select Product
Information from the Help pull-down menu.

Step 3. When the configuration opens, modify it as required, see Part 2,
“Resource Configuration” on page 55.

Step 4. When completed: Main panel File menu → Save.

Note:  If you were only viewing the configuration, you can close it without
modification: Main panel File menu → Close opened configuration.
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Saving a Configuration to Diskette or Hard Disk
You can export a configuration in the:

Stand-alone environment
To the A: or B: drive or any accessible hard disk partition.

Service processor environment
Only to the A: drive.

To export a configuration:

Step 1. Main panel File menu → Open.

Step 2. In the configuration list, select the configuration to export and press
Export (see Figure 6 on page 27).

Step 3. In the Path Selection panel, specify the destination disk and press OK.

Activating a Configuration
To activate a configuration:

Step 1. Main panel File menu → Open.

Step 2. In the configuration list, select the configuration you want and press
Activate (see Figure 6 on page 27).

Note:  A configuration cannot be activated if it is currently opened.

 Migrating Configurations
When you have several configurations that are not compatible with the running
CCM level, you can decide to migrate these configurations at the same time. In
order to know if a configuration is compatible with the running CCM level, check the
level compatibility column. If it indicates a level different from the one running, the
configuration must be migrated. To migrate configurations:

Step 1. Main panel File menu → Open.

Step 2. In the configuration list, select the configurations that require migration
and press Migrate.

Moving the MAE Coupler Connection
In the main CCM panel, if you select the coupler configured for the MAE connection
and then right-click, the pop-up contextual menu allows you to go to the Move MAE
configuration function to change the MAE coupler. Because not all unused
couplers cannot be connected to the MAE, this function only offers you the choice
of the couplers that are available.
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Working with the CDF-E
The Reference CDF-E menu (see Figure 8) lets you compare the opened CCM
configuration to a MOSS-E reference CDF-E (configuration definition file-extended).

For example, you might want to compare the active CDF-E of a 3746 with a CCM
configuration that you are planning to use in the 3746. This function allows you to
compare the machine hardware with the future machine configuration offline. This
allows you to check for and resolve any discrepancies between the hardware
configuration (as given in the reference CDF-E file) and the logical configuration
(the CCM configuration file) before activating the CCM configuration.

Figure 8. Reference CDF-E Comparison Menu
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Comparing Couplers and Ports in a Configuration with a Reference
CDF-E

To compare the couplers and ports in a CCM configuration with a MOSS-E
reference CDF-E:

Main panel Options → Reference CDF-E → Compare with CCM configuration
→ CCM Configuration/Reference CDF-E Comparison panel (see Figure 9).

Figure 9. CCM Configuration/Reference CDF-E Comparison Panel

Notes:

1. After the comparison is finished, some of the coupler icon are blue, others
remain white. For more information, see “Blue and White Icons” on page 11.

2. If discrepancies are found between the CCM configuration and the reference
CDF-E, a message is displayed. Additional information about the discrepancies
can be found in the CCM log file.

3. As the MAE is not in the CDF-E file, none of buttons in this panel are enabled
when the MAE is selected in the CCM column. However, the coupler location
of the MAE can be changed, see “Moving the MAE Coupler Connection” on
page 29.

Working with CDF-E Ports
By selecting a LIC11 in the CCM column (see Figure 9) and then clicking Ports,
you can see the results of the port comparison in the CCM Configuration/Reference
CDF-E Ports Comparison panel.

The ports can be sorted, swapped, and deleted to resolve discrepancies in the
same way as the couplers can be in Figure 9.
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Swapping Couplers or Ports
To swap two couplers (or ports), select the two couplers in the CCM configuration
and click Swap.

If the attempted swap is not allowed, does not resolve, or creates a problem, a
message is displayed that saying that you cannot make the swap.

Deleting Couplers or Ports
| To delete a coupler (or port), select it in the CCM column and click Delete. More
| than one coupler (or port) can be selected at the same time for deleting by holding
| down Ctrl.

Sorting the Information in a CDF-E Comparison
You can sort the information in a coupler or port CDF-E comparison by status,
CDF-E, coupler, or CCM configuration.

To sort a comparison:

Step 1. When the coupler or port list is displayed (see Figure 9 on page 31),
press Sort.

Step 2. In the Sort By panel, enter the sort criteria and press Sort.

 Problem Resolution
You can try to resolve any problems by swapping or deleting couplers or ports in
the CCM configuration to obtain either OK or Not configured in the Status column
for all the couplers.

If all the problems cannot be resolved by swapping or deleting, you must return to
the main panel and reconfigure one or more of the couplers.

Note:  None of the changes you make to the CCM configuration are saved until
you click the OK button.

Setting or Clearing the Coupler Type
Once a reference CDF-E - CCM configuration has been made, the “blue” coupler
types are set. There are two ways to change the coupler type once they are set by
the CDF-E:

� To free (clear) all the “blue” couplers:

Main panel Options → Reference CDF-E → Set/clear coupler type.

You can reset the couplers again by selecting Set/clear coupler type again.

� To free (clear) one “blue” coupler:

Right-click the coupler you want to change → Pop-Up menu → Set/clear
coupler type.

You can reset the coupler by clicking Set/clear coupler type again.
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Loading a CDF-E
To load a reference CDF-E into the opened CCM configuration:

Main panel Options → Reference CDF-E → Import/load (see Figure 8 on
page 30)

The disk that the reference CDF-E file can be loaded from varies according to the
CCM environment:

Service Processor
The reference CDF-E can come directly from the MOSS-E disk or from
the A: drive.

Stand-alone
The reference CDF-E can come from the hard drive, the A: drive, or
another .CCM configuration file.

The reference CDF-E loaded into the CCM configuration becomes part of the CCM
configuration when the .CCM configuration file is saved.
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Chapter 4. Working with the CCM Configuration Files from a
Remote Workstation

This chapter describes how:

� To use the file transfer facility provided by the DCAF program or Java Console
application. See “Using the File Transfer Facility.”

� To use the CCM remote configuration application. See “Using the CCM
Remote Configuration Application on AIX Software” on page 40.

Using the File Transfer Facility
If you want to modify the active CCM configuration file, use the file transfer facility
available either through DCAF or the Java Console application1 in order to:

1. Download the required file from the service processor hard disk onto the
remote controlling workstation.

2. Upload the file onto the service processor hard disk, after modifying it.

File Transfer Major Steps
During the CCM configuration file transfer, three major steps take place as shown
in Figure 10 on page 36.

The first step takes place when you download
the configuration file from the service
processor hard disk (Q:\NODE\ MOSSE\
directory) to the remote workstation hard disk
(\CCMIN\ directory)

in Figure 10

  
The second step takes place when you
modify the configuration using a stand-alone
CCM. After modifying and saving the
configuration, you export the configuration to
the \CCMOUT\ directory.

in Figure 10

  
The third step takes place when you upload
the configuration from the remote workstation
hard disk (\CCMOUT\ directory) to the service
processor hard disk (Q:\NODE\MOSSE\
directory).

in Figure 10

1 If you are using the Java Console via an applet, you cannot download and then upload files. You can only download files from
the service processor.
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Figure 10. File Transfer Major Steps

Before you go further...
� If you intend to use Java Console program, it must be running on the remote

workstation. If you intend to use DCAF, DCAF must be correctly configured
and operational.

� You must be remotely connected to and controlling the service processor.
Refer to the Console Setup Guide for more information.
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� You must know the name of the active configuration file. Otherwise, look for it
in the SCHEDULE.DAT file, which is located on the service processor hard disk
in the Q:\NODE\ MOSSE\ directory.

� Two directories must be created on the remote controlling workstation:

– The \CCMIN\ directory into which to download the CCM configuration
file(s).

– The \CCMOUT\ directory where you can export the CCM configuration file
after you modify it.

If they were already created, check these directories are empty before
downloading any file. Otherwise, delete the files contained in them.

Using the Java Console Program
Step 1. In the Java Console, select Actions→File Manager. This displays the

File Manager panel (see Figure 11).

Step 2. From the Local column, select the target directory, which should be
\CCMIN\. From the Remote column, select the source CCM configuration
file from the Q:\NODE\MOSSE\ directory on the service processor hard
disk and double-click it to copy it to the target directory.

Figure 11. Java Console File Manager Panel

Step 3. Using the CCM stand-alone version, import the file from the \CCMIN\
directory (File→Import).

Step 4. Open the file and modify it (File→Open).

Step 5. Then save the configuration using a new name (File→Save as).
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 Attention 

 A CCM configuration is characterized by:

� The name you specify when you first create it or later modify it.
� The name of the file that contains the configuration data. This

name is automatically generated by CCM.

Each time, you modify a configuration, CCM changes the name of
the file that contains the configuration data.

Step 6. Close the configuration.

Step 7. Export the configuration to the \CCMOUT\ directory (File→Open→ Select
the configuration →Export).

Step 8. Check that the modified configuration file has been exported to the
\CCMOUT\ directory.

Step 9. In the Java Console, select Actions→File Manager.

Step 10. In the File Manager panel, select from the Remote column, the
Q:\NODE\MOSSE\ target directory on the service processor hard disk.
Then select the configuration file from \CCMOUT\ in the local file list, and
double-click it to copy it to the target directory.

Step 11. Use CCM (through the MOSS-E) to activate the modified configuration.

Step 12. Once you no longer need to work with the CCM configuration files, delete
the files contained in the CCMIN and CCMOUT directories.

 Using DCAF
Step 1. From the DCAF main panel, select Services→Start File Transfer. This

displays the DCAF - File Transfer Utility panel (see Figure 12).

Step 2. In the Source file name field, type the source configuration name,
including the complete path, as follows:

Q:\NODE\MOSSE\04221247.CCM

Step 3. In the Destination file name field, type the target directory name, followed
by filename.filetype. For example:

C:\CCMIN\04221247.CCM

Step 4. Click Receive.

Figure 12. DCAF File Transfer Utility Panel
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Step 5. Using the CCM stand-alone version, import the file from the \CCMIN\
directory (File→Import).

Step 6. Open the file and modify it (File→Open).

Step 7. Save the configuration using a new name (File→Save as).

See the  note on page 38.

Step 8. Close the configuration.

Step 9. Export the configuration to the \CCMOUT\00 directory (File→Open→
Select the configuration→Export).

Step 10. Check that the modified configuration file has been exported to the
\CCMOUT\ directory.

Step 11. From DCAF main panel, select Services→Start File Transfer.

Step 12. In the Source file name field, type the source configuration name,
including the complete path, as follows:

C:\CCMOUT\04221247.CCM

Step 13. In the Destination file name field, type target directory followed by the
filename.filetype. For example:

Q:\NODE\MOSSE\04221247.CCM

Step 14. Click Send.

Step 15. Use CCM (through the MOSS-E) to activate the modified configuration.

Step 16. Once you no longer need to work with the CCM configuration files, delete
the files contained in the CCMIN and CCMOUT directories.
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| Using the CCM Remote Configuration Application on AIX Software
Based on an client/server application, the CCM remote configuration application
allows a user, from an AIX workstation, to perform the following tasks:

� Access the 3746s to download CCM configurations
� Update the corresponding ASCII files with a text editor
� Upload the resulting CCM configurations
� Activate them after syntax validity checking

What You Need

Required CCM Version
The required CCM version is EC: F64810.

A TCP/IP Connection
There must be a TCP/IP connection between the server and the client. The
TCP/IP connection can be set up by either accessing:

� The service ring via a bridge or a router
� The server through the 3746-9X0 controller

On the Service Processor/Server
� Feature code 5810/5811 must be installed.

On the AIX Client Workstation
� AIX Version 4.2 or later
� A dedicated directory in which to put the client application
� The EULYCLII.CMD executable file and EULYCLI*.DAT files, downloaded using

FTP from the service processor (Q:\NODE\CLIENT directory)

Installing the Client Workstation
Note:  You must know:

1. The service processor IP address

2. The required user identifier and password to access the service processor.

Step 1. Create a directory into which to put the CCM remote configuration
executable files. For example the CCMCLI directory.

Step 2. Using FTP, download the CCM remote configuration application files from
the service processor Q:\NODE\CLIENT directory to the client workstation
CCMCLI directory.

Access to the service processor is password-protected. In addition, a
user identifier must be entered before the password. Check that you
have the required information.

ftp service processor IP address
user: user identifier
password: password
cd Q:/NODE/CLIENT
get eulyclii.cmd
bin
prompt
mget eulycli*.dat
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bye

Step 3. Enter the chmod command to convert the EULYCLII.CMD file to an
executable file:

chmod +X EULYCLII.CMD

Step 4. Launch the EULYCLII.CMD file, which extracts the CCMCLI client
application files.

Checking or Customizing the User Information
The user information consists of the user identifier and the password that must be
entered when you connect to the server.

Note:  In order to use the CCM remote configuration application and configure the
user information, the FC 5810/5811 must be installed on the service processor.

To check or modify the user information, proceed as follows:

Step 1. From the Service Processor menu, select the Configuration
Management → Service Processor (SP) Customization

Step 2. Select the CCM Remote Configuration option and click Next.

Step 3. Click Customize.

Step 4. Enter the management password.

Step 5. In the CCM Remote Configuration panel, the user identifier and password
appear and can be modified. Use the online help for more information.

Before You Start

 Remember That:
� You cannot launch more than one CCM remote configuration application on the

same client workstation.

� Several client workstations can be connected to the same server, but
performing concurrent actions must be avoided.

� You cannot select more than one controller.

It is recommended that you migrate all the configurations that require migration
before using the CCM remote configuration application. Configurations saved with
a previous CCM level cannot be downloaded on the client workstation.

If You Need Help...
Online help is available and consists of contextual and general help.

� Contextual help provides explanations about the commands. Type -? after a
command to get information about the command.

� General help provides information about different topics. Type help to display
the topic list, or type help TOPIC to display information about the specified
topic.
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Starting the Server
It is assumed that the server and its environment, including the TCP/IP connection
between the server and the client, have been correctly installed using the MOSS-E
and checked.

From the main CCM panel, select the Option → Server → Start option.

Note:  If the server is running before the service processor reboot occurs, then it is
automatically restarted. Otherwise, it remains stopped.

Starting the Client Application
From the AIX workstation, start the client application using the ccmcli command:

ccmcli

Connecting to the Server
Connecting to the server consists of the following procedures:

� Connecting to the service processor
� Selecting a remote controller

Before You Start...
1. In order to connect to a service processor, you must know either:

� Its IP address
� Its host name, if the service processor is known by the domain server or

declared in your local host file.

2. You must also provide a user identifier and a password that have been defined
using the MOSS-E.

3. The logon command is case-sensitive.

Connecting to a Service Processor
Use the logon command as follows:

logon target service processor user identifier password

Selecting a Controller
In order to select a controller you must know its name.

Use the select command as follows:

select controller name

If you cannot remember the name of the controller, use the listrc command to
display the list of the controllers:

listrc

42 3746-9X0: CCM User's Guide  



  
 

Switching Between the Local and Remote Environments
After the connection to the server has been established and you have selected a
controller, you can switch between the local environment and the remote
environment.

Which Is Which?
In the local environment, you work with the files located on the (client) workstation
hard disk.

In the remote environment, you can, from the client workstation, directly work with
the files located on the service processor disk.

Switching Between These Environments
At any time, you can switch between these two environments using the following
commands:

� local to switch to the local environment, and
� remote to switch to the remote environment.

However, without switching to the other environment, you can run remote
commands in the local environment, and conversly, by simply adding an 'l' or an 'r'
suffix to the command.

For example, if you are working in the local environment and want to list the files
located on the service processor hard disk, then type:

listr

If you are working in the remote environment, and want to list the files located on
the client workstation hard disk, then type:

listl

Listing the Configuration Files
Use the list command to list the configuration files available in the current working
directory (depending on the current environment you are working in).

If working in the local environment, use the listr to list the files available on the
service processor. If working in the remote environment, use the listl to list the
files available on the client workstation.

If you want to display configuration file name and comments, use the display
command.

display cfgname

Downloading a Remote Configuration
In order to download a configuration from the service processor to the client
workstation, type:

get cfgname

Note:  You cannot download a configuration created with a CCM level previous to
the CCM Level F64810.
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It is therefore recommended that you migrate the configurations that require
migration before using the CCM remote configuration application.

Extracting the ASCII Configuration Files
A CCM configuration consists of several ASCII files. Some of these files are
mandatory. They are:

� .NDF, which is the network definition file that contains the APPN and IP
resource configurations.

� .ESC, which is the ESCON definition file that contains the SNA/subarea, APPN,
and IP ESCON definitions.

Optional files are:

� .IDF, which is the Internet definition file that contains the IP resource data.
� .CMD, which is the SNMP definition file that contains the SNMP definitions.
� .MAE, which is the directory that contains the MAE-related files.

After downloading a configuration, you must extract the ASCII files from the CCM
configuration, in order to update the CCM configuration by editing the ASCII files
with a text editor. The extract command syntax is:

extract cfgname -fn:f.ndf -fi:f.idf -fs:f.cmd -fe:f.esc -fm:d.mae

Note:  The complete command must be typed in on a single line.

Creating a New CCM Configuration
Creating a new configuration on the client workstation requires the creation of the
mandatory .NDF and .ESC files and, if necessary, the .IDF and .CMD optional files
and MAE directory.

The command is:

create cfgname-fn:f.ndf -fi:f.idf -fs:f.cmd -fe:f.esc -fm:d.mae

Note:  The complete command must be typed in on a single line.

Checking a Configuration
Before uploading a configuration from the client workstation to the service
processor, you must check any new or modified CCM configuration. This step is
mandatory.

The command is:

check cfgname

The configuration checking consists of:

� Cross-checking the different configuration files. Because some parameters are
duplicated in the APPN, IP and ESCON files, the configuration of these
parameters must be consistent between these files.

� Processing the different ASCII files in order to generate binary files that can be
managed by the 3746-9x0 controllers and network node processors.
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A configuration that has not been checked cannot be exported. If errors are found
during the checking, they must be corrected and the configuration must be checked
again.

Uploading a Configuration
After successfully checking a configuration, you can transfer the configuration from
the client workstation to the service processor. The command is:

put cfgname

Activating a Configuration
After uploading a configuration, you can activate the configuration on the service
processor from the client workstation. The command is:

activate cfgname

Activating a configuration from the client workstation is traffic-disruptive:

� APPN and IP control points are restarted.
� ESCON processors are re-IMLed.

When being activated, the configuration file is locked (a l flag indicates the locked
status).

Compared to a configuration activation run from the service processor, the following
restrictions apply:

� No dynamic configuration update
� No CDF-E checking
� No resource management.

Note:  If the TCP/IP connection between the server and the client workstation
breaks during a configuration activation, the configuration file remains
locked, even if the activation would have successfully completed without the
connection interruption. Use the unlock command to unlock the
configuration file:

unlock cfgname

Choosing the Interactive or Script Mode
You can run the CCM remote configuration application in two modes:

The interactive mode In this mode, commands are processed in a conversational
mode. Alternatively, you enter commands and then wait
for the responses from the application.

The script mode In this mode, you create batch files that contain a series of
commands, which are processed in sequence when you
type the name of the file at the command prompt. See
Appendix A, “CCM Remote Configuration Application:
Options, Script Commands and Variables” on page 171 to
know more about the available commands and variables
that can be used in the script files.
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Summarizing the Commands
In Table 3 the Remote column indicates the remote commands that can be run
from the local environment. The local column indicates the local commands that
can be run from the remote environment.

Table 3 (Page 1 of 2). CCM Remote Configuration Commands

Command Description Remote Local

activate cfgname To activate a
configuration on the
service processor.

- -

@ To run any shell
command. ¬¬ For
example:

[local]>@ls

This gives the list of
the files located in the
current directory.

- -

check cfgname To check the modified
or new configuration
before uploading it to
the service processor.

checkr checkl

create name -fnndf: -fi:f.idf
-fs:f.cmd -fe:f.esc
-fm:d.mae
 
(see note)

To create a new CCM
configuration on the
client workstation.

- -

delete cfgname To delete a
configuration from the
current working
directory.

deleter deletel

display cfgname To display details
about a configuration
located in the current
working directory.

displayr displayl

exit To quit the application
interactive mode and
switch to the running
script program.

- -

extract name -fn:ndf: -fi:f.idf
-fs:f.cmd -fe:f.esc
-fm:d.mae
 
(see note)

To extract the
configuration ASCII
files from the CCM
local configuration file.

- -

get cfgname To download a
configuration from the
server to the client
workstation.

- -

getrlf To download the
server.log file.

- -

46 3746-9X0: CCM User's Guide  



  
 

Table 3 (Page 2 of 2). CCM Remote Configuration Commands

Command Description Remote Local

list To list the
configuration files
available in the
current working
directory.

listr listl

listrc To display the
controller list.

- -

local To switch to the local
environment

- -

logon server user id password To connect to the
server.

- -

logoff To disconnect from
the server.

- -

modify <cfgname>{-n:<name>} {-c:<comment>} To modify the name
and description of a
configuration located
in the current working
directory.

modifyr modifyl

put cfgname To upload a
configuration to the
server.

- -

quit To quit and stop the
application.

- -

select controller_name To select a controller. - -

test_connection server To test the TCP/IP
connection between
the server and the
client workstation.

- -

remote To switch to the
remote environment
of the specified
server.

- -

unlock cfgname To unlock a
configuration.

- -

Note:  The complete command must be typed in on a single line.
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| Using the CCM Remote “light” Configuration Application on OS/2
| The CCM remote “light” configuration for OS/2 is available with feature code
| FC5812, Extended Function 5. This new function allows the user, using an editor
| on a remote workstation, to modify an already-existing CCM configuration file
| directly. For example, it allows the user to utilize the editor’s Copy/Paste function
| to define a large number of the same resources quickly.

| The CCM remote “light” configuration runs only on the OS/2 operating system,
| but, by using FTP, for instance, the user can use the editor on any type of
| workstation (Windows 95, Windows 98, Windows NT, DOS, and so on).

| The CCM remote “light” for OS/2 enables a user to perform the following tasks:

| � Access the 3746s to download CCM configurations
| � Update the corresponding ASCII files with a text editor
| � Upload the resulting CCM configurations

| What You Need

|  TCP/IP Connection
| There must be a TCP/IP connection between the server and the client. The
| TCP/IP connection can be established by accessing either:

| � The service ring by means of a bridge or a router
| � The server through the 3746-9X0 controller

| On the Service Processor/Server
| � Feature code 5810/5811/5812 must be installed.

| On the OS/2 Client Workstation
| � OS/2 WARP Version 4 or later
| � A dedicated directory into which to put the CCM files

| Installing the Client Workstation
| The CCM remote “light” configuration for OS/2 is an executable file, CCMUPD.EXE,
| that runs on OS/2 only. CCMUPD.EXE is included in the auto-extractable file of
| the CCM stand-alone package and installs automatically when you install the CCM
| stand-alone application.

| For more information on installing the CCM stand-alone application, see Chapter 1,
| “Welcome to the CCM.”

| Checking or Customizing the User Information
| The user information consists of the user identifier and the password that you must
| enter when you connect to the server.

| Note:  In order to use the CCM remote “light” configuration application and
| configure the user information, FC 5810/5811/5812 must be installed on the service
| processor.

| To check or modify the user information, perform the following steps:
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| Step 1. From the Service Processor menu, select the Configuration
| Management → Service Processor (SP) Customization.

| Step 2. Select the CCM Remote Configuration option and click Next.

| Step 3. Click Customize.

| Step 4. Enter the management password.

| Step 5. In the CCM Remote Configuration panel, the user identifier and password
| appear and can be modified. Use the online help for more information.

| Before Using the CCM Remote “light” Configuration Application

|  Remember That:
| It is recommended that you migrate all the configurations that require migration
| before using the CCM remote “light” configuration application, as configurations
| saved with a previous CCM level cannot be downloaded on the client workstation.

| If You Need Help...
| Online help is available by typing ccmupd -?.

| User Operations Description
| There are three major procedures in user operations:

| Procedure 1 Download the CCM configuration file (.CCM) from the service
| processor directory (Q:\NODE\MOSSE\) to an OS/2 workstation.

| Procedure 2 Run CCMUPD.EXE on the OS/2 workstation to convert the
| .CCM file to ASCII text files (.NDF and .IDF). Use an editor on
| the OS/2 workstation or on another workstation (for example, a
| Windows workstation) to modify the .NDF and .IDF files, and
| then convert the .NDF and .IDF files back into the .CCM file.

| Procedure 3 Upload the modified .CCM file to the service processor.

|  Important 

| A CCM configuration is characterized by the following names:

| � The name that you specify when you first create or later modify the CCM
| configuration

| � The name of the file that contains the configuration data. CCM generates
| this file name automatically.

| For example, on the CCM panel, the current configuration name could be:
| Machine 123 at xxx, but the real CCM file (on the MOSS-E disk) would be:
| 12345678.CCM.

| Procedure 1: Download the CCM Configuration File from the
| Service Processor
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|  Important 

| If you want to download only the active configuration file, you must know the
| name of the CCM-generated active configuration file (for example,
| 12345678.CCM). You can find the name in the SCHEDULE.DAT file, which is
| located on the service processor hard disk in the Q:\NODE\MOSSE\ directory.
| You can download this file locally using either the following DCAF or the
| following FTP procedure.

|  Using DCAF:

| Step 1. From the DCAF main panel, select Services→Start File Transfer. The
| DCAF - File Transfer Utility panel appears.

| Step 2. In the Source file name field, type the source configuration name,
| including the complete path, as follows:

| Q:\NODE\MOSSE\ xxxxxxxx.CCM

| where xxxxxxxx represents digits.

| Step 3. In the Destination file name field, type the target directory name, followed
| by filename.filetype, as follows: C:\CCMIN\ xxxxxxxx.CCM

| Step 4. Click Receive.

|  Using FTP:

| Step 1. From the OS/2 window, create a directory into which to download the
| configuration files, and then make that directory the current directory. For
| example:

| mkdir \CCMIN
| cd \CCMIN

| Step 2. Using FTP, download the CCM configuration files from the service
| processor

| ftp service processor IP address
| user: user identifier defined in service processor customization
| password: password defined in service processor customization
| cd Q:\NODE\MOSSE
| bin
| prompt
| mget *.CCM
| bye
|  Important 

| Service processor customization rules requires that the password be
| uppercase.

| Procedure 2: Convert the CCM Configuration File into ASCII
| Files
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|  Important 

| Before working with the CCM configuration file, you must back up all service
| processor CCM configuration files to a local directory.

| On the service processor, the CCM configuration files are located in
| Q:\NODE\MOSSE\*.CCM.

| On a stand-alone workstation, if you performed Procedure 1, the CCM
| configuration files are located in \CCMIN.

| Note:  If you want to see the syntax of the CCMUPD.EXE tool, type ccmupd -?.

| Step 1. Determine which CCM file in which configuration you want to update.
| Copy all .CCM files from \CCMIN into your working directory where you
| installed the CCM stand-alone application. Use the command ccmupd to
| obtain the list of configurations with the configuration names and the
| names of the .CCM files.

| For example,

| | BEX-FR 2 Uplinks Jun-07-2000 16:29 H10014/000 | 06071630.CCM
| | BIGNET+MCLReg+10K Feb-22-2000 11:53 H10014/000 | 02221153.CCM
| | NEW2ET+MCLReg+10K Feb-22-2000 11:53 H10014/000 | 5500.CCM

| You can also use the method described in Procedure 1 to determine
| which file is the active configuration file, if you do not know its name.

| Step 2. Extract the APPN configuration file from the .CCM file to your current
| directory by using the following command:

| ccmupd GET opened.ndf xxxxxxxx.ccm

| where xxxxxxxx represents digits.

| Step 3. Use an editor to modify the APPN ASCII file (OPENED.NDF), and then
| save it.

| Step 4. Put the updated APPN ASCII file in your .CCM file by using the following
| command:

| ccmupd PUT opened.ndf xxxxxxxx.ccm

| where xxxxxxxx.ccm

| is the same file name as that in Step 2.

| If a syntax error occurs, the .CCM file will not be updated. Errors are
| listed in the following files:

| � PSNA_CCM.LOG -> APPN errors output found in OPENED.NDF
| (see note)

| � IDF_COM.LOG -> IP errors output found in OPENED.NDF

| � CFG_COM.LOG -> Miscellaneous errors output

| Explanations of the errors are explicit, and often the line where the error
| appears is listed.

| Note:  The following PSNA_CCM.LOGsyntax error message about
| OPENED.SEC is not actually an error because the last line indicates that
| the verification of the PSNA configuration was successful:
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| Parsing of the node definitions file started.
| Parsing of the node definitions file was successful.
| APN0421W fopen failed for the security information
|  file (.SEC)=PUTCFG\OPENED.SEC.
| APN0434W An empty or missing security information
| file (.SEC) is OK if no security
| information is defined in the PSNA
|  configuration.
| An empty security information file will be created.
| Verification of the PSNA configuration started.
| Verification of the PSNA configuration was successful.

| Step 5. Repeat Steps 2 on page 51, 3 on page 51, and 4 on page 51 to extract
| the IP configuration file by replacing the name of the APPN configuration
| file (OPENED.NDF) with the name of the IP configuration file
| (OPENED.IDF). For example:

| ccmupd GET opened.idf 12345678.ccm
| ccmupd PUT opened.idf 12345678.ccm

| Step 6. Prepare for Procedure 3 by typing the following command:

| copy xxxxxxxx.ccm \CCMOUT

| Procedure 3: Uploading the CCM Configuration File to the
| Service Processor
| This procedure describes how to use FTP to upload the modified .CCM file to the
| service processor.

|  Using DCAF:

| Step 1. From the DCAF main panel, select Services→Start File Transfer. The
| DCAF - File Transfer Utility panel appears.

| Step 2. In the Source file name field, type the source configuration name,
| including the complete path, as follows:

| C:\CCMOUT\xxxxxxxx.CCM

| where xxxxxxxx represents digits.

| Step 3. In the Destination file name field, type the target directory name, followed
| by the CCM file name. For example:

| Q:\NODE\MOSSE\xxxxxxxx.CCM

| Step 4. Click Send.

| Step 5. Use CCM (through the MOSS-E) to activate the modified configuration.

| Step 6. Once you no longer need to work with the .CCM configuration files, delete
| the files contained in the CCMIN and CCMOUT directories.

|  Using FTP:

| Step 1. From the OS/2 window, change the directory to \CCMOUT.

| Step 2. Using FTP, upload the CCM configuration files to the service processor.
| For example:

| ftp service processor IP address
| user: user identifier defined in service processor customization
| password: password defined in service processor customization
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| cd Q:\NODE\MOSSE
| bin
| prompt
| mput *.CCM
| bye

|  Important 

| Service processor customization rules require that the password be
| uppercase.

| Step 3. Use CCM (through the MOSS-E) to activate the modified configuration.

| Step 4. Once you no longer need to work with the .CCM configuration files, delete
| the files contained in the CCMIN and CCMOUT directories.
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 Part 2. Resource Configuration
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Chapter 5. Beginning a CCM Configuration

If you are creating a new configuration and if you are configuring the first coupler,
go to Step 1 on page 58.

Otherwise, go to Step 4 on page 58.

Note:  To save a new configuration, at least the following two parameters must
have a value:

Network node: Network identifier and Control point name

To go to these parameters: Main panel Configuration menu → NN/FP/DLUR →
Network Node/Focal Point/Dependent LU Requester Parameters panel.

It is possible to save a configuration with only these two parameters and the name
of the configuration file defined.

Figure 13. Main CCM Panel
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To start a new configuration:

Step 1. Double-click the icon for the coupler you want to configure. This displays
the 3745/3746 Parameters panel (see Figure 14).

Figure 14. 3745/3746 Parameters Panel

Step 2. Enter the parameters as required for your configuration.

Notes:

a. If you leave the default 950 for the 3746 model, you will not be able
to add the 3745 identifier or set the mode of operation.

b. Information you have entered on some of the fields is retained by the
CCM. This information can be later modified by: Main panel
Configuration menu → 3745/3746 Parameters

Step 3. When completed, click OK → Coupler/Processor Type panel (see
Figure 15).

Figure 15. CCM Coupler/Processor Type Panel

Step 4. Select the desired coupler type.
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Step 5. Click OK → Port Configuration panel for the selected port type.

Step 6. For the specific configuration, go to the appropriate chapter:

� Chapter 6, “Configuring an ESCON Coupler” on page 61
� Chapter 7, “Configuring a Token-Ring Coupler” on page 69
� Chapter 8, “Configuring Serial Line SDLC Resources” on page 77
� Chapter 9, “Configuring Serial Line Frame-Relay Resources” on

page 83
� Chapter 10, “Configuring Serial Line PPP Resources” on page 95
� Chapter 11, “Configuring Serial Line X.25 Resources” on page 99
� Chapter 12, “Configuring the MAE” on page 107

Configuring Stations on Coupler/Port 2080
You specify the type of stations to be automatically generated on the 2080 port.
The station type depends on your use of the port:

 � Service Processor

– For a remote console using DCAF

– To use the Aping function

– To send alerts to NetView for AIX2

 � NPM

– To use NetView Performance Monitor

To configure these parameters go to the Configuration menu on the Main panel and
select Stations on Coupler/Port 2080 (see Figure 16). Select either Service
Processor or NPM and click OK.

Figure 16. Stations on Coupler/Port 2080 Panel

2 After Version 4.0, NetView for AIX has been renamed to Tivoli NetView.
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Chapter 6. Configuring an ESCON Coupler

Before You Start...
� If this is the first coupler to be configured in a new CCM configuration, see

Chapter 5, “Beginning a CCM Configuration” on page 57.

� If this is the first time the coupler is to be configured, but it is not the very first
one to be configured, double-click the icon of the coupler you want to configure,
select its DLC type (see Figure 15 on page 58), and go to “Configuring the
ESCON Port Parameters.”

� If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double-click the icon of the coupler you want
to configure, and go to “Configuring the ESCON Port Parameters.”

If You Need Help...
Use the CCM online help or the 3745/3746 Planning Series: ESCON Channels for
more information about the ESCON configuration parameters.

Configuring the ESCON Port Parameters
From the ESCON Port configuration panel (see Figure 17), you can specify
configuration parameters for the ESCON ports and the ESCON Directors (ESCDs).

Figure 17. ESCON Port Configuration Panel

Step 1. Enter the parameters values as required. As you enter the values, CCM
dynamically checks them for configuration-wide consistency, see “An
Easier Way to Configure” on page 15.
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Note:  An ESCON port can be shared by an APPN network, an IP
network, and an SNA/Subarea network.

To configure IP access control filtering for this port, continue with the next
step.

Otherwise, go to Step 16 on page 63.

Step 2. To configure the input packet filter, click Input Packet Filter.... The Input
Packet Filter panel appears (see Figure 18).

Figure 18. Input Packet Filter Panel

| Step 3. Select the Access control type that you want, and enter the source and
| destination network IP addresses, the IP protocol number, and the
| destination and source port numbers.

| Step 4. Click the TCP/ICMP... button and define TCP/ICMP for the current access
| control.

| Step 5. Click Add to add the new access control entries.

| Step 6. Repeat Steps 3 through 5 for any other access control entires that you
| want to define.

| Step 7. Check Enable Input Packet to filter incoming traffic.

| Step 8. When you have completed configuring the input packet filter, click OK.
| The ESCON Port Configuration panel reappears.

Step 9. To configure the output packet filter, click Output Packet Filter... (see
Figure 19 on page 63).
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Figure 19. Output Packet Filter Panel

| Step 10. Select the Access control type that you want, and enter the source and
| destination network IP addresses, the IP protocol number, and the
| destination and source port numbers.

| Step 11. Click the TCP/ICMP... button and define TCP/ICMP for the current access
| control.

| Step 12. Click Add to add the new access control entries.

| Step 13. Repeat Steps 10 through 12 for any other access control entires that you
| want to define.

| Step 14. Check Enable Output Packet Filter to filter outgoing traffic.

| Step 15. When you have completed configuring the output packet filter, click OK.
| The ESCON Port Configuration panel reappears.

Step 16. When you have completed configuring the port parameters, click one of
the following options:

� OK to save and exit
� Host links... to display the ESCON Host Links Configuration panel;

then continue with “Configuring the ESCON Host Link Parameters” on
page 64.
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Configuring the ESCON Host Link Parameters

Figure 20. ESCON Host Links Configuration Panel

Step 1. Enter the parameters as required in the ESCON Host Links Configuration
panel (see Figure 20).

Note:  A host link can be shared by an APPN network, an IP network
and an SNA/Subarea network.

Step 2. When completed, click Add.

Note:  After clicking Add, the host link information you have just entered,
is added to the Host Link Already Configured list. Depending on the type
of host link configured, other pushbuttons are now available.

Step 3. Repeat Step 1 and Step 2 for any other host links to be defined.

Otherwise, continue with the next step.

Step 4. To configure the APPN parameters for one or more host links, go to Step
5.

Otherwise, to configure ESCON stations for host links, go to “Configuring
ESCON Station Parameters” on page 65.

Configuring the Port APPN Parameters

Step 5. Select a host link and click APPN parameters → ESCON Port
Configuration - APPN Parameters panel.

Step 6. Keep the default APPN values or change them as needed.

Step 7. When completed, click OK to return to the Host Links Configuration
panel.
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Step 8. Repeat Step 5 through Step 7 for any other host link that is to be used for
APPN.

Otherwise, go to “Configuring ESCON Station Parameters,” or click  OK
to save and exit.

Configuring ESCON Station Parameters
Step 1. From the Host Links Configuration panel, select a host link and click

Stations...→ ESCON Station Configuration panel.

Step 2. Enter the parameters values as required. As you enter the values, CCM
dynamically checks them for configuration-wide consistency, see “An
Easier Way to Configure” on page 15.

Note:  A station cannot be shared by several networks. It is configured
to work in a single network.

If the station is defined for an IP network, the IP address must be
specified in this panel.

| Step 3. Click Add. The ESCON Host Links Configuration panel reappears.

Note:  After clicking Add, the station information you have just entered, is
added to the ESCON Stations Already Configured list. Depending on the
type of station configured, other pushbuttons are now available.

Step 4. Repeat Step 2 and Step 3 for any other station to be defined.

Otherwise, continue with the next step.

| Step 5. If you need to configure:

| a. Station APPN parameters for one or several stations, continue with
| the next step.

| b. IP parameters for one or several stations, go to Step 18 on page 67.

Otherwise, go to Step 13 on page 66.

Configuring the Station APPN Parameters

Step 6. Select a station and click APPN parameters... → ESCON Station
Configuration - APPN Parameters panel (see Figure 21 on page 66).
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| Figure 21. ESCON Station Configuration - APPN Parameters Panel

Step 7. Either keep the default values or change these values according to your
needs.

Step 8. To configure the transmission group for this station, continue with the next
step.

Otherwise, go to Step 12.

Step 9. Click TG characteristics... → Station Configuration - TG
characteristics panel.

Step 10. Either keep the default values or change these values according to your
needs.

Step 11. When completed, click OK to save and return to the previous panel.

Step 12. When completed, click OK to save and return to the ESCON Station
Configuration panel.

Step 13. To configure the DLC parameters for one or several stations, select a
station and click DLC parameters → ESCON Station - DLC Parameters
panel.

Otherwise, go to Step 16.

Step 14. Keep the default values, or change these values according to your needs.

Step 15. When completed, click OK to save, and return to the ESCON Station
Configuration panel.

Step 16. Click OK to return to the Host Links Configuration panel.

Step 17. To configure ESCON stations for any other host link, repeat Step 1
(starting on page 65) through Step 16.
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| To configure the IP parameters for a station, continue with the next step.
| Otherwise, go to step 20 on page 67.

| Configuring the Port IP Parameters

| Step 18. Select a station and click IP parameters. → ESCON Station
| Configuration - IP Parameters panel.

| Step 19. Either keep the default values or change these values according to your
| needs.

Step 20. Click OK on each panel until the CCM main panel is displayed.
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Chapter 7. Configuring a Token-Ring Coupler

Before You Start...
� If this is the first coupler to be configured in a new CCM configuration, see

Chapter 5, “Beginning a CCM Configuration” on page 57.

� If this is the first time the coupler is to be configured, but it is not the very first
one to be configured, double-click the icon of the coupler you want to configure,
select its DLC type (see Figure 15 on page 58), and go to “Configuring
Token-Ring Ports.”

� If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double-click on the icon of the coupler you
want to configure, and go to “Configuring Token-Ring Ports.”

If You Need Help...
Use the CCM online help and the 3745/3746 Planning Series: Token Ring and
Ethernet for more information about the token-ring configuration parameters.

Configuring Token-Ring Ports

Figure 22. Token-Ring Port Configuration Panel

Step 1. Enter the parameters values as required in the Token-Ring Configuration
panel (see Figure 22). As you enter the values, CCM dynamically checks
them for configuration-wide consistency, see “An Easier Way to
Configure” on page 15.

Note:  A token-ring port can be shared between IP and APPN networks.

Step 2. When completed, click OK to save and exit. Otherwise:

� To configure the port APPN parameters, go to Step 3 on page 70.
� To configure the IP parameters, go to Step 10 on page 70.
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� To configure the port DLC parameters, go to Step 18 on page 71.
� To configure the connection network, go to Step 22 on page 72.
� To configure the stations, see “Configuring Token-Ring Stations” on

page 73.

Configuring Port APPN Parameters

Step 3. Click APPN parameters → Token-Ring Port Configuration - APPN
| Parameters panel (see Figure 23).

| Figure 23. Token-Ring Port Configuration - APPN Parameters Panel

Step 4. Keep the default parameter values, or change these values according to
your needs.

Step 5. If you want to configure the user defined parameters, continue with the
next step.

Otherwise, to Step 8.

Step 6. Click User defined parameters.

Step 7. When completed, click OK.

Step 8. Click OK to return to the Token-Ring Port Configuration panel.

Step 9. If you want to use IP over a token-ring port, continue with the next step.

Otherwise, go to Step 21 on page 72.

Configuring Port IP Parameters

Step 10. Click IP parameters... to display the IP over Token-Ring Parameters
panel (see Figure 24 on page 71).
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Figure 24. IP Over Token-Ring Parameters Panel

Step 11. Enter the IP address and the subnetwork mask values (note that up to 16
IP address and subnetwork mask pairs can be defined). Keep or change
the RIF timer default value according to your needs.

To configure IP access control filtering for this port, continue with the next
step.

Otherwise, go to Step 16.

Step 12. To define the input packet filter, click Input Packet Filter.... (see
Figure 18 on page 62).

Step 13. When completed, click OK.

Step 14. To define the output packet filter, click Output Packet Filter.... (see
Figure 19 on page 63).

Step 15. When completed, click OK.

Step 16. When the IP configuration is completed, click OK to return to the
Token-Ring Port Configuration panel.

Step 17. If you want to configure the DLC port parameters, continue with the next
step.

Otherwise, go to step 21 on page 72.

Configuring Port DLC Parameters

Step 18. Click DLC defaults....

Step 19. Keep the default parameter values, or change these values according to
your needs.

Step 20. When completed, click OK to return to the Token-Ring Port Configuration
panel.
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Step 21. If you want to configure port connection network parameters, continue
with the next step.

Otherwise, go to Step 27.

Configuring Port Connection Network Parameters

Step 22. Connection network → Token-Ring Connection Network panel (see
Figure 25).

Figure 25. Token-Ring Connection Network Panel

Step 23. Enter the Network identifier and the CN name.

Step 24. Click Add CN.

Notes:

a. After clicking Add CN, the connection network that you have just
configured is added to the Connection Networks Already
Configured list. Depending on the type of connection network
configured, other push buttons are now available.

b. After clicking Add CN, you must click Add port to CN, otherwise the
connection network information you have just entered will not be
saved.

c. If connection networks have been defined, select the one to which
you want to add the port currently being defined. A total of five ports
can be added to each connection network.

Step 25. Click Add port to CN.

Step 26. When completed, click OK to save and return to the previous panel.

Step 27. If you want to define token-ring stations, go to “Configuring Token-Ring
Stations” on page 73.

Otherwise, click OK to exit.
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Configuring Token-Ring Stations
Note:  Token-ring stations only need to be configured when the connection must
be established from the controller to the stations.

Step 1. From the Token-Ring Port Configuration panel, click Stations to display
the Token-Ring Station Configuration panel (see Figure 26).

Figure 26. Token-Ring Station Configuration Panel

Step 2. Enter the parameters values as required. As you enter the values, CCM
dynamically checks them for configuration-wide consistency, see “An
Easier Way to Configure” on page 15.

Step 3. Click Add.

Note:  After clicking Add, the station that you have just configured is
added to the Token-Ring Stations Already Configured list. Depending on
the type of station configured, other pushbuttons are now available.

Step 4. If you need to configure APPN parameters for the station, continue with
the next step.

Otherwise, go to Step 15 on page 74.

Configuring Station APPN Parameters

Step 5. Select a station and click APPN parameters... → Token-Ring Station
Configuration – APPN Parameters panel (see Figure 27 on page 74).
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Figure 27. Token-Ring Station Configuration - APPN Parameters Panel

Step 6. Either keep the default values or change these values according to your
needs. If you want to configure remote LUs on adjacent nodes, continue
with the next step.

Otherwise, go to Step 9.

Step 7. Click LUs....

Step 8. When completed, click OK.

Step 9. To configure the transmission group for this station, continue with the next
step.

Otherwise, go to Step 13.

Step 10. Click TG characteristics... → Station Configuration - TG
characteristics panel.

Step 11. Either keep the default values or change these values according to your
needs.

Step 12. When completed, click OK to save and return to the previous panel.

Step 13. Click OK to save and return to the Token-Ring Station Configuration
panel.

Step 14. Repeat Steps 5 on page 73 through 13 until you have configured the
APPN parameters for each station that requires APPN parameter
configuration, or continue with the next step.

Configuring Station DLC Parameters

| Step 15. If you need to configure DLC parameters for the station, continue with the
| next step.
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| Otherwise, go to Step 21 on page 75.

| Step 16. To configure the DLC parameters for a station, DLC parameters →
| Token-Ring Station - DLC Parameters 1/2 panel.

| Step 17. Keep the default values, or change these values according to your needs.

| Step 18. Token-Ring Station - DLC Parameters 1/2 → Parameters 2/2 →
| Token-Ring Station - DLC Parameters 2/2 panel.

Step 19. Keep the default values, or change these values according to your needs.

Step 20. When completed, click OK to save and return to the Token-Ring Station
Configuration panel.

Step 21. Click OK on each panel until the CCM main panel is displayed.
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Chapter 8. Configuring Serial Line SDLC Resources

This chapter explains the configuration of serial line couplers LIC11 and LIC12 for
SDLC lines.

Before You Start...
� If this is the first coupler to be configured in a new CCM configuration, see

Chapter 5, “Beginning a CCM Configuration” on page 57.

� If this is the first time the coupler is to be configured, but it is not the very first
one to be configured, double-click the icon of the coupler you want to configure,
select its DLC type (see Figure 15 on page 58), and go to “Configuring the
SDLC Port.”

� If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double-click on the icon of the coupler you
want to configure, and go to “Configuring the SDLC Port.”

If You Need Help...
Use the CCM online help or the 3745/3746 Planning Series: Serial Line Adapters,
GA27-4235 for more information about the serial line parameters.

Configuring the SDLC Port
Note:  A LIC12 has only one port, a LIC11 can have up to 30 ports.

Figure 28. Serial Line Port Configuration Panel

Step 1. In the Port Configuration panel (see Figure 28), select the DLC type as
SDLC and enter the other parameters values as required. As you enter
the values, CCM dynamically checks them for configuration-wide
consistency, see “An Easier Way to Configure” on page 15.
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Step 2. When completed, click Add.

Note:  After clicking Add, the port you have just configured is added to
the Ports Already Configured list. Depending on the type of port
configured, other push buttons are now available.

Step 3. If you want to configure APPN parameters for a port, continue with the
next step.

Otherwise, go to Step 10.

Configuring Port APPN Parameters

Step 4. Select a port and click APPN parameters → Port Configuration - APPN
parameters... panel (see Figure 23 on page 70).

Step 5. Keep the default values or modify these values according to your needs.

Step 6. If you want to configure the user defined parameters, continue with the
next step.

Otherwise, to Step 8 on page 70.

Step 7. Click User defined parameters.

Step 8. Click OK.

Step 9. When completed, click OK to return to the previous panel.

Step 10. If you want to configure the DLC parameters for the port, continue with
the next step.

Otherwise go to Step 15 on page 79.
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Configuring Port DLC Parameters

Step 11. Click DLC parameters → SDLC Port - DLC Parameters 1/3 panel.

Step 12. Keep the default values or modify these values according to your needs
(see Figure 29).

Figure 29. The First DLC Port Parameters Panel for SDLC

Note:  There are three panels containing the DLC port parameters, you
can display the second and third panels in any order.

Step 13. When completed, click OK to return to the previous panel.

Note:  If the DLC Parameters 2/3 or DLC Parameters 3/3 panel is
displayed, you must first return to the DLC Parameters 1/3 panel, then
click OK in that panel to exit.

Step 14. Repeat Step 1 on page 77 through Step 13 for any other ports that need
to be configured.

Step 15. At this point, you can either:

� Save and exit port configuration by clicking OK.

� Configure stations by going to “Configuring SDLC Stations” on
page 80.

  Chapter 8. Configuring Serial Line SDLC Resources 79



  
 

Configuring SDLC Stations
Step 1. From the Port Configuration panel, select a port and click APPN Stations

→ SDLC Station Configuration panel (see Figure 30).

Figure 30. SDLC Station Configuration Panel

Step 2. Enter the parameters as required and click Add.

Note:  After clicking Add, the station you have just configured, is added
to the SDLC Stations Already Configured list. Depending on the type of
station configured, other push buttons are now available.

Step 3. If you need to configure APPN parameters for the station, continue with
the next step.

Otherwise, go to Step 13 on page 81.
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Configuring Station APPN Parameters

Step 4. Select a station and click APPN parameters to display the SDLC Station
Configuration – APPN Parameters panel (see Figure 27 on page 74).

Step 5. Either keep the default values or change these values according to your
needs. To configure remote LUs on adjacent nodes, continue with the
next step.

Otherwise, go to Step 8.

Step 6. Click LUs... → Adjacent Node - Remote LUs panel.

Step 7. When completed, click OK.

Step 8. To configure the transmission group for the MLTG, continue with the next
step.

Otherwise, go to Step 12.

Step 9. Click TG characteristics → Station Configuration - TG characteristics
panel.

Step 10. Either keep the default values or change these values according to your
needs.

Step 11. When completed, click OK to save and return to the previous panel.

Step 12. When the APPN configuration is completed, click OK to save and return
to the SDLC Station Configuration panel.

Step 13. To configure the DLC parameters for a station, select a station and click
DLC parameters → SDLC Station - DLC Parameters panel.

Otherwise, go to Step 17 on page 82.

Figure 31. First SDLC Station Configuration - DLC Parameters Panel
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Step 14. Keep the default values, or change these values according to your needs.

Step 15. When completed, click OK to save, and return to the SDLC Station
Configuration panel.

Note:  If the DLC Parameters 2/2 panel is displayed, you must first return
to the DLC Parameters 1/2 panel by clicking OK or Cancel.

Step 16. Repeat Step 1 on page 80 through Step 15 any other stations that need
to be configured.

Step 17. Click OK to return to the Port Configuration panel.

Step 18. To configure stations on another port, select the port and go to
“Configuring SDLC Stations” on page 80.

Step 19. If no other stations need to be defined, click OK on each panel until the
CCM main panel is displayed.
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Chapter 9. Configuring Serial Line Frame-Relay Resources

This chapter explains the configuration of the serial line couplers LIC11 and LIC12
for frame-relay lines. The frame-relay configuration procedure for defining the
DLCIs is different depending on your choice of bandwidth management (a DLC port
parameter) used:

� COMRATE (communications rate)
� CIR (committed information rate).

Before You Start...
� If this is the first coupler to be configured in a new CCM configuration, see

Chapter 5, “Beginning a CCM Configuration” on page 57.

� If this is the first time the coupler is to be configured, but it is not the very first
one to be configured, double-click the icon of the coupler you want to configure,
select its DLC type (see Figure 15 on page 58), and go to “Configuring a
Frame Relay Port.”

� If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double-click on the icon of the coupler you
want to configure, and go to “Configuring a Frame Relay Port.”

If You Need Help...
Use the CCM online help or the 3745/3746 Planning Series: Serial Line Adapters,
GA27-4235 for more information about the frame-relay configuration parameters.

Configuring a Frame Relay Port
Note:  A LIC12 has only one port, a LIC11 can have up to 30 ports.
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Figure 32. Serial Line Port Configuration Panel

Step 1. In the Port Configuration panel (see Figure 32), select the DLC type as
Frame Relay and enter the other parameters values as required. As you
enter the values, CCM dynamically checks them for configuration-wide
consistency, see “An Easier Way to Configure” on page 15.

Note:  After clicking Add, the port you have just configured is added to
the Ports Already Configured list. Depending on the type of port
configured, other pushbuttons are now available.

For information about creating one or more ports identical to one in the
Ports Already Configured list, see “Copy” on page 23.

Step 2. If you want to configure APPN parameters for a port, continue with the
next step.

Otherwise, go to Step 7.

Configuring Port APPN Parameters

Step 3. Click APPN parameters → Frame Relay Port Configuration - APPN
Parameters panel (see Figure 23 on page 70).

Step 4. Keep the default values or modify these values according to your needs.

Step 5. Click User defined parameters if you want to define these parameters at
the port level. Otherwise, continue with the next step.

Step 6. When completed, click OK to return to the previous panel.

Step 7. If you want to configure the DLC parameters for a port, continue with the
next step.

Otherwise go to Step 15 on page 86.

Configuring the Port DLC Parameters
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Step 8. Click DLC parameters → Frame-Relay Port - DLC Parameters panel
(see Figure 33 on page 85).

Step 9. Keep the default values or modify these values according to your needs.

In this panel, you choose the type of bandwidth management
(COMRATE, the default, or CIR) to be used for all the traffic on this port.
This choice decides which panel you use for configuring in “Defining
Frame-Relay DLCIs and Stations” on page 88.

Figure 33. Frame-Relay Port - DLC Parameters Panel

Step 10. Click Parameters 2/2... to configure additional DLC parameters (see
Figure 34).

Figure 34. Frame-Relay Port - DLC Parameters 2/2 Panel
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When completed, click Parameters 1/2 to return to the previous panel.

Step 11. Click LMI to configure the frame-relay local management interface.

Step 12. When completed, click OK.

Step 13. If CIR is selected as the Bandwidth management, click CIR Parameters
to configure CIR and CLLM parameters.

Step 14. When completed, click OK until you reach the Port Configuration panel.

Step 15. If you want to configure IP over Frame Relay for the port, continue with
the next step.

Otherwise go to Step 23 on page 87.

Step 16. Click IP parameters → IP over Frame-Relay Parameters panel (see
Figure 35).

Figure 35. IP over Frame-Relay Parameters Panel

Step 17. Keep the default General values or modify them according to your needs.

Enter the IP addresses that you want to use on this port.

If you want to configure IP access control filtering for this port, continue
with the next step.

Otherwise, go to Step 22 on page 87.

Step 18. To define the input packet filter, click Input Packet Filter.... (see
Figure 18 on page 62).

Step 19. When completed, click OK.

Step 20. To define the output packet filter, click Output Packet Filter.... (see
Figure 19 on page 63).

Step 21. When completed, click OK.
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Step 22. When the IP configuration is completed, click OK to return to the previous
panel.

Step 23. When completed, you can either:

� Save and exit port configuration by clicking OK.

� Configure stations by going to “Defining Frame-Relay DLCIs and
Stations” on page 88.
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Defining Frame-Relay DLCIs and Stations
In order to configure the stations, you must first define the DLCIs for the
frame-relay port. Then you define the stations for each DLCI.

Step 1. Select a frame-relay port and click DLCI.

Step 2. If you configured the port for COMRATE bandwidth management, to
configure stations, continue with the next step (see Figure 33 on
page 85).

Otherwise, go to Step 14 on page 89 to configure stations using CIR
bandwidth management.

Step 3. In the Frame-Relay DLCI/COMRATE Parameters panel (see Figure 36),
for each DLCI you need keep the default values or modify these values
according to your needs and click Add.

Figure 36. Frame-Relay DLCI/COMRATE Parameter Panel

Step 4. If you want to configure remote IP addresses for a DLCI, click IP
addresses... → DLCI Remote IP Addresses panel and continue with the
next step.

Otherwise, go to Step 7.

Step 5. Enter the values according to your needs.

Step 6. When completed, click OK to return to the previous panel.

Step 7. If you want to change parameters for the FRFH, click FRFH set →
Frame-Relay Handler Set Configuration panel and go to next panel.

Otherwise, go to step 10 on page 89.

Step 8. Keep the default values or modify these values according to your needs.

Step 9. When completed, click OK to return to the previous panel.
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Step 10. If you want to change the default DLCI communication rates (COMRATE)
for the APPN and IP stations, click Default DLCI → Frame-Relay
COMRATE - Default DLCI panel

Step 11. Keep the default values or modify these values according to your needs.

Step 12. When completed, click OK to return to the previous panel.

Step 13. Go to Step 27 on page 90 

Step 14. In the Frame-Relay DLCI/CIR Parameters panel (see Figure 37), for each
DLCI you need keep the default values or modify these values according
to your needs and click Add.

Figure 37. Frame-Relay DLCI/CIR Parameters Panel

Step 15. If you want to configure remote IP addresses for a DLCI, click IP
addresses... → DLCI Remote IP Addresses panel and continue with
the next step.

Otherwise, go to Step 18.

Step 16. Enter the values according to your needs.

Step 17. When completed, click OK to return to the previous panel.

Step 18. If you want to configure BRS parameters for a selected DLCI, click BRS
→ Frame-Relay CIR - Bandwidth Reservation System (BRS) panel,
and continue with the next step.

Otherwise, go to Step 21 on page 90.

Step 19. Keep the default values or modify these values according to your needs.

Step 20. When completed, click OK to return to the previous panel.
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Step 21. If you want to change parameters for the FRFH, click FRFH set →
Frame-Relay Handler Set Configuration panel and continue with the
next step.

Otherwise, go to Step 24.

Step 22. Keep the default values or modify these values according to your needs.

For more information about configuring a FRFH, see “Configuring
Frame-Relay Frame Handler Sets” on page 94.

Step 23. When completed, click OK to return to the previous panel.

Step 24. If you want to change the default DLCI committed information rate (CIR)
for the APPN and IP stations, click Default DLCI → Frame-Relay CIR -
Default DLCI panel and go to next panel.

Otherwise, go to Step 27.

Step 25. Keep the default values or modify these values according to your needs.

Step 26. When completed, click OK to return to the previous panel.

Step 27. Click Add.

Note:  After clicking Add, the DLCI information you have just entered, is
added to the DLCIs Already Configured list. Depending on the type of
DLCI configured, other push buttons are now available.

Step 28. Repeat step 2 on page 88 through 27 for any other DLCIs to be defined
on the same frame-relay port.

Step 29. If you want to configure APPN stations for a DLCI, go to “Configuring
APPN over Frame-Relay Stations” on page 91.

Otherwise, go to Step 23 on page 93.
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Configuring APPN over Frame-Relay Stations
Step 1. Select a DLCI and click APPN stations → APPN over Frame Relay –

Station Configuration Panel (see Figure 38).

Figure 38. APPN over Frame Relay – Station Configuration Panel

Step 2. Enter the parameters as required.

Step 3. Click Add.

Note:  After clicking Add, the station you have just configured, is added
to the Frame Relay Stations Already Configured list. Depending on the
type of station configured, other push buttons are now available.

For information about creating one or more stations identical to one in the
Frame-Relay Stations Already Configured list, see “Copy” on page 23.

Step 4. If you need to configure APPN parameters for the station, continue with
the next step.

Otherwise, go to Step 15 on page 92.

Configuring Station APPN Parameters

Step 5. Select a station and click APPN parameters → Frame-Relay Station
Configuration – APPN Parameters panel (see Figure 27 on page 74).

Step 6. Either keep the default values or change these values according to your
needs.

If you want to configure remote LUs on adjacent nodes (if AOD has been
selected), continue with the next step.

Otherwise, go to Step 9 on page 92.

Step 7. Click LUs....

Step 8. When completed, click OK.
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Step 9. To configure the transmission group for the MLTG (including the user
defined parameters used to change route priority), continue with the next
step.

Otherwise, go to Step 13.

Step 10. Click TG characteristics → Station Configuration - TG characteristics
panel.

Step 11. Either keep the default values or change these values according to your
needs.

Step 12. When completed, click OK to save and return to the previous panel.

Step 13. When completed, click OK to save and return to the APPN Over
Frame-Relay – Station Configuration panel.

For information about creating one or more stations identical to one in the
Stations Already Configured list, see “Copy” on page 23.

Step 14. If you need to configure DLC parameters for the station, continue with the
next step.

Otherwise, go to Step 15 

Configuring Station DLC Parameters

Step 15. To configure the DLC parameters for the station, click DLC parameters
→ Frame-Relay/FRTE Station - DLC Parameters panel.

In this panel, you can define, among others, the following parameters:

� Panel increment (DYNWIND - nw)
� Panel decrement (DYNWIND dwc)
� Discard eligibility (the conditions under which data are discarded).

Step 16. Keep the default values or change these values according to your needs.

Step 17. To configure more DLC parameters, click DLC Parameters 2/2 and
continue with the next step.

Otherwise, go to Step 19.

Step 18. In the DLC Parameters 2/2 panel, you can define, among others, the
following parameters:

 � Reply timer
 � Acknowledgement timer
 � Inactivity timer
� Number of retries.

Step 19. When completed, click OK to save, and return to the APPN Over
Frame-Relay – Station Configuration panel.

Note:  If the DLC Parameters 2/2 panel is displayed, you must first return
to the DLC Parameters 2/2 panel, then click OK in that panel to exit.

Step 20. Repeat steps 2 on page 91 through 19 for each station that needs to be
configured on the DLCI.

Step 21. Click OK to return to the Frame-Relay DLCI/COMRATE Parameters or
Frame-Relay DLCI/CIR Parameters panel.

Step 22. To configure other stations on another DLCI, click OK, and repeat Steps
1 on page 91 through 21.
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Step 23. Click OK on each panel until the CCM main panel is displayed.
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Configuring Frame-Relay Frame Handler Sets
You define the set name, NPA (NetView Performance Analyzer) eligibility, and the
primary-substitute partner DLCI pairing. You can also modify or delete sets in the
list of FRFH sets already configured.

To configure these parameters: Main panel Configuration menu →
Frame-relay frame handler set → Frame-Relay Frame Handler Set
Configuration panel (see Figure 39)

Figure 39. Frame-Relay Frame Handler Set Configuration Panel

Only certain DLCI pairing possible in a given set. In general, the primary partner
DLCI can pair with each other or with one of the substitute DLCIs. The substitute
partner DLCI can never pair with each other. There are only four possible set
types. The combinations of pairing are:

1. A with B

2. A with B
A with D

3. A with B
A with D
B with C

4. A with B
B with C

Note:  B is never paired with D.
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Chapter 10. Configuring Serial Line PPP Resources

This chapter concerns the configuration of serial line couplers LIC11s and LIC12s
for PPP leased lines.

Before You Start...
� If this is the first coupler to be configured in a new CCM configuration, see

Chapter 5, “Beginning a CCM Configuration” on page 57.

� If this is the first time the coupler is to be configured, but it is not the very first
one to be configured, double-click the icon of the coupler you want to configure,
select its DLC type (see Figure 15 on page 58), and go to “Configuring a PPP
Port.”

� If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double-click on the icon of the coupler you
want to configure, and go to “Configuring a PPP Port.”

If You Need Help...
Use the CCM online help or the 3745/3746 Planning Series: Serial Line Adapters,
GA27-4235 for more information about the PPP configuration parameters.

Configuring a PPP Port
Note:  A LIC12 has only one port, a LIC11 can have up to 30 ports.

Figure 40. Serial Line Port Configuration Panel

Step 1. In the Port Configuration panel (see Figure 40), select the DLC type as
PPP and enter the other parameters values as required.
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As you enter the values, CCM dynamically checks them for
configuration-wide consistency, see “An Easier Way to Configure” on
page 15.

For information about creating one or more ports identical to one in the
Ports Already Configured list, see “Copy” on page 23.

Step 2. Click Add.

Step 3. If you want to configure remote IP addresses for a DLCI, click IP
addresses... → DLCI Remote IP Addresses panel and continue with the
next step.

Otherwise, go to Step 6.

Step 4. Enter the values according to your needs.

Step 5. When completed, click OK to return to the previous panel.

Step 6. If you want to configure the DLC parameters for a port, continue with the
next step.

Otherwise go to Step 14 on page 97.

Configuring the Port DLC Parameters

Step 7. Select a port and click DLC parameters.

Step 8. Keep the default values or modify these values according to your needs
(see Figure 41).

Figure 41. PPP Port DLC Parameters Panel

Step 9. When completed, click OK to return to the Port Configuration panel and
go to step 14 on page 97.

Otherwise, go to 10 to configure BRS parameters.

Step 10. To configure the bandwidth reservation class of the PPP port, click BRS...
→ Bandwidth Reservation panel.

Step 11. When completed, click OK to return to the PPP Port - DLC Parameters
panel.
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Step 12. Click OK to return to the Port Configuration panel.

Step 13. Repeat Step 7 on page 96 through Step 11 on page 96 for any other
ports that need DLC parameters configured.

Step 14. Save and exit port configuration by clicking OK.
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Chapter 11. Configuring Serial Line X.25 Resources

This chapter describes the configuration of one X.25 port for a LIC11 or LIC12
serial line coupler.

Before You Start...
� If this is the first coupler to be configured in a new CCM configuration, see

Chapter 5, “Beginning a CCM Configuration” on page 57.

� If this is the first time the coupler is to be configured, but it is not the very first
one to be configured, double-click the icon of the coupler you want to configure,
select its DLC type (see Figure 15 on page 58), and go to “Configuring a X.25
Port.”

� If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double-click on the icon of the coupler you
want to configure, and go to “Configuring a X.25 Port.”

If You Need Help...
Use the CCM online help or the 3745/3746 Planning Series: Serial Line Adapters,
GA27-4235 for more information about the X.25 configuration parameters.

Configuring a X.25 Port
Note:  A LIC12 has only one port, a LIC11 can have up to 30 ports.

Figure 42. Serial Line Port Configuration Panel

Step 1. In the Port Configuration panel (see Figure 42), select X.25 as the DLC
type and enter the other parameters values as required. As you enter the
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values, CCM dynamically checks them for configuration-wide consistency,
see “An Easier Way to Configure” on page 15.

Step 2. Click Add.

Note:  After clicking Add, the port you have just configured is added to
the Ports Already Configured list. Depending on the type of port
configured, other push buttons are now available.

For information about creating one or more ports identical to one in the
Ports Already Configured list, see “Copy” on page 23.

Step 3. If you want to configure APPN parameters for the port, continue with the
next step.

Otherwise, go to Step 8 

Configuring Port APPN Parameters

Step 4. Select a port and click APPN parameters to go to the Port Configuration
- APPN Parameters panel (see Figure 23 on page 70).

Step 5. Keep the default values or modify these values according to your needs.

Step 6. Click User defined parameters if you want to define these parameters at
the port level.

Step 7. When completed, click OK to return to the previous panel.

Step 8. If you want to configure DLC parameters for the port, continue with the
next step.

Note:  To configure stations on the X.25 port, you must define at least
two DLC parameters: the X.25 local DTE address and one or more on
logical channel numbers (see Figure 44 on page 101).

Otherwise go to Step 18 on page 101.

Configuring the Port DLC Parameters

Step 9. DLC parameters → X.25 Port - DLC Parameters panel (see Figure 43)

Figure 43. X.25 Port - DLC Parameters Panel

Step 10. Keep the default values or modify the other values according to your
needs.
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Step 11. If you want to configure the LAPB parameters for the port, continue with
the next step.

Otherwise go to Step 15.

Step 12. Click LAPB parameters → X.25 - LAPB Parameters panel

Step 13. Keep the default values or modify the values according to your needs.

Step 14. When completed, click OK to return to the previous panel.

Step 15. PLP parameters → PLP parameters 1/2 panel (see Figure 44)

Figure 44. First X.25 PLP Parameters Panel

Step 16. You must enter values for the X.25 Local DTE Address and for at least
one of the logical channel types: the PVCs values < Incoming SVCs
values < Two-Way SVCs values < Outgoing SVCs values.

Notes:

a. The SVC Highest values must be always ≥ the Lowest values.

Keep the other default values or modify them according to your
needs.

b. There is a second PLP parameter panel available.

Step 17. When completed, click OK to return to the previous panel.

Note:  If the PLP Parameters 2/2 panel is displayed, you must first return
to the PLP Parameters 1/2 panel, then click OK in that panel to exit.

Step 18. If you want to configure IP over X.25 for the port, continue with the next
step.

Otherwise go to step 27 on page 102.

Step 19. Click IP parameters → IP over X.25 - Port Parameters panel (see
Figure 45 on page 102)
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Figure 45. IP over X.25 - Port Parameters Panel

Step 20. Keep the default General values or modify them according to your needs.

Enter the IP addresses that you want to use on this port.

If you want to configure IP access control filtering for this port, continue
with the next step.

Step 21. To define the input packet filter, click Input Packet Filter.... (see
Figure 18 on page 62).

Step 22. When completed, click OK.

Step 23. To define the output packet filter, click Output Packet Filter.... (see
Figure 19 on page 63).

Step 24. When completed, click OK.

Step 25. When the IP configuration is completed, click OK to return to the previous
panel.

Otherwise, go to step 26.

Step 26. When the IP configuration is completed, click OK to return to the previous
panel.

Step 27. At this point, you can either:

� Save and exit the port configuration by clicking OK.

� Configure stations by going to “Configuring X.25 Stations” on
page 103.
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Configuring X.25 Stations
Before configuring stations on the X.25 port, you must define at least two DLC
parameters: the X.25 local DTE address and one or more logical channel numbers
(see Figure 44 on page 101).

Step 1. Click APPN Stations → X.25 Station Configuration panel (see
Figure 46).

Figure 46. X.25 Station Configuration Panel

Step 2. Enter the parameters as required and click Add.

Notes:

a. You must choose the type of virtual circuit (permanent or switched)
for the station. (It must have a logical circuit number [LCN] available,
the number of PVCs and SVCs are defined in Figure 44 on
page 101.)

b. After clicking Add, the station you have just configured, is added to
the X.25 Stations Already Configured list. Depending on the type of
station configured, other pushbuttons are now available.

For information about creating one or more stations identical to one in the
Stations Already Configured list, see “Copy” on page 23.

Step 3. If you need to configure the station DLC parameters, continue with the
next step.

Otherwise, go to Step 7 on page 104.
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Configuring Station DLC Parameters

Step 4. Click DLC parameters → X.25 Station - DLC Parameters panel (see
Figure 47). Otherwise, go to Step 21 on page 105.

Figure 47. X.25 Station Configuration - DLC Parameters Panel

Step 5. Keep the default values or change them according to your needs.

Step 6. When completed, click OK to save, and return to the X.25 Station
Configuration panel.

Step 7. If you need to configure the APPN parameters, continue with the next
step.

Otherwise, go to Step 17 on page 105.

Step 8. APPN parameters → X.25 Station Configuration – APPN Parameters
panel (see Figure 27 on page 74)

Step 9. Either keep the default values or change these values according to your
needs. To configure remote LUs on adjacent nodes, continue with the
next step.

Otherwise, go to step 12.

Step 10. Click LUs....

Step 11. When completed, click OK.

Step 12. To configure the transmission group for the MLTG (including the user
defined parameters used to change route priority), continue with the next
step.

Otherwise, go to Step 16 on page 105.

Step 13. Click TG characteristics → Station Configuration - TG characteristics
panel.

Step 14. Either keep the default values or change these values according to your
needs.
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Step 15. When completed, click OK to save and return to the previous panel.

Step 16. When the APPN configuration is completed, click OK to save and return
to the X.25 Station Configuration panel.

Step 17. If you want to configure IP over X.25 for the station, continue with the
next step.

Otherwise go to Step 27 on page 102.

Configuring IP Over X.25

Step 18. Click IP parameters → IP over X.25 - Station Parameters panel (see
Figure 48)

Figure 48. IP over X.25 - Station Parameters Panel. (This panel is for a PVC, the SVC
panel is slightly different.)

Step 19. Keep the default General values or modify them according to your needs.

Enter the IP addresses that you want to use on this station.

Step 20. When completed, click OK to return to the previous panel.

Step 21. Click OK to return to the Station Configuration panel.

Step 22. To configure IP over X.25 for another station, select the station and return
to 18.

Step 23. If other X.25 ports need to be defined for this coupler, return to
“Configuring a X.25 Port” on page 99.

Otherwise, click OK until the CCM main panel is displayed.
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Chapter 12. Configuring the MAE

This chapter describes how to use the MAE configuration program3 by including
some of the navigation features of the program.

Before You Start...
� If this is the first coupler to be configured in a new CCM configuration, see

Chapter 5, “Beginning a CCM Configuration” on page 57 

� If this is the first time the coupler is to be configured, but it is not the very first
one to be configured, double-click the icon of the coupler you want to configure,
select its DLC type (see Figure 15 on page 58), and go to “Understanding the
Navigation and Configuration Panels.”

� If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double-click on the icon of the coupler you
want to configure, and go to “Understanding the Navigation and Configuration
Panels.”

Note:  Only one MAE can be connected to a coupler per CCM configuration. The
MAE can be connected to left-hand slot of any pair of unused coupler slots. The
remaining, unused right-hand coupler slot is not available for configuration.

Understanding the Navigation and Configuration Panels
After CCM starts the MAE configuration program and clears the copyright notice, it
opens two panels:

� The full screen Configuration panel labeled “Nothing Selected!”. This is the
panel where you actually configure each MAE resource. You use it most of the
time while configuring, so it is made as large as possible.

� The smaller Navigation panel (see Figure 49 on page 108). Use this panel to
move through the MAE configuration program to find resources that you want
to view or configure. When the MAE Configurator starts, this panel is hidden
by the Configuration panel. There are two ways to bring the Navigator Panel to
the front when you need it:

– Click and hold down the left mouse key on the Configuration Panel. title bar
then slide down the Configuration Panel until you can see the title bar of
the Navigator Panel.

– Press Ctrl + Esc to open the OS/2 task list and click Navigator Panel.

– If you are using the stand-alone CCM, you can see both panels at the
same time if you increase your screen resolution above VGA-level.

You configure the MAE by selecting items in the Navigation panel and then
providing details for each selected item in the Configuration panel. When you have
completed entering the configuration details, select a new item in the Navigation
Panel.

3 This program is also known as the IBM Nways Multiprotocol Access Services Configuration Program or the IBM 2210-400
Configuration Program.
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Using the MAE through the MOSS-E
MAE configuration panels are often larger than the service processor display panel
and the scroll bars are sometimes hidden. It is therefore highly recommended to
change the screen resolution.

In order to enable a high-VGA screen resolution, select from the MOSS-E:

Service Processor Menu → Configuration Management → Service Processor
(SP) Customization → Screen Resolution. Then select the 600x800 option from
the list.

The Navigation Panel

Figure 49. Navigation Panel

The Navigation panel (see Figure 49) contains the following items:

 � Menu bar

The Navigation panel menu bar contains the following menus:

 – Configure

Use the Configure menu option to exit the MAE configurator and return to
the 3746 resources.

 – Options

You can change the following configuration program options:

 - Colors
 - Message prompting

- ATM address format.

 – Help

Note:  The following topics in the online help and tutorial do not apply to
the version of the MAE Configurator Program that is used with the CCM:

- Using the MAE Configurator from the command line
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 - AIX support
- Configuration menu functions
- Options menu change fonts.

� Configuration description area

The area below the menu bar is the configuration description area. It displays
the following information:

– Scrollable list of features and protocols that you can configure.

This list is called the navigation list. As you select items in the navigation
list, the program displays related configuration panels in the Configuration
panel.

– If there are no configuration errors for a type of resource, a check mark (√)
appears next to that item in the navigation list.

– If there is an error or if you have not supplied required information in the
current configuration, a question mark (?) appears next to that item in the
navigation list.

Contextual Pop-Up Menu
Another feature of the Navigation Panel is a contextual pop-up menu that you
invoke by clicking the right mouse button on any selected folder in the navigation
list.

While holding down the right mouse button, drag the mouse to the submenu item
that you want to select. You can invoke the history pop-up from any item in the
navigation list in the same way you invoke the contextual pop-up menu.

The pop-up menu allows you to:

� Fully expand the navigation list.

� Expand a portion of a navigation folder.

� Contract a portion of the navigation list into a folder.

� Display the history of the configuration items that you have selected. From the
history pop-up you can access any of the previously selected configuration
items.

� Validate a selection item in error. The Navigation panel marks erroneous items
with a yellow question mark.

The validate function displays messages for any configuration errors. Using the
validate function on a folder displays the validation messages for all of the
items within that folder.

After you correct an error and leave the configuration panel that contained the
error, the question mark is removed.

Return to the CCM
Use the Configure menu option to exit the MAE configurator and return to the
3746 resources. If you have made changes in the MAE configuration, you are
asked if you want to save the changes before exiting. If so, click Yes.
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The Configuration Panel
The title bar of the Configuration panel (see Figure 50) identifies the item that is
selected in the navigation list.

As you select items in the Navigation panel, the format of the Configuration panel
changes to the appropriate display for the item selected.

Figure 50. Example Configuration Panel
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MAE IP Access Control Packet Filtering

Figure 51. Access Control Packet Filtering Panel

In Figure 51, five of the columns are used in special ways to configure the interface
selected in the list:

Configure (3rd column)
Click the column heading to access the fields that let you to choose
input, output, or both types of packet filtering.

Input filter (4th column)
Click the word enable or disable to toggle ON or OFF input filtering for
this interface.

Filter (5th column)
Click the column heading to access several pages of fields used to
configure the input packet filters for this interface.

Output filter (6th column)
Click the word enable or disable to toggle ON or OFF output filtering for
this interface.

Filter (7th column)
Click the column heading to access several pages of fields used to
configure the output packet filters for this interface.

 APPN Interfaces

Figure 52. APPN Interfaces Panel

In Figure 52, two of the columns are used in special In this configuration panel,
four of the columns are used in special ways to configure the interface selected in
the list:

Configure (4rd column)
Click the column heading to access several pages of fields used to
configure this interface.
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Link stations (5th column)
Click the column heading to access several pages of fields used to
configure link stations for this interface.

Navigating Through the MAE Configuration Program
The MAE configuration program is designed with a point-and-click interface. In
addition to using a mouse pointer in the Configuration and Navigation panels,
various keys also have specific meanings.

Using the Mouse
The mouse pointer is the main tool you use to move through the various lists and
panels in the MAE configuration program.

The MAE configuration program uses the:

� Left button to select an item in a panel

� Right button to perform the following actions:

– In the Navigation panel:

- Displays a pop-up menu for a selected item in the list
- Moves through and selects items in a pop-up menu
- Validates a selected item that was in error and has been corrected.

– In the Configuration panel: drag-and-drop list items.

The configurator indicates that a drag-and-drop item is active by changing
the mouse cursor into a file icon. You can use drag-and-drop to reorder
many configuration lists.
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Using the Keyboard in the Configuration Program
Various keys have specific functions in the MAE configuration program, see
Table 4.

Table 4 (Page 1 of 2). Configuration Program Keyboard Functions

Key Function How to Use Key

F1 (Help) Request help

Note:  After you
press F1, the MAE
configuration
program displays a
frame that you use
to position the
panel. Position the
frame wherever
you want on your
desktop and press
the left mouse
button to display
the help text.

� To obtain help for configuring a feature or protocol:

When the MAE configuration program displays a feature or
protocol configuration in the Configuration panel, press F1.

� To obtain help on a panel:

Step 1. Select an item in the Navigation panel.

Step 2. Press F1.

� To obtain help on a parameter, a button, or a drop-down list:

Step 1. Select the parameter field or button by tabbing to the
parameter field, button, or list.

When you tab to the field or button, a yellow box will
highlight the item.

Note:  You must use the tab key for help: clicking
on a button causes the MAE configuration program
to perform the configuration task indicated by that
button or drop-down list.

Step 2. Press F1.

In the help text, additional information about certain words are
hypertext-linked to the help panel by clicking on the blue text.

If you press F1 on a different panel or parameter without closing a
previously opened help panel, the new help text overlays the
currently displayed text.

In a help panel, use:

� UP to view the previous topic

� DOWN to view the next topic

� CLOSE to close the help panel.

Up and Down
Arrow Keys

Move vertically Use these keys to move through lists on any panel, including the
Navigation panel and the drop-down menus. To select an item,
press the Enter key.

Left and Right
Arrow Keys

Move horizontally Use these keys to move through the menu items on the
Navigation panel, after you have selected one of the menu items.
They can also be used to move through a parameter field without
affecting the existing values.

Tab and
Shift(Back)-tab

Next or previous
entry field

These keys work only in the Configuration panels to move through
the various entry items in a panel.

  Chapter 12. Configuring the MAE 113



  
 

Table 4 (Page 2 of 2). Configuration Program Keyboard Functions

Key Function How to Use Key

Character Keys Speed-scroll Use character keys in the Navigation panel to jump through the
list. When you type a character, the selection marker moves to
the next item in the list that starts with the characters that you
have typed. This feature can help you change specific protocols
in a configuration without using the scroll bar to locate the
protocol. The following limitations exist:

� Speed-scroll works only in the Navigation panel.

� Once you speed-scroll to an item, you must select that item
before speed-scrolling again.

Alt + C Configure
pull-down

Opens the Configure menu.

Alt + P Options pull-down
menu

Opens the Options menu.

Alt + H Help pull-down
menu

Opens the Help menu.

Esc Escape Clears the pull-down menus.

Selecting Multiple Items in a List
Whenever the configuration program presents you with a selection list, you can pick
multiple items from those lists. The method for selecting items depends on whether
you want to start at one point and end at another point or just select items at
random from the list:

To select items randomly:
Press and hold Ctrl, point to each item and then press the left mouse
button.

To select a range of items:
Select the first item in the range. Press and hold Shift. Select the last
item in the range and then press the left mouse button.

To deselect items
Press and hold Ctrl, point to the item you want to deselect and press
the left mouse button. If you do not hold Ctrl, you will deselect all
previously selected items except the item just selected.
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Chapter 13. Configuring IP Parameters

This chapter explains how to go to the panels where you configure the general and
default parameters of the IP parameters for Bootp, OSPF, RIP, BGP, ARP, and
SNMP.

Configuring General IP Parameters

Figure 53. IP Configuration Menu

General IP Parameters
You define parameters for direct broadcasting, packet multipathing, source routing,
and the routing table, cache and buffer sizes.

To configure these parameters: Main panel Configuration menu → IP → General
→ IP General Parameters panel.

PPP NCP Default Parameters
You define retry and timeout parameters for configuration, NAK (negative
acknowledge character), and terminate.

To configure these parameters: Main panel Configuration menu → IP → PPP
NCP defaults → PPP NCP Default Parameters panel.
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IP Static Routes
You define parameters for destination network, destination mask, and next hop
address and cost. You can also modify or delete the records in the list of static
routes already configured.

To configure these parameters: Main panel Configuration menu → IP → General
→ IP Static Routes panel.

IP Access Controls
You define access control filter parameters at the node-level for access control
type, source and destination address, protocol number and port. You can also
modify or delete the records in the list of access control entries already configured.

This filtering can also be done for several DLCs at the port-level by clicking IP
access control - Packet filtering in the Port Configuration panel.

To configure these parameters: Main panel Configuration menu → IP →
Access controls → IP Access Controls panel.

There is an example of the use of IP access controls on “Make Sure SNMP Access
Is Enabled When Filtering Packets” on page 122.

 IP Filters
You define routing filter parameters for IP address and subnetwork mask. You can
also modify or delete the records in the list of IP filters already configured.

Note:  IP filters allow the control of host access to each other across a firewall.

To configure these parameters: Main panel Configuration menu → IP → Filters
→ IP Filters panel.

IP Route Filters
When the route table filtering option is enabled and route filters defined, the system
checks the routes to be added to the IP routing table. Route table filtering can be
used in order to prevent the system from adding routes to the IP route table when
the network operator does not want all the routes advertised by routing protocols to
be available for use.

To enable route table filtering and/or define route table filters, Main panel
Configuration menu → IP → Filters → IP Route Filters → IP Route Table
Filters panel.

Bootp Forwarding Parameters
You enable Bootp and define parameters for maximum hops, waiting time before
forwarding and forwarding address. You can also modify or delete the records in
the list of Bootp forwarding server addresses already configured.

To configure these parameters: Main panel Configuration menu → IP →
Bootp forwarding → Bootp Forwarding panel.
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Configuring OSPF Parameters

Figure 54. OSPF Configuration Menu

OSPF General and Multicast Parameters
You can enable or disable the Open Shortest Path First (OSPF) and multicast
functions and define parameters such as number of routes/routers, and the group
addresses. You can also modify or delete the records in the list of group
addresses already configured.

To configure these parameters: Main panel Configuration menu → OSPF →
General/Multicast → OSPF - General/Multicast Parameters panel.

OSPF Parameters for Each IP Address
You can select an IP address in the list and specify whether you want to configure
OSPF or RIP.

To configure these parameters:

Step 1. Main panel Configuration menu → OSPF →
Parameters per IP address.

Step 2. In the OSPF/RIP - Parameters Per IP Address panel, specify the required
values.

Step 3. If available, you can press OSPF parameters.

Step 4. In the OSPF - Parameters for IP panel, specify the required values and
press OK.

Step 5. If available, you can press RIP parameters.

Step 6. In the RIP - Parameters for IP panel, specify the required values and
press OK.

Step 7. If available, you can press OSPF neighbors (N).
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Step 8. In the OSPF - Neighbors panel, specify the required values and press
OK.

 OSPF Areas
You can enable/disable the stub area and authentication functions and define stub
area default cost. You can also modify or delete records in the list of OSPF areas
already configured.

To configure these parameters:

Step 1. Main panel Configuration menu → OSPF → Areas → OSPF - Area
Configuration panel.

Step 2. Specify the required values.

Step 3. To configure the area ranges, press Ranges.

Step 4. In the Area Ranges panel, specify the required values.

OSPF Imported and Default Routes
You can enable/disable various "import" functions including static routes, RIP
routes, BGP routes, direct routes and subnetwork routes. You can also define
parameters such as network IP address and default route cost.

To configure these parameters: Main panel Configuration menu → OSPF →
Imported/default routes → OSPF - Imported/Default Routes panel.

OSPF Virtual Links
You define the neighbor IP addresses and interval timers including
retransmit/transmit, and dead router interval. You can also modify or delete records
in the list of OSPF virtual links already configured.

To configure these parameters: Main panel Configuration menu → OSPF →
Virtual links → OSPF - Virtual Links panel.
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Configuring RIP Parameters

Figure 55. RIP Configuration Menu

RIP General Parameters
You can enable/disable RIP and define the "originate default route" parameters.
You can also modify or delete records in the list of route acceptance network
addresses.

To configure these parameters: Main panel Configuration menu → RIP →
General → RIP - General Parameters panel.

RIP Parameters for Each IP Address
You can select an IP address in the list and specify whether you want to configure
OSPF or RIP.

To configure these parameters:

Step 1. Main panel Configuration menu → RIP → Parameters per IP address.

Step 2. In the OSPF/RIP - Parameters Per IP Address panel, specify the required
parameters.

Step 3. To configure addition RIP parameters, press RIP parameters.
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Configuring BGP Parameters

Figure 56. BGP Configuration Menu

BGP General and Excluded AS Parameters
You can enable/disable the BGP (border gateway protocol) function and define
parameters for AS (autonomous system) number, and TCP segment size. You can
also select the AS to be excluded, and modify or delete records in the list of
excluded AS.

To configure these parameters: Main panel Configuration menu → BGP →
General/excluded AS → BGP - General Parameters/Excluded AS panel.

BGP Receive Policies
You define policy type, matching addresses, IP address/mask, and AS numbers
(origin and adjacent). You can also modify or delete records in the list of BGP
receive policies already configured.

To configure these parameters: Main panel Configuration menu → BGP →
Receive policies → BGP - Receive Policies panel.

BGP Send Polices
You define policy type, matching addresses, IP address/mask, and AS numbers
(origin and adjacent). You can also modify or delete records in the list of BGP
send policies already configured.

To configure these parameters: Main panel Configuration menu → BGP →
Send policies → BGP - Send Policies panel.
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BGP Originate Policies
You define policy type, matching addresses, IP address/mask, and AS numbers
(origin and adjacent). You can also modify or delete records in the list of BGP
originate policies already configured.

To configure these parameters: Main panel Configuration menu → BGP →
Originate policies → BGP - Originate Policies panels

 BGP Neighbors
You define parameters for IP address, AS number, TCP segment, and hold and
connect timers. You can also modify or delete records in the list of BGP neighbors
already configured.

To configure these parameters: Main panel Configuration menu → BGP →
Neighbors → BGP - Neighbors panel.

BGP Aggregate Routes
You define the IP address and subnetwork mask for an aggregate route. You can
also modify or delete records in the list of aggregate route already defined.

To configure these parameters: Main panel Configuration menu → BGP →
Aggregate routes → BGP - Aggregate Routes panel.

Configuring ARP Parameters

 ARP Parameters
You enable/disable ARP net routing, ARP subnetwork routing, and ARP auto
refresh, and you configure ARP entry parameters (port, remote IP address, and
remote MAC address). You can also modify or delete records in the list of ARP
entries already configured.

To configure these parameters: Main panel Configuration menu → ARP → ARP
panel.

Configuring SNMP Parameters

 SNMP Parameters
You define the access type, community name and user datagram protocol (UDP)
parameters for Simple Network Management Protocol (SNMP). You can also
modify or delete records in the list of SNMP transport information sets already
configured.

To configure these parameters: Main panel Configuration menu → SNMP →
SNMP Configuration panel.
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Make Sure SNMP Access Is Enabled When Filtering Packets
To deny outside access to your service LAN when using SNMP, make sure the IP
Access Controls are configured correctly (see Figure 57). The following example
shows how to do this:

Figure 57. IP Access Controls Panel

Step 1. Leave the default I (permit/inclusive) access control in the list of access
controlled already configured:

I 0.0.0.0 0.0.0.0 0.0.0.0 0.0.0.0

Step 2. Deny access to all outside hosts by adding an E (deny/exclusive) access
control with the source addresses as 0.0.0.0 0.0.0.0 and the destination
address of your 3746 IP router (for example: 5.5.5.0 255.255.255.0):

E 0.0.0.0 0.0.0.0 5.5.5.0 255.255.255.0

Step 3. Enable access for the SNMP connection between the 3746 and the NNP
with an I with the source and destinations addresses both equal to the
address of your 3746 IP router, in this example:

I 5.5.5.0 255.255.255.0 5.5.5.0 255.255.255.0

Step 4. Enable access for any other IP hosts you to want to have access to your
service LAN.
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Chapter 14. Configuring APPN Parameters

This chapter describes how to configure general and specific APPN parameters
from the main panel Configuration menu (see Figure 58) for ports and stations,
and other values such as:

� Network node characteristics
� Management focal points
� Dependent LU servers (DLUSs)

 � Coupler 2080
� Type of 3745/3746
� Adjacent node remote LUs
� Different kings of class of service (COSs) and modes
� Transmission groups (TGs) and MLTGs

For additional information about the parameter values and controls in these panels,
press Help in the panel.

Configuring General APPN Parameters

Figure 58. Configuration Menu

 Coupler
You go to the port configuration panel for the selected coupler.

An easier way to go to this panel is to simply double-click the coupler icon.
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Network Nodes, Focal Points, and DLURs
You define values for network identifier and control point name for:

� This Network Node
� Primary network management focal point
� Backup network management focal points

 � Primary DLUS
 � Backup DLUSs

Also defined is the type of High-Performance Routing (HPR) for this Network Node,
retry timers, and other values.

To configure these parameters: Main panel Configuration menu → NN/FP/DLUR
→ Network Node/Focal Point/Dependent LU Requester Parameters panel.

Network Node Characteristics
You define values for cache entries, route addition resistance (RAR), and frequency
of topology routing services (TRS) tree use.

To configure these parameters:

Step 1. Main panel Configuration menu → NN/FP/DLUR.

Step 2. In the Network Node/Focal Point/Dependent LU Requester Parameters
panel, specify the required values.

Step 3. Press NN characteristics → Network Node Characteristics panel.

Backup Focal Points
You define the network identifier and control point name for a backup focal point.

To configure these parameters:

Step 1. Main panel Configuration menu → NN/FP/DLUR.

Step 2. In the Network Node/Focal Point/Dependent LU Requester Parameters
panel, specify the required values.

Step 3. Press Backup focal point → Backup Focal Point Parameters panel.

Rapid Transport Protocol/Path Switch Parameters
You define values for sessions and RTP retries and timers.

To configure these parameters:

Step 1. Main panel Configuration menu → NN/FP/DLUR.

Step 2. In the Network Node/Focal Point/Dependent LU Requester Parameters
panel, specify the required values.

Step 3. Press RTP parameters → Rapid Transport Protocol (RTP)/Path
Switch Parameters panel.
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Coupler/Port 2080 Stations
You specify the type (service processor or NetView Performance Monitor) of
stations to be automatically generated.

To configure these parameters: Main panel Configuration menu →
Stations on coupler/port 2080 → Stations on Coupler/Port 2080... panel.

 3745/3746
You define the type of 3746 for this CCM configuration.

If necessary, you give the identifier of the 3745 attached to the 3746-900 and the
3745 mode of operation.

To configure these parameters: Main panel Configuration menu → 3745/3746 →
3745/3746 Parameters panel.

Frame-Relay Frame Handler Set
For information about configuring frame-relay frame handler sets, refer to
“Configuring Frame-Relay Frame Handler Sets” on page 94.

Configuring Specific APPN Parameters
The procedures in this section start with: Main panel Configuration menu → APPN
as shown in Figure 59.

Figure 59. APPN Configuration Menu
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Adjacent Node Remote LUs
You specify the remote LU and adjacent LEN node. You can also modify or delete
LUs in the list of remote LUs already configured.

To configure these LU/LENs:

Main panel Configuration menu → APPN → Adjacent Node Remote LUs →
Adjacent Node - Remote LUs panel

Session Mode Classes of Service
You specify the mode name and its class of service (COS). You can also modify
or delete mode COSs in the list of modes already configured.

To configure the modes:

Main panel Configuration menu → APPN → Mode/COS... → Mode
Configuration panel.

Classes of Service
You specify mode and COS names and transmission priorities. You can also
modify or delete items in the lists of modes and different kinds of COS already
configured.

To configure the modes and COS:

Step 1. Main panel Configuration menu → APPN → Mode/COS

Step 2. In the Mode Configuration panel, specify the required values.

Step 3. Press Configure COS → Class of Service Configuration panel.

 Node Rows
You specify values for weight, RAR (route addition resistance), and congestion.
You can also modify or delete from the list of node rows already configured.

To configure the node rows:

Step 1. Main panel Configuration menu → APPN → Mode/COS

Step 2. In the Mode Configuration panel, specify the required values and press
Configure COS.

Step 3. In the Class of Service Configuration panel, specify the required values
and press Node rows → Node Row Configuration panel.
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Transmission Group Rows
You specify values for weight, propagation, security, effective capacity (EC), relative
cost per byte (RCPB), and relative cost per unit of time (RCPUT). You can also
modify or delete TG rows in the list of TG rows already configured.

To configure the TG rows:

Step 1. Main panel Configuration menu → APPN → Mode/COS....

Step 2. In the Mode Configuration panel, specify the required values and press
Configure COS.

Step 3. In the Class of Service Configuration panel, specify the required values
and press TG Node rows → Transmission Group Row Configuration
panel.

Multilink Transmission Group
You define the MLTG name and transmission group number. You can also modify
or delete the MLTGs in the list of MLTGs already configured.

To configure the MLTGs:

Main panel Configuration menu → APPN → MLTG → Multilink Transmission
Group Configuration panel.

Specifying Multilink Transmission Group Stations
You specify which stations are to be added to or removed from a MLTG.

To add or remove stations:

Step 1. Main panel Configuration menu → APPN → MLTG.

Step 2. In the Multilink Transmission Group Configuration panel, specify the
required values and press Stations → Stations Selection panel.
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 Part 3. Resource Management
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Chapter 15. Dynamic Activation and How It Affects Your
Network

This chapter describes:

� How to dynamically activate resources in a modified active configuration

� Possible unexpected results when using dynamic activation

Notes:

1. Information about actual configuration parameter values is not covered (refer to
the CCM online help for parameter descriptions, valid values, and rules for
use).

2. When running the stand-alone CCM, because there is no 3746 connected,
there is nothing to manage and the procedures explained in this chapter are
not available.

Dynamically Activating Modifications to a Configuration While Saving
When you start to save the active configuration, after modifying it, you are asked if
you want to immediately update the active resources affected by the modifications.
Then, you are asked whether you want to immediately activate these resources.
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 Attention 

 

� When changes are dynamically activated, most network traffic is
not affected by APPN, IP, and SNA/subarea modifications.

However, dynamic activation of certain resources can have a
major effect on network operation, because a re-IML or VTAM
deactivation of resources might have to be performed. You
should be aware of the information in “Network Traffic Disruption
and Dynamic Activation” on page 133 before using dynamic
activation.

� Modifications made to the network node (NN/FP/DLUR
parameters) cannot be dynamically activated. The CP must be
stopped and restarted to take these changes into account, which
is disruptive for all APPN and IP traffic.

Exception! Modifications made to the LU parameters are
dynamically activated.

� Choosing dynamic activation after making modifications only to
the MAE configuration results in restarting only the MAE, when

| no MAE IP resource is affected by the modifications. Otherwise,
| when shared IP parameters are modified, all IP traffic (3746 and
| MAE) is disrupted. Modifying only IP resources of the 3746
| results in only the IP router restarting.

� Modification of a non-active configuration does not affect the
network traffic. The changes you make to the non-active
configuration are only applied when it is activated.

| � When you modify the maximum number of incoming calls
| parameter of the token-ring port, the port and the stations
| concerned will not have traffic disrupted.
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Network Traffic Disruption and Dynamic Activation
The tables in this section show the effect on network traffic of viewing, adding, modifying, or deleting
network resources.

 Attention 

When you save the active configuration–if you dynamically activate the modifications you
have just made in your configuration–you can disrupt network traffic.

Restarting the IP CP (router) restarts the whole MAE (IP and APPN traffic).

Viewing a Resource

 Attention 

When you finish viewing a 3746 resource of the active configuration, click Cancel. Do not
use OK.

If you use OK in certain panels, the resources related the parameters in the panel are
marked as needing to be re-IMLed, even though you did not change a single thing in the
panel. Then when you dynamically activate changes that you do want to make, There may
be unexpected traffic disruptions because resources that you did not change are re-IMLed.

All 3746 APPN and IP resources related to the following parameters can be disrupted by
using OK even if they are only viewed:

� APPN parameters in port and station configuration panels
 � DLC parameters
� Parameters in the following panels:

– Frame-Relay - Default DLCI
– Frame-Relay CIR - BRS

To summarize:  

� In the 3746 (non-MAE) configuration, use only the Cancel button to close panels when
you navigate inside CCM to view your configuration.

� In the MAE configuration, this problem does not exist.
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Adding a Resource When a new resource is created, normally it is not disruptive for any of
preexisting resources. In Table 5 are the two groups of parameters that are exceptions to this rule.

Table 5. Network Traffic Disruption - Adding a Resource

Networks DLC Added Resources Result

APPN,
SNA/subarea

All DLCs Frame Relay DLCI/CIR parameters

 

MAE IP parameters

MAE other parameters

� Disruptive for the associated IP
port, if it exists

If there is no associated IP
port, this is disruptive for
APPN ports and their
resources

� Disruptive for all IP resources,
the IP router is restarted.
Disruptive for all MAE
resources.

� Disruptive for all MAE
resources, the MAE is
restarted.

IP All DLCs All resources � Disruptive for all IP resources,
the IP router is restarted

Modifying a Resource

Table 6 (Page 1 of 3). Network Traffic Disruption - Modifying a Resource

Networks DLC Modified Resources/Parameters Result

All networks All DLCs Network parameter (sharing) on a
port/host link/DLCI

MAE IP parameters

MAE other parameters

� Disruptive for all APPN
concerned resources and their
resources if modified from an
APPN network to a non-APPN
network

� Non-disruptive if modified from
an IP network to a shared
network

� If modified from a non-IP
network to an IP network, it is
disruptive for all IP resources,
the IP router is restarted

� Disruptive for all IP resources,
the IP router is restarted.
Disruptive for all MAE
resources.

� Disruptive for all MAE
resources, the MAE is
restarted.
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Table 6 (Page 2 of 3). Network Traffic Disruption - Modifying a Resource

Networks DLC Modified Resources/Parameters Result

APPN/IP All DLCs
except ESCON

APPN parameters in port and
station configuration panels

| IP-specific parameters for
| parameters of dialog boxes:
| � IP General Parameters
| � IP Access Control
|  � Bootp Forwarding

| IP parameters different from
| previous ones

except for:
Frame Relay DLCI/CIR parameters

� Disruptive for all APPN
concerned resources and their
resources

| � Disruptive for all IP resources,
| the IP router is restarted.
| Disruptive for all MAE
| resources.
|  
|  
| � Disruptive for IP router

� Disruptive for the associated IP
port, if it exists.

If there is no associated IP
port, disruptive for APPN ports
and their resources

APPN ESCON ESCON port,

except for:

Fiber status parameter

 ESCD parameters

� Disruptive for concerned APPN
ESCON port and its resources

� Disruptive for all resources of
the concerned ESCON
processor if modified from
‘Enable’ to another status

 � Non-disruptive

IP ESCON ESCON port,

except for:

Fiber status parameter

 Automatic reactivation
parameter

 ESCD parameters

� Disruptive for all IP resources,
the IP router is restarted

� Disruptive for all resources of
the concerned ESCON
processor, if modified from
‘Enable’ to another status

� Disruptive for concerned IP
ESCON port and its resources

 � Non-disruptive

APPN and IP ESCON Host link name parameter

 HLA and
Partition number parameters

Other ESCON host link
parameters

� Disruptive for concerned
APPN/IP ESCON host link and
its resources

� Disruptive for all resources of
the concerned ESCON
processor (re-IML)

 � Non-disruptive

APPN ESCON ESCON station � Disruptive for concerned APPN
ESCON stations

IP ESCON ESCON station parameters,

except for:
IP address/subnet mask
parameters

� Disruptive for concerned IP
ESCON station

� Disruptive for all IP resources,
the IP router is restarted
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Table 6 (Page 3 of 3). Network Traffic Disruption - Modifying a Resource

Networks DLC Modified Resources/Parameters Result

SNA/subarea ESCON ESCON port,

except for:
Fiber status parameter

 � Non-disruptive

� Disruptive for all resources of
the concerned ESCON
processor if modified from
‘Enable’ to another status

SNA/subarea ESCON ESCON host link,

except for:
HLA and/or Partition number
parameters

 � Non-disruptive

� Disruptive for all resources of
the concerned ESCON
processor (re-IML)

SNA/subarea ESCON ESCON station,

except for:
PU type, Unit address and IPL
through that station parameters

 � Non-disruptive

� Disruptive for the concerned
SNA/subarea station (manual
VTAM deactivation needed)

| APPN| Token-ring| Token-ring port
| Maximum number of incoming calls
| parameter

| � Not disruptive for port and
| associated stations
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Deleting a Resource

Table 7. Network Traffic Disruption - Deleting a Resource

Networks DLC Deleted Resources Result

APPN All DLCs
except ESCON

All resources,

except for:
Frame-relay DLCI/CIR parameters

 

MAE IP parameters

MAE other parameters

� Disruptive for all concerned
resources and their resources.

� Disruptive for the associated IP
port, if it exists.

If there is no associated IP
port, this is disruptive for
APPN ports and their
resources

� Disruptive for all IP resources,
the IP router is restarted.
Disruptive for all MAE
resources.

� Disruptive for all MAE
resources, the MAE is
restarted.

APPN and
SNA/subarea

ESCON ESCON port or host link � Disruptive for all resources of
the concerned ESCON
processor (re-IML)

APPN and
SNA/subarea

ESCON ESCON station � Disruptive for concerned
ESCON stations

IP All DLCs,
except ESCON

All resources � Disruptive for all IP resources,
the IP router is restarted

IP ESCON ESCON port or host link � Disruptive for all IP resources,
the IP router is restarted and is
disruptive for all resources of
the concerned ESCON
processor (re-IML)

IP ESCON ESCON station � Disruptive for all IP resources,
the IP router is restarted and is
disruptive for all resources of
the concerned ESCON
processor (re-IML)
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 Chapter 16. Resource Management

This chapter describes how to view and manage (see the menu in Figure 60)
non-MAE:

� Filters for resource management
� Ports (manage and view information about)
� Stations (manage and view information about)
� Sessions (view information about)
� Processor- or port-level IP resources

No MAE resources can be managed with the functions described in this chapter.

Figure 60. Operations Menu in Ports Management Panel

Notes:

1. Information about actual configuration parameter values is not covered (refer to
the CCM online help for parameter descriptions, valid values, and rules for
use).

2. When running the stand-alone CCM, since there is no 3746 connected, there is
nothing to manage and the procedures explained in this chapter are not
available.
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Management Using Resource Filters
This section explains the first two item in the Management menu of the main CCM
panel (see Figure 60 on page 139):

Manage all node resources
Selecting this choice displays, in the appropriate resource management
panel (for ports, stations, or sessions), all the resources of the chosen
type defined on all the couplers installed in the network node.

Manage resources with filter
Selecting this choice lets you limit the number of resources displayed by
filtering the resources according to port number (address), port name,
station name, and partner LU name.

For example, if you want to look at session information, the Session
Management Filters panel is opened (see Figure 61).

Figure 61. Session Management Filters Panel

In this panel, you can limit the sessions to those contained in one or a
limited range of:

� Stations, using the station name

� Session partner LU names.
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 Managing Ports
The management tasks that can be performed include:

� Displaying a list of configured ports
� Displaying the resources on a selected port
� Viewing details of a port
� Activating or deactivating ports

Displaying a List of Configured Ports
You can display the list of the ports configured for the controller. From this list the
ports management tasks can be performed.

To display the port list (see Figure 62): Main panel Management menu → Ports.

Figure 62. Ports Management Panel

Displaying the Resources on a Selected Port
From the list of ports, you can display the list of the stations available for a specific
port.

To display the stations on a port:

Step 1. Main panel Management menu → Ports.

Step 2. Double-click the desired port.

Note:  All the station management functions are available from the panel showing
the stations list associated to a specific port.
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Viewing Details of a Port
You can display the configuration details for a selected port. The details include
the parameter values specified during configuration and the values automatically
generated by the CCM during network operation.

To view the details of a port:

Step 1. Main panel Management menu → Ports.
Step 2. Select the port you want.
Step 3. Operations menu → Details (see Figure 64 on page 143).

Displaying the Connectivity Counters
To display the connectivity counters, select from the main panel, the Management
→ Connectivity counters option (see Figure 63).

| Figure 63. Connectivity Counters Panel

| The following list describes the counters:

| Number of active PUs Total number of PUs that the NNP has
| activated

| Number of active ISR sessions All the LU-LU independent and
| dependent sessions that the NNP has
| activated. The sessions that other NNs
| have activated also are included.

| Number of active LU-LU sessions Total number of active LU-LU sessions

| Number of active SSCP-LU sessions Total number of active SSCP-LU
| sessions

| Number of pending SSCP-LU sessions Total number of pending SSCP-LU
| sessions

| Number of down SSCP-LU sessuibs Total number of down SSCP-LU
| sessuibs

| Number of SSCP-LU sessions Total number of SSCP-LU sessions
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Activating and Deactivating Ports
You can activate or deactivate ports as required (see Figure 64).

Figure 64. Operations Menu for APPN Ports Management

Port activation is a process that loads code and runs tests in order to make the port
available for use. When the port is deactivated, it is no longer available for
providing network services.

Ports can be deactivated normally, or by forcing the deactivation.

A normally deactivated port is deactivated if traffic has stopped flowing through it
and its associated resources. Sessions are first deactivated, then the stations and
finally the ports.

A force-deactivated port is deactivated while traffic is flowing through it and its
associated resources, regardless of the status of its associated resources. This is
done if, for example, a port has not been deactivated within a reasonable time after
attempting a normal deactivation, or if a port must be immediately deactivated for a
specific reason.

When you activate or deactivate a resource, you receive a message after the
command completion. This message indicates whether or not the command has
been successfully performed and completed. In case of an error, you get a return
code. Use SMPR for problem determination.
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 Attention 

To activate/deactivate an IP resource, see “IP Resource Status” on
page 145.

Activating a Port
To activate a port:

Step 1. Main panel Management menu → Ports.
Step 2. Select the port you want to activate.
Step 3. Operations menu → Activate selected resource.

Deactivating a Port Normally
To deactivate a port normally:

Step 1. Main panel Management menu → Ports.
Step 2. Select the port you want to activate.
Step 3. Operations menu → Deactivate selected resource (normal mode).

Forcing the Deactivation of a Port
 Attention 

When you deactivate a port in forced mode, you might lose data in
transit, because the port and its associated resources are
deactivated without waiting for all of their activity to cease.

To force the deactivation of a port:

Step 1. Main panel Management menu → Ports.
Step 2. Select the port you want to activate.
Step 3. Operations menu → Deactivate selected resource (forced mode).

Activating All Listed Ports
 Attention 

Before you run the command, activating a large number of ports may
take some time, however the command can be cancelled from the
system menu icon, by selecting Close.

To activate all listed ports:

Main panel Management menu → Ports → Operations menu → Activate listed
ports

Deactivating All Ports in Normal Mode
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 Attention 

Before you run the command, deactivating a large number of ports
may take some time, however, the command can be cancelled from
the system menu icon, by selecting Close.

Before doing this, scroll vertically through the list of ports, to display
the ports not originally displayed and to check whether you really
want to deactivate them all.

To deactivate all listed ports:

Main panel Management menu → Ports → Operations menu → Deactivate
listed resources (normal mode).

Deactivating All Ports in Forced Mode
 Attention 

When you deactivate a port in the forced mode, you may lose data
in transit, since the port and its associated resources are deactivated
without waiting for all of their activity to cease.

Before you start deactivating all ports, use the vertical scrolling bars
to display the items that can be displayed in the panel, and check if
you really want to deactivate all the ports.

Deactivating a large number of ports is time-consuming. However,
this command can be cancelled from the system menu icon, by
selecting the Close option.

To force the deactivation of all ports:

1. Main panel Management menu → Ports

2. Operations menu → Deactivate listed resources (forced mode)

IP Resource Status
IP resource activation is a two-stage process that runs the Activate command (a
generic management command), and the Test command (an IP command). The
DLC configuration of the IP resource is activated, and then the IP resource in the
processor is activated.

The Activate and Test commands are combined into a single CCM command.

IP resource deactivation also has two stages, the Disable command and the
Deactivate command. The IP resource is disabled in the processor, and then the
DLC configuration of the IP resource is deactivated.

The Deactivate and Disable commands are also combined into CCM commands.
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MOSS-E IP Commands
You can use the IP commands function from the MOSS-E Network Node
processor (NNP) menu to issue the Test or Disable command.

If you issue the Test or Disable command, the resource status changes.

Possible IP Resource Statuses
An IP resource can have one of the following statuses:

Active/up The Activate command has been issued from the CCM and
the resource is ready for operation.

Active/disabled The resource was active and the Disable command has
been issued via Telnet. The resource is not ready for
operation.

Inactive/testing The resource was inactive and the Test command has been
issued via Telnet. The resource is not ready for operation.

Inactive/Disabled The Deactivate command has been issued from the CCM.

Note:  Active/testing and inactive/up are not valid statuses.
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Table 8 shows the changes in status that result from the issuing of these
commands.

Table 8. Post-Command Status

Command issued

Pre-Command Status

Active/up Active/Disabled Inactive/Testing Inactive/Disabled

Test – Active/Up – Inactive/Testing

Disable Active/disabled – – –

Activate – Active/up Active/up Active/up

Deactivate Inactive/Disabled Inactive/Disabled – –

Notes: 

1. A dash (-) indicates that the status remains unchanged.

2. Using CCM, you can only activate and deactivate an IP resource, even though the commands Activate and
Deactivate are linked to Test and Disable.

3. Use Telnet to issue the commands Test and Disable.

Here are some examples:

If you issue the command Disable via Telnet for a resource that is active/up, the
resource status becomes active/disabled. In this situation, the DLC configuration is
still active, but the IP data is no longer active, and the resource is no longer ready
for operation.

If you issue the command Test via Telnet for a resource that is active/disabled, the
resource status becomes active/up. In this situation, the DLC configuration which
was already active, remains active, and the IP data has been activated through the
Test command. The resource, therefore, becomes ready for operation.
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 Managing Stations
The station management tasks that can be performed with the CCM include:

� Displaying a list of configured stations
� Displaying a list of sessions for a selected station
� Viewing the details of a station
� Activating and deactivating stations.

Note:  The station management tasks can be accessed from a panel containing a
list of stations associated with a specific port.

Displaying a List of Configured Stations
You can display all of the stations handled by the controller to perform the station
management tasks.

To display the stations:

Main panel Management menu → Stations → Station Management panel (see
Figure 65).

Figure 65. APPN Stations Information Display Panel
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Displaying a List of Sessions for a Selected Station
Use this function to display the sessions available for a station.

To display the sessions for a station:

Step 1. Main panel Management menu → Stations → Station Management
panel.

Step 2. Double-click the desired station to display the sessions activated for it.

Note:  You can display details about a specific session from the panel showing the
sessions activated for a specific station.

Viewing the Details of a Station
You can display the configuration details for a selected station. The details include
the currently configured parameter values and the values automatically generated
by the CCM during network operation.

To display details about a station:

Step 1. Main panel Management menu → Stations → Station Management
panel.

Step 2. Double-click the desired station.

Step 3. Operations menu → Details.

Activating and Deactivating Stations
You can activate or deactivate stations as required (see Figure 64 on page 143).

Station activation is a process that loads code and runs tests in order to make the
station available for use. When the station is deactivated, it is no longer available
for providing network services.

Stations can be deactivated normally, or by forcing the deactivation.

A normally deactivated station is deactivated if traffic has stopped flowing through it
and its associated resources. Sessions are first deactivated, then the stations.

A force-deactivated station is deactivated while traffic is flowing through it and its
associated resources, regardless of the status of its associated resources. This is
done if, for example, a station has not been deactivated within a reasonable time
after attempting a normal deactivation, or if a station must be immediately
deactivated for a specific reason.

When you activate or deactivate a resource, you receive a message after the
command completion. This message indicates whether or not the command has
been successfully performed and completed. In case of an error, you get a return
code. Use SMPR for problem determination.
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Activating a Station
To activate a station:

Step 1. Main panel Management menu → Stations.

Step 2. Select the station you want to deactivate.

Step 3. Operations menu → Activate selected resource.

Deactivating a Station Normally
To deactivate a station normally:

Step 1. Main panel Management menu → Stations.

Step 2. Select the station you want to deactivate.

Step 3. Operations menu → Deactivate selected resource (normal mode).

Forcing the Deactivation of a Station
 Attention 

When you deactivate a station in forced mode, you may lose data in
transit, since the station and its associated resources are deactivated
without waiting for all of their activity to cease.

To force the deactivation of a station:

Step 1. Main panel Management menu → Stations.

Step 2. Select the station you want to deactivate.

Step 3. Operations menu → Deactivate selected resource (forced mode).

Activating All Listed Stations
 Attention 

Before you run the command, activating a large number of stations
may take some time, however, the command can be cancelled from
the system menu icon, by selecting Close.

To activate all listed stations:

Main panel Management menu → Stations → Operations menu → Activate
listed stations.
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Deactivating All Stations Normally
 Attention 

Before you run the command, deactivating a large number of
stations may take some time, however the command can be
cancelled from the system menu icon, by selecting Close.

Before doing this, scroll though the list to view all stations and to
check whether or not you really want to deactivate all stations.

To deactivate all stations normally:

Main panel Management menu → Stations → Operations menu → Deactivate
listed resources (normal mode)

Forcing the Deactivation of All Stations
 Attention 

When you deactivate a station in the forced mode, you may lose
data in transit, since the station and its associated resources are
deactivated without waiting for all of their activity to cease.

Before you start deactivating all stations, use the vertical scrolling
bars to display the items that can be displayed in the panel, and
check if you really want to deactivate all stations.

Deactivating a large number of stations is time-consuming.
However, this command can be cancelled from the system menu
icon, by selecting the Close option.

To force the deactivation of all stations:

1. Main panel Management menu → Stations.

2. Operations menu → Deactivate listed resources (forced mode).
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Displaying Information about Sessions
You can display information about the CP-CP and LU-LU sessions currently routed
through the network node.

To display sessions information:

Step 1. Main panel Management menu → Non-intermediate sessions → Ports
Management panel (see Figure 66).

Figure 66. Sessions Information Display

Step 2. Double-click the appropriate session.

Step 3. Operations menu → Details.

Step 4. Details about the selected session are displayed in the CCM IP Results
Display (see Figure 68 on page 154).
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IP-Specific Port/Processor Commands
This section explains how to issue IP port-level or processor-level management
commands to view information about ports or processors and to clear certain
memory areas.

Notes:

1. For the overall, node-level commands, see Chapter 18, “Managing IP Router
Data” on page 165.

2. The CCM and Telnet commands given in this section cannot be used for the
MAE. MAE IP management is only done through Telnet, refer to either:

� 3746 Nways Multiprotocol Controller Model 950: User’s Guide.

� 3745 Communication Controller Models A, 3746 Nways Multiprotocol
Controller Model 900: Basic Operations Guide.

The port-level or processor-level management commands can be issued in two
ways:

1. By sending a command using the MOSS-E Telnet console, refer to the
3746-950  User’s Guide.

The equivalent Telnet command is given for each CCM command. Most of the
time, the command is issued by selecting a cascaded menu item: the CCM
automatically adds any necessary parameters to the command.

Note:  Certain commands ask you for additional information. For example, if
the command must be issued for a specific resource by its address, name, or
number.

2. By using the CCM:

a. Main panel Management menu → Ports

b. Double-click a port in the Ports Management panel → CCM Management
panel

c. Select the level (port or processor) of the commands that you want to use
by selecting either one of the first two IP specifics menu options (see
Figure 67 on page 154):

On selected port
When this option is selected, only commands that can be issued
on the port-level are available in the IP specifics menu.

On processor of selected port
When this option is selected, the commands act globally on the
port’s processor, that is, for all the ports on all the couplers
attached to the processor.

d. Use the IP specifics menu to issue a command.
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Figure 67. Example IP Port Management Menus

Available Commands Depend on IP Resource DLC
The choices available in the IP specifics menu and its cascaded sub-menus vary
depending on the DLC (token-ring, frame relay, X.25, or ESCON) of the resource
selected as a target for the IP commands.

CCM IP Results Display
If information is generated as the result of a command being issued, it is displayed
by CCM in the CCM IP Results Display panel, see Figure 68.

| Figure 68. Example CCM IP Results Display

The Options menu lets you:

Search You can search for a character string currently in the display (the string
need not be visible at the time of the search).

Clear You can delete all the information currently in the display.
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Buffer Use and Size
To view information about the packet buffer usage and size at the port or processor
level, you can issue either:

� Telnet command: GWCON BUFFER

� CCM command: CCM Management menu → IP specifics → Buffer

Protocol and Port Configurations
To view information (DLC type and status) about the ports configured on the
processor, you can issue either:

� Telnet command: GWCON CONFIGURATION

� CCM command: CCM Management menu → IP specifics → Configuration

Issuing this command for the 2080 coupler lets you view the whole 3746
configuration.

ESCON and Token-Ring Port Dump
To view an ESCON (line status, traffic statistics) and token-ring (MAC address and,
if source routing is used, RIF information) port dump, you can issue either:

� Telnet command: NET DUMP

� CCM command: CCM Management menu → IP specifics → Dump

Current Processor Memory Use
To view information about current processor memory usage, and buffers, you can
issue either:

� Telnet command: GWCON MEMORY

� CCM command: CCM Management menu → IP specifics → Memory

Port Queue Length
To view information about the input and output queues (number of buffers and
queue length) at the port or processor level, you can issue either:

� Telnet command: GWCON QUEUE

� CCM command: CCM Management menu → IP specifics → Queue
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All Parameters of a X.25 Port
To view information about the X.25 port parameters at the packet, frame, and
physical levels, you can issue either:

� Telnet command: NET PARAMETERS ALL

� CCM command: CCM Management menu → IP specifics → Parameters →
All

This command is only available for X.25 IP ports.

For more information, see “X.25 Physical Level Port Parameters,” “X.25 Frame
Level Port Parameters,” and  “X.25 Packet Level Port Parameters.”

X.25 Physical Level Port Parameters
To view information about the X.25 port parameters at the physical level (interface
type, maximum frame size, type of clocking, and others), you can issue either:

� Telnet command: NET PARAMETERS PHYSICAL

� CCM command: CCM Management menu → IP specifics → Parameters →
Physical

This command is only available for X.25 IP ports.

X.25 Frame Level Port Parameters
To view information about the X.25 port parameters at the frame level (maximum
frame and panel size, the T1, T2, N1, and disconnect timers, and others), you can
issue either:

� Telnet command: NET PARAMETERS FRAME

� CCM command: CCM Management menu → IP specifics → Parameters →
Frame

This command is only available for X.25 IP ports.

X.25 Packet Level Port Parameters
To view information about the X.25 port parameters at the packet level (default and
maximum packet size, various timers, number of logical circuits, and others), you
can issue either:

� Telnet command: NET PARAMETERS PACKET

� CCM command: CCM Management menu → IP specifics → Parameters →
Packet

This command is only available for X.25 IP ports.

 Error Information
To view statistics about the errors (number of packets discarded or that were
defective) at the port or processor level, you can issue either:

� Telnet command: GWCON ERROR

� CCM command: CCM Management menu → IP specifics → Error
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 Interface Information
To view statistics about the number of passed and failed self-tests and the number
of maintenance failures at the port or processor level, you can issue either:

� Telnet command: GWCON INTERFACE

� CCM command: CCM Management menu → IP specifics → Statistics →
Interface

All X.25 Port Statistics
To view all the X.25 counters (packet, frame, and physical levels), you can issue
either:

� Telnet command: NET STATISTICS ALL

� CCM command: CCM Management menu → IP specifics → Statistics → All

For more information, see “X.25 Physical Level Port Statistics,” “X.25 Frame Level
Port Statistics,” and  “X.25 Packet Level Port Statistics.”

X.25 Physical Level Port Statistics
To view the X.25 physical layer counters and information (received and transmitted
bytes, cable information, frame error counters, and others), you can issue either:

� Telnet command: NET STATISTICS PHYSICAL

� CCM command: CCM Management menu → IP specifics → Statistics →
Physical

X.25 Frame Level Port Statistics
To view the X.25 frame level counters (number of received and transmitted frames
of each type, number of timeouts for the T1, T2, N1, and disconnect timers, and
others), you can issue either:

� Telnet command: NET STATISTICS FRAME

� CCM command: CCM Management menu → IP specifics → Statistics →
Frame

X.25 Packet Level Port Statistics
To view the X.25 packet level counters (number of received and transmitted
packets of each type and others), you can issue either:

� Telnet command: NET STATISTICS PACKET

� CCM command: CCM Management menu → IP specifics → Statistics →
Packet
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All Statistics for a Serial Line Interface
To view statistics about serial lines (frame-relay circuits, PPP, and X.25) at the port
level, you can issue either:

� Telnet command: NET LIST ALL

� CCM command: CCM Management menu → IP specifics → Statistics →
List → All

This command is only available for frame-relay, X.25, and PPP ports.

Statistics for a DLCI
To view the statistics for a DLCI, you can issue either:

� Telnet command: NET LIST CIRCUIT

 � CCM command:

1. CCM Management menu → IP specifics → Statistics → List → Circuit
number

2. Enter a DLCI number and press OK.

This command is only available for frame-relay ports.

 LMI Information
To view information about the LMI (local management interface) for the frame-relay
port, you can issue either:

� Telnet command: NET LIST LMI

� CCM command: CCM Management menu → IP specifics → Statistics →
List → LMI

This command is only available for frame-relay ports.

Frame-Relay Physical Line Parameters
To view information about the frame-relay physical line parameters for a port, you
can issue either:

� Telnet command: NET LIST LINE PARAMETERS

� CCM command: CCM Management menu → IP specifics → Statistics →
List → Physical line

This command is only available for frame-relay IP ports.

Frame-Relay COMRATE Parameters
To view information about the frame-relay port parameters, you can issue either:

� Telnet command: NET LIST COMMUNICATION RATE TUNING

� CCM command: CCM Management menu → IP specifics → Statistics →
List → COMRATE

This command is only available for frame-relay IP ports.
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Frame-Relay DLCI IP Address
To find the IP address of the other end of a frame-relay DLCI, you can issue either:

� Telnet command: NET LIST IARP TABLE

� CCM command: CCM Management menu → IP specifics → Statistics →
List → IARP table

This command is only available for frame-relay IP ports and is also called the
inverse ARP command.

X.25 PVC Information
To view information about the PVCs (permanent virtual circuits) for the frame-relay
port, you can issue either:

� Telnet command: NET LIST PERMANENT-VIRTUAL-CIRCUITS

� CCM command: CCM Management menu → IP specifics → Statistics →
List → PVCs

This command is only available for frame-relay ports.

 SVC Information
To view information about the SVCs (switched virtual circuits) for the X.25 or
frame-relay port, you can issue either:

� Telnet command: NET LIST SVCS

� CCM command: CCM Management menu → IP specifics → Statistics →
List → SVCs

X.25 IP Address Table
To view information about the X.25 IP address table for the port, you can issue
either:

� Telnet command: NET LIST

� CCM command: CCM Management menu → IP specifics → Statistics →
List → IP-ADDRESS-TABLE

This command is only available for X.25 IP ports.

PPP IP Control Protocol Information
To view control information (state and configuration) about the IP control protocol
for the PPP port, you can issue either:

� Telnet command: NET LIST CONTROL IPCP

� CCM command: CCM Management menu → IP specifics → Statistics →
List → Control → IPCP

PPP Link Control Protocol Information
To view control information (state and configuration) about the PPP link control
protocol for the PPP port, you can issue either:

� Telnet command: NET LIST CONTROL LCP

� CCM command: CCM Management menu → IP specifics → Statistics →
List → Control → LCP
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PPP Error Statistics
To view error statistics for a PPP port at the port level, you can issue either:

� Telnet command: NET LIST ERRORS

� CCM command: CCM Management menu → IP specifics → Statistics →
List → Error

PPP Link IP Information
To view information about IP packets over a PPP link at the port level, you can
issue either:

� Telnet command: NET LIST IP

� CCM command: CCM Management menu → IP specifics → Statistics →
List → IP

PPP IP Control Protocol Statistics
To view IP control protocol statistics (packets received and transmitted) for a PPP
port, you can issue either:

� Telnet command: NET LIST IPCP

� CCM command: CCM Management menu → IP specifics → Statistics →
List → IPCP

General Port Statistics
To view statistics (type of port(s), number of packets and bytes received and
transmitted) about the port or processor, you can issue either:

� Telnet command: GWCON STATISTICS

� CCM command: CCM Management menu → IP specifics → Statistics

 Clearing Statistics
To clear all statistics counters on the port or processor, you can issue either:

� Telnet command: GWCON CLEAR

� CCM command: CCM Management menu → IP specifics → Statistics →
Clear

Router Status Information
To view the status of the all router processes on the processor, you can issue
either:

� Telnet command: OPCON STATUS

� CCM command: CCM Management menu → IP specifics → Status

Router Up-Time Statistics
To view router processor statistics (number of restarts and crashes, time since last
reload or restart), you can issue either:

� Telnet command: OPCON UPTIME

� CCM command: CCM Management menu → IP specifics → Uptime
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IP Access Controls
To view information about the IP access controls on the processor (enabled or
disabled and exclusive or inclusive for the source and destination networks,
protocols, and ports), you can issue either:

� Telnet command: P_IP ACCESS

� CCM command: CCM Management menu → IP specifics → IP commands
→ Access

IP Routing Table Cache
To view the IP routing table cache on the processor, you can issue either:

� Telnet command: P_IP CACHE

� CCM command: CCM Management menu → IP specifics → IP commands
→ Cache

 IP Counters
To view statistics in the IP counters for the processor (routing errors, dropped
packets due to congestion, multicast packets, and overflows), you can issue either:

� Telnet command: P_IP COUNTERS

� CCM command: CCM Management menu → IP specifics → IP commands
→ Counters

Router IP Addresses
To view the IP addresses and masks for the local processor, you can issue either:

� Telnet command: P_IP INTERFACE

� CCM command: CCM Management menu → IP specifics → Statistics →
Interface

Routing Table Size
routing table size To view the size of the routing table, reassembly buffer, and
routing cache for the processor, you can issue either:

� Telnet command: P_IP SIZES

� CCM command: CCM Management menu → IP specifics → IP commands
→ Sizes

Clearing ARP Statistics
To flush the ARP cache for a port, you can issue either:

� Telnet command: P_ARP CLEAR

� CCM command: CCM Management menu → IP specifics → ARP commands
→ Clear
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 ARP Cache
To view the ARP cache (MAC address, IP address, and refresh timer) for a port,
you can issue either:

� Telnet command: P_ARP DUMP interface#

� CCM command: CCM Management menu → IP specifics → ARP commands
→ Dump ARP routing table

ARP Registered Networks
To view the port type and MAC address of the ports currently registered with ARP,
you can issue either:

� Telnet command: P_ARP HARDWARE

� CCM command: CCM Management menu → IP specifics → ARP commands
→ Hardware

ARP Registered Address Protocols
To view ARP information (the port, its protocol, and protocol local address), you
can issue either:

� Telnet command: P_ARP PROTOCOL

� CCM command: CCM Management menu → IP specifics → ARP commands
→ Protocol

Statistics about ARP
To view ARP statistics, you can issue either:

� Telnet command: P_ARP STATISTICS

� CCM command: CCM Management menu → IP specifics → ARP commands
→ Statistics
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Chapter 17. Viewing Node-Level APPN Information

This chapter explains how to see global information about APPN resources running
on the network node. Figure 69 shows the APPN-specific cascaded-menu.

Figure 69. Example Management Panel for APPN

View Details of the APPN Network Topology
You can see the APPN network topology including details about the nodes and the
links that are active and active-on-demand.

To view the topology information: Main panel Management menu → APPN
specifics → Topology... → Topology Information Display panel

View Details of the Network Nodes
You can see network node information, including details about the service
processor and network node processor.

To view the network node information: Main panel Management menu → APPN
specifics → Network node → Network Node Information Display panel

View Details of the Network Directories
You can see information about the network directory, including details of all the LUs
for which the local node "recognizes" the owning control point, details of the
network node CP name, the number of associated LUs, the name of the owning CP
and the LU entry type.

To view the directory information: Main panel Management menu → APPN
specifics → Directory → Directory Information Display panel.
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View Details of the Connection Networks
You can see information about the connection networks.

To view the connection information: Main panel Management menu → APPN
specifics → Connection networks → Connection Networks Information
Display panel

| View Details of the HPR Connections
You can see information about the HPR connections.

| To view the HPR connection information: Main panel Management menu →
| APPN specifics → HPR Connections → HPR Connections Information Display
| panel

 Aping
You can check the reachability of an APPN resource using this MOSS-E command.
This is similar to the IP PING command.

To use Aping: Main panel Management menu → APPN specifics → Aping →
APING MOSS-E panel.
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Chapter 18. Managing IP Router Data

This chapter explains how to manage IP network resources that are part of the
3746 router (including the MAE), by issuing commands.

These commands can be issued in two ways:

1. By sending a command using the MOSS-E Telnet console, refer to the 3746
Nways Multiprotocol Controller Model 950: User’s Guide.

The equivalent Telnet command is given for each CCM command. Most of the
time, the command is issued by selecting a cascaded menu item: the CCM
automatically adds any necessary parameters to the command.

Note:  Certain command ask you for additional information. For example, if
the command must be issued for a specific resource by its address, name, or
number.

2. Through the IP specifics cascaded menu from the main panel Management
menu (see Figure 70).

If information is generated as the result of a command being issued, it is
displayed by CCM in the CCM IP Results Display panel (see Figure 67 on
page 154).

Figure 70. Example of an IP Command Panel

These commands are only available if IP resources are in the active configuration.
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General IP-Specific Commands

Viewing the Protocol and Interface Configuration
To view details of the protocol and interface configuration for the whole router, you
can issue either:

� Telnet command: GWCON CONFIGURATION

� CCM command: Main panel Management menu → IP specifics →
Configuration

View (Dump) the Router Routing Table
To perform a dump of the router routing table, you can issue either:

� Telnet command: P_IP DUMP

� CCM command: Main panel Management menu → IP specifics → Dump
routing table

Verifying the Reachability of a Resource: Ping
This commands checks whether or not a resource is currently reachable. It sends
data packets of a specific size to the remote resource and requests the resource to
send back the same packets as confirmation that it is reachable.

This command can be issued to a resource at a specific destination address, with
no other parameters being defined. Alternatively the command can be issued to a
specific destination address, with additional control values such as the size of the
data packet being used for pinging, or the time to live (TTL) value for the ping
packets.

You can issue either:

� Telnet command: P_IP PING

� CCM command: Main panel Management menu → IP specifics → Ping →
Ping panel.

To start pinging, specify the values in the panel and press Ping.

To stop pinging, return to the Ping panel and press Stop ping.

Restarting the IP Router
To restart the IP router, you can issue either:

� Telnet command: OPCON RESTART

� CCM command: Main panel Management menu → IP specifics → Restart

Note:  When the IP router is restarted, the MAE is completely (both IP and APPN
traffic) restarted.
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Viewing the Route to a Resource
To view information (next hops, routing characteristics) about the route to a
specified destination address, you can issue either:

� Telnet command: P_IP ROUTE

� CCM command: Main panel Management menu → IP specifics → Route →
Route panel

Tracing the Route to a Resource
This command traces the transfer of packets to the specified destination and shows
the entire route, information about the next hops, and the time to get to each
intermediate hop.

To trace the entire route to a specific network resource, you can issue either:

� Telnet command: P_IP TRACEROUTE

� CCM command: Main panel Management menu → IP specifics → Traceroute
→ Traceroute panel

To start tracing, specify the values in the panel and press Trace.

To stop tracing, return to the Traceroute panel and press Stop trace.

IP OSPF Commands

OSPF Link State Advertisement
To view details of a link state advertisement in the OSPF database, you can issue
either:

� Telnet command: P_OSPF ADVERTISEMENT [advertising-router] [area-id]
command

� CCM command: Main panel Management menu → IP specifics → OSPF →
Advertisement → OSPF - Advertisement panel

 OSPF Area
To view the statistics and parameters of all the OSPF areas attached to the router,
you can issue either:

� Telnet command: P_OSPF AREA

� CCM command: Main panel Management menu → IP specifics → OSPF →
Area

OSPF AS-External Information
To view all the AS external advertisements belonging to the OSPF routing domain,
you can issue either:

� Telnet command: P_OSPF AS-EXTERNAL

� CCM command: Main panel Management menu → IP specifics → OSPF →
AS-External
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OSPF Area Link State Database
To view link state (advertisements) database of a specific OSPF area, you can
issue either:

� Telnet command: P_OSPF DATABASE

� CCM command: Main panel Management menu → IP specifics → OSPF →
Database → OSPF - Database panel

OSPF Interface Statistics
To view details of the statistics and parameters for all OSPF interfaces, or a
specific one, you can issue either:

� Telnet command: P_OSPF INTERFACE

� CCM command: Main panel Main panel Management panel → IP specifics
→ OSPF → Interface → OSPF - Interface panel

Adding an OSPF Router to a Multicast Group
To add an OSPF router to a multicast group, you can issue either:

� Telnet command: P_OSPF JOIN

� CCM command: Main panel Management menu → IP specifics → OSPF →
Multicast → Join → OSPF - Join Multicast Group Address panel

Removing an OSPF Router from a Multicast Group
To remove an OSPF router from a multicast group, you can issue either:

� Telnet command: P_OSPF LEAVE

� CCM command: Main panel Management menu → IP specifics → OSPF →
Multicast → Leave → OSPF - Leave Multicast Group Address panel

OSPF Multicast Cache
To view all or a specific multicast cache entry, you can issue either:

� Telnet command: P_OSPF MCACHE

� CCM command: Main panel Management menu → IP specifics → OSPF →
Multicast → Mcache → OSPF - Multicast Cache panel

Router OSPF Membership Groups
To view the group membership of the attached router interfaces, you can issue
either:

� Telnet command: P_OSPF MGROUPS

� CCM command: Main panel Management menu → IP specifics → OSPF →
Multicast → Mgroups
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OSPF Multicast Routing Statistics
To view statistics (types of forwarding enabled, datagram counters) about the
multicast routing, you can issue either:

� Telnet command: P_OSPF MSTAT

� CCM command: Main panel Management menu → IP specifics → OSPF →
Multicast → Mstat

Details of Active OSPF Neighbors
To view statistics and parameters for all or a specified OSPF neighbor, you can
issue either:

� Telnet command: P_OSPF NEIGHBOR

� CCM command for all neighbors: Main panel Management menu → IP
specifics → OSPF → Multicast → Neighbors → OSPF - Neighbors panel

OSPF Router Routes
To view all the router routes that have been calculated by OSPF, you can issue
either:

� Telnet command: P_OSPF ROUTERS

� CCM command: Main panel Management menu → IP specifics → OSPF →
Routers

Link State Advertisement Database Statistics
To view the number of link state advertisements (LSAs) in the link state database
(categorized by type), you can issue either:

� Telnet command: P_OSPF SIZE

� CCM command: Main panel Management menu → IP specifics → OSPF →
SIZE

OSPF Routing Statistics
To view the statistics generated by the OSPF routing protocol, you can issue either:

� Telnet command: P_OSPF STATISTICS

� CCM command: Main panel Management menu → IP specifics → OSPF →
Statistics

Changing the Cost of an OSPF Interface
You can view and temporarily change the cost of a router OSPF interface. If the
router is restarted or reloaded, the cost of the interface reverts back to its original
configured value.

You can issue either:

� Telnet command: P_OSPF WEIGHT

� CCM command: Main panel Management menu → IP specifics → OSPF →
Weight → OSPF - Weight panel
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IP BGP View Commands

BGP Routing Table
You can view (dump) the BGP routing table (network addresses, subnet masks,
advertised to- and advertised from-entries).

This command can be issued to all destinations, a specific destination, or to
destinations advertised or obtained.

You can issue either:

� Telnet command: P_BGP DESTINATIONS

� CCM command: Main panel Management menu → IP specifics → BGP →
Destinations → BGP - Destinations panel

Details of Active BGP Neighbors
To view details of all active neighbors, or of a specific neighbor, you can issue
either:

� Telnet command: P_BGP NEIGHBORS

� CCM command: Main panel Management menu → IP specifics → BGP →
Neighbors → BGP - Neighbors panel

Path Description Database
To view the paths in the path description database, you can issue either:

� Telnet command: P_BGP PATHS

� CCM command: Main panel Management menu → IP specifics → BGP →
Paths

Size of the BGP Databases
To view the size of all the BGP databases, you can issue either:

� Telnet command: P_BGP SIZES

� CCM command: Main panel Management menu → IP specifics → BGP →
Sizes
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Appendix A. CCM Remote Configuration Application:
Options, Script Commands and Variables

This appendix provides information about:

� CCMCLI options and variables
� The script commands

 � The variables

CCMCLI Options and Variables
The following section provides information about the ccmcli options and variables.

 Options
The following list shows the ccmcli command options:

-f:script_name Starts the application in script mode with the script_name file.
-i:n    Ignores all the errors (-i, which is the default value) or any

first n specified error number.
-v Shows the application release number
-q Means quiet mode – No information is displayed while the

application is running.
-s Only syntactic analyze is processed – No request is

performed.

 Variables
The following list shows the ccmcli variables.

config_nb indicates the number of configurations available in
the current directory.

config_name[integer_value] indicates the name of the configuration according
to its position in the list (indicated by
integer_value).

config_nb[config_name] indicates for the specified configuration, its
position in the list.

 Example

[local]>ccnb=config_nb
[local]>ccfisrt=config_name[1]
[local]>cclast=config_name[ccnb]
[local]>@echo "number of configuration $ccnb"
[local]>number of configuration 15
[local]>@echo "first configuration $ccfirst"
[local]>first configuration BS8 05/02/99
[local]>@echo "last configuration $cclast"
[local]>last configuration BS9 12/12/99
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 Script Commands
This section provides information about the commands used in the script files.

label and goto
The label identifies a specific part of the script program. The goto command is
used for intentional rerouting and works with the label.

 Syntax
label:
goto label:

 Example
start:
deletel config_name [1]
goto start:

 include
The include commands calls, from a script file, another script file.

 Syntax
include script name

 Example
The script 1 file contains the following instructions:

logon mosse user password
select "BSA-810L"

The script 2 file contains the following instructions:

include script1
get config_name[1]

 interactive_mode
This command interrupts the current script program and switches to the interactive
mode. In order to return to the script mode and continue the script program
execution, type exit on the command line.

 Syntax
interactive_mode

 Example
logon mosse user password
select "BSA-810L"
name=config_name[1]
local
interactive_mode
@echo $name
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onerror   
Error rerouting allows you to manage actions when errors occur.  

 Syntax
onerror goto label:

onerror command

 Example
start:
onerror goto error:
deleter config_name[1]
goto start:

error:
onerror exit
displayr config_name[1]
unlock config_name[1]
goto start:

 Substitution
Substitution is used to assign a specific value to a variable depending on whether
or not the variable has been previously initialized.

 Syntax
${var?var1:var2}

 Example
var=shell
a=${var?ls:dir}
@ $a /* In this case a=ls */
unset var
a=${var?ls:dir}
@ $a /* In this case a=dir */

 Variables
Variables are mainly used in the script files.

Assigning a Value
Consists to set a value to a variable.

 Syntax
variable_name=value
variable_name=“value”

Note:  Quotes (“xxx”) are used when the value contains blanks.
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 Example
The following instruction assigns to the program_name variable the CCMCLI
value.

program_name=CCMCLI

The following instruction assigns to the program_name variable the CCMCLI is
new value.

program_name=“CCMCLI is new”

 Expanding Variables
Expansion is used to assign to a variable the value of another variable.

 Syntax
$variable_name

 Example
[local]> configuration_name=config_test
[local]> first_name=$configuration_name
[local]> @echo $first_name
[local]> config_test

Deleting a Variable
Use the unset command to delete the value of a variable.

 Syntax
unset variable_name

 Example
unset program_name

 Example
[local]> configuration=config_test
[local]> first_name=$configuration
[local]> second_name="$configuration name"
[local]> third_name=$configuration_name
[local]> VARIABLE configuration_name DOES NOT EXIST
[local]> fourth_name="${configuration}_name"
[local]> @echo $configuration
[local]> config_test
[local]> @echo $first_name
[local]> config_test
[local]> @echo $second_name
[local]> config_test name
[local]> @echo $third_name
[local]>
[local]> @echo $fourth_name
[local]> config_test_name
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 Parameters
Parameters are used to provide additional information for script file execution.
They are identified using $n, where n corresponds to the number of the parameter
position (first, second, third...) after the ccmcli character string. Note that $0
corresponds to the script name and $* to the list of parameters.

 Example
ccmcli -f:sample1 address userid password

 Sample1

@echo $*
@echo $0
@echo $1
@echo $2
logon $2 $3 $4

Sample1 results in:

-f:sample1 address userid password
sample1
-f:sample1
address
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Customer Documentation for the 3746 Model 950

Table 9 (Page 1 of 5). Customer Documentation for the 3746 Model 950

This customer documentation has the following formats:

B o o k s

O n l i n e B o o k s
and

D i s k e t t e s

Finding Information

3745 Models A and 3746 Books

All of the books in the 3745 Models A and 3746 library are available on the
CD-ROM that contains the Licensed Internal Code (LIC) for the machine.

Preparing for Operation

GA33-0400 IBM 3745 Communication Controller All Models¹
IBM 3746 Expansion Unit Model 900
IBM 3746 Nways Multiprotocol Controller Model 950

Safety Information²

Provides general safety guidelines.

Evaluating and Configuring

GA33-0180 IBM 3745 Communication Controller Models A and 170³
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Overview

Gives an overview of connectivity capabilities within SNA, APPN, and IP
networking.

GA27-4234 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Overview, Installation, and Integration

Provides information for:

� Overall 3746 planning
� Installation and upgrade scenarios
� Controller and service processor network integration
� Related MOSS-E and CCM worksheets for these tasks.
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Table 9 (Page 2 of 5). Customer Documentation for the 3746 Model 950

GA27-4235 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Serial Line Adapters

Provides information for:

� Serial line adapter descriptions
� Serial line adapter line weights and connectivity
� Types of SDLC support
� Configuring X.25 lines
� Performance tuning for frame-relay, PPP, X.25, and NCP lines.
� ISDN adapter description and configuration.

GA27-4236 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Token Ring and Ethernet

Provides information for:

� Token-ring adapter description and configuration
� Ethernet adapter description and configuration.

GA27-4237 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
ESCON Channels

Provides information for:

� ESCON adapter descriptions
� ESCON configuration and tuning information
� ESCON configuration examples.

GA27-4238 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Physical Planning

Provides information for:

� 3746 and MAE physical planning details
� 3746 and MAE cable information
� Explanation of installation sheets
� 3746 plugging sheets.
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Table 9 (Page 3 of 5). Customer Documentation for the 3746 Model 950

GA27-4239 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Management Planning

Provides information for:

� Overview for 3746
� 3746 APPN/HPR, IP router, and X.25
� NetView Performance Monitor (NPM), remote consoles, and RSF
� MAE APPN/HPR management.

GA27-4240 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Multiaccess Enclosure Planning

Provides information for:

� MAE adapters details
� MAE ESCON planning and configuration
� ATM and ISDN support.

GA27-4241 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Protocols Description

Provides information for:

� Overview and details about APPN/HPR and IP.

On-line information IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Controller Configuration and Management Worksheets

Provides planning worksheets for ESCON, Multiaccess Enclosure, serial line,
and token-ring definitions.
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Table 9 (Page 4 of 5). Customer Documentation for the 3746 Model 950

Operating and Testing

SA33-0356 IBM 3746 Nways Multiprotocol Controller
Model 950

User's Guide²

Explains how to:

� Carry out daily routine operations on Nways controller
� Install, test, and customize the Nways controller after installation
� Configure user's workstations to remotely control the service processor

using:
 – DCAF program
– Telnet client program
– Java Console support.

On-line information Controller Configuration and Management Application

Provides a graphical user interface for configuring and managing a 3746
APPN/HPR network node and IP Router, and its resources.
It is also available as a stand-alone application, using an OS/2 workstation.
Defines and explains all the 3746 Network Node and IP Router configuration
parameters through its on-line help.

SH11-3081 IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Controller Configuration and Management: User's Guide²

Explains how to use CCM and gives examples of the configuration process.

GA33-0479 IBM 3745 Communication Controller Models A
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

NetView Console
APPN Command Reference Guide

Explains how to use the RUN COMMAND from the NetView S/390 Program
and gives examples.

Managing Problems

On-line information Problem Analysis Guide

An on-line guide to analyze alarms, events, and control panel codes on:

� IBM 3745 Communication Controller Models A³
� IBM 3746 Nways Multiprotocol Controller Models 900 and 950.

SA33-0175 IBM 3745 Communication Controller Models A³
IBM 3746 Expansion Unit Model 900
IBM 3746 Nways Multiprotocol Controller Model 950

Alert Reference Guide

Provides information about events or errors reported by alerts for:

� IBM 3745 Communication Controller Models A³
� IBM 3746 Nways Multiprotocol Controller Models 900 and 950.
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Table 9 (Page 5 of 5). Customer Documentation for the 3746 Model 950

¹ Models 130 to 61A.
² Documentation shipped with the 3746-950
³ 3745 Models 17A to 61A.
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Customer Documentation for the 3745 (All Models), and 3746 (Model
900)

Table 10 (Page 1 of 6). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

This customer documentation has the following formats:

B o o k s

O n l i n e B o o k s
and

D i s k e t t e s

Books
and

CD-ROM

Finding Information

3745 Models A and 3746 Books

All of the books in the 3745 Models A and 3746 library are available on the
CD-ROM that contains the Licensed Internal Code (LIC) for the machine.

Evaluating and Configuring

GA33-0092 IBM 3745 Communication Controller
Models 210, 310, 410, and 610

Introduction

Gives an introduction of the IBM Models 210 to 610 capabilities.

For Models A, refer to the Overview, GA33-0180.

GA33-0180 IBM 3745 Communication Controller Models A and 170²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Overview

Gives an overview of connectivity capabilities within SNA, APPN, and IP
networking.

GA27-4234 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Overview, Installation, and Integration

Provides information for:

� Overall 3746 planning
� Installation and upgrade scenarios
� Controller and service processor network integration
� Related MOSS-E and CCM worksheets for these tasks.
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Table 10 (Page 2 of 6). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

GA27-4235 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Serial Line Adapters

Provides information for:

� Serial line adapter descriptions
� Serial line adapter line weights and connectivity
� Types of SDLC support
� Configuring X.25 lines
� Performance tuning for frame-relay, PPP, X.25, and NCP lines.
� ISDN adapter description and configuration.

GA27-4236 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Token Ring and Ethernet

Provides information for:

� Token-ring adapter description and configuration
� Ethernet adapter desription and configuration.

GA27-4237 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
ESCON Channels

Provides information for:

� ESCON adapter descriptions
� ESCON configuration and tuning information
� ESCON configuration examples.

GA27-4238 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Physical Planning

Provides information for:

� 3746 and MAE physical planning details
� 3746 and MAE cable information
� Explanation of installation sheets
� 3746 plugging sheets.
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Table 10 (Page 3 of 6). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

GA27-4239 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Management Planning

Provides information for:

� Overview for 3746
� 3746 APPN/HPR, IP router, and X.25
� NetView Performance Monitor (NPM), remote consoles, and RSF
� MAE APPN/HPR management.

GA27-4240 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Multiaccess Enclosure Planning

Provides information for:

� MAE adapters details
� MAE ESCON planning and configuration
� ATM and ISDN support.

GA27-4241 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Protocols Description

Provides information for:

� Overview and details about APPN/HPR and IP.

On-line information IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Planning Series:
Controller Configuration and Management Worksheets

Provides planning worksheets for ESCON, Multiaccess Enclosure, serial line,
and token-ring definitions.

Preparing Your Site

GC22-7064 IBM System/360, System/370, 4300 Processor

Input/Output Equipment Installation Manual-Physical Planning
(Including Technical News Letter GN22-5490)

Provides information for physical installation for the 3745 Models 130 to 610.

For 3745 Models A and 3746 Model 900, refer to the Planning Guide,
GA33-0457.
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Table 10 (Page 4 of 6). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

GA33-0127 IBM 3745 Communication Controller
Models 210, 310, 410, and 610

Preparing for Connection

Helps for preparing the 3745 Models 210 to 610 cable installation.

For 3745 Models A refer to the Connection and Integration Guide, SA33-0129.

Preparing for Operation

GA33-0400 IBM 3745 Communication Controller All Models³
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Safety Information¹

Provides general safety guidelines.

SA33-0129 IBM 3745 Communication Controller All Models³
IBM 3746 Nways Multiprotocol Controller Model 900

Connection and Integration Guide¹

Contains information for connecting hardware and integrating network of the
3745 and 3746-900 after installation.

SA33-0416 Line Interface Coupler Type 5 and Type 6
Portable Keypad Display

Migration and Integration Guide

Contains information for moving and testing LIC types 5 and 6.

SA33-0158 IBM 3745 Communication Controller All Models³
IBM 3746 Nways Multiprotocol Controller Model 900

Console Setup Guide¹

Provides information for:

� Installing local, alternate, or remote consoles for 3745 Models 130 to 610
� Configuring user workstations to remotely control the service processor for

3745 Models A and 3746 Model 900 using:
 – DCAF program
– Telnet Client program
– Java Console support.

Customizing Your Control Program

SA33-0178 Guide to Timed IPL and Rename Load Module

Provides VTAM procedures for:

� Scheduling an automatic reload of the 3745
� Getting 3745 load module changes transparent to the operations staff.

Operating and Testing
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Table 10 (Page 5 of 6). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

SA33-0098 IBM 3745 Communication Controller
All Models⁴

Basic Operations Guide¹

Provides instructions for daily routine operations on the 3745 Models 130 to
610.

SA33-0177 IBM 3745 Communication Controller Models A²
IBM 3746 Nways Multiprotocol Controller Model 900

Basic Operations Guide¹

Provides instructions for daily routine operations on the 3745 Models 17A to
61A, and 3746 Model 900 operating as an SNA node (using NCP),
APPN/HPR Network Node, and IP Router.

SA33-0097 IBM 3745 Communication Controller
All Models³

Advanced Operations Guide¹

Provides instructions for advanced operations and testing, using the 3745
MOSS console.

On-line Information Controller Configuration and Management Application

Provides a graphical user interface for configuring and managing a 3746
APPN/HPR Network Node and IP Router, and its resources.
It is also available as a stand-alone application, using an OS/2 workstation.
Defines and explains all the 3746 Network Node and IP Router configuration
parameters through its online help.

SH11-3081 IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Controller Configuration and Management: User's Guide⁵

Explains how to use CCM and gives examples of the configuration process.

GA33-0479 IBM 3745 Communication Controller Models A
IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

NetView Console
APPN Command Reference Guide

Explains how to use the RUN COMMAND from the NetView S/390 Program
and gives examples.

Managing Problems

SA33-0096 IBM 3745 Communication Controller
All Models³

Problem Determination Guide¹

A guide to perform problem determination on the 3745 Models 130 to 61A.
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Table 10 (Page 6 of 6). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

On-line Information Problem Analysis Guide

An online guide to analyze alarms, events, and control panel codes on:

� IBM 3745 Communication Controller Models A²
� IBM 3746 Nways Multiprotocol Controller Models 900 and 950.

SA33-0175 IBM 3745 Communication Controller Models A²
IBM 3746 Expansion Unit Model 900
IBM 3746 Nways Multiprotocol Controller Model 950

Alert Reference Guide

Provides information about events or errors reported by alerts for:

� IBM 3745 Communication Controller Models A²
� IBM 3746 Nways Multiprotocol Controller Models 900 and 950.

¹ Documentation shipped with the 3745.
² 3745 Models 17A to 61A.
³ 3745 Models 130 to 61A.
⁴ Except 3745 Models A.
⁵ Documentation shipped with the 3746-900.
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Additional Customer Documentation for the 3745 Models 130, 150, 160,
170, and 17A

Table 11. Additional Customer Documentation for the 3745 Models 130 to 17A

This customer documentation has the following format:

B o o k s

Finding Information

3745 Models A and 3746 Books

All of the books in the 3745 Models A and 3746 library are available on the
CD-ROM that contains the Licensed Internal Code (LIC) for the machine.

Evaluating and Configuring

GA33-0138 IBM 3745 Communication Controller
Models 130, 150, 160, and 170

Introduction

Gives an introduction about the IBM Models 130 to 170 capabilities, including
Model 160.

For Model 17A refer to the Overview, GA33-0180.

Preparing Your Site

GA33-0140 IBM 3745 Communication Controller
Models 130, 150, 160, and 170

Preparing for Connection

Helps for preparing the 3745 Models 130 to 170 cable installation.

For 3745 Model 17A refer to the  Connection and Integration Guide,
SA33-0129.

¹ Documentation shipped with the 3745.
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List of Abbreviations

APPN Advanced Peer-to-Peer Networking

ARP address resolution protocol

AS autonomous system

BGP border gateway protocol

BLPU build logical program unit

BRS bandwidth reservation

CCM Controller Configuration and Management

CCU central control unit

CDF-E configuration data file - extended

CHPID channel path id

CIR committed information rate

COS class of service

CP control point

CUD call user data

DCE data circuit-terminating equipment

DCAF Distributed Console Access Facility

DLC data link control

DLCI data link connection identifier

DLUR dependent logical unit requester

DLUS dependent logical user server

DTE data terminal equipment

EC engineering change

ECA engineering change announcement

EGA ESCON Generation Assistant

EMIF ESCON Multiple Image Facility

ESCC ESCON channel coupler

ESCD ESCON Director

ESCON Enterprise Systems Connection

ESCP ESCON channel processor

FRFH frame-relay frame handler

HCD Hardware Configuration Definition

HPR high performance routing

I/O input or output, input and output

IDF Internet definition file

IML initial microcode load

IOC input/output control

IOCP Input/Output Configuration Program

IP Internet Protocol, internetwork protocol

IPCP 

IPL initial program load

ISDN integrated services digital network

LAN local area network

LAPB link access protocol - balanced

LC logical channel

LCP link control protocol

LCN logical channel number

LEN low entry networking

LIC line interface coupler

LLC logical link control

LMI local management interface

LU logical unit

MAC medium access control

MAE multiaccess enclosure

MB megabyte (processor storage)
1MB = 220 (1 048 576 bytes)

MLTG multilink transmission group

MOSS-E maintenance and operator subsystem -
extended

MVS Multiple Virtual Storage

NAK negative acknowledgement

NAU network accessible unit

NCP Network Control Program

NDF network definition file

NNP network node processor

NPA NetView Performance Analyzer

NPI numbering plan identification

NPM Network Performance Monitor

OSPF open shortest path first

PLP packet level protocol

PPP point-to-point protocol

PR/SM processor resource/systems manager

PVC permanent virtual circuit

QLLC qualified logical link control

RAM random access memory

RAR route addition resistance

RCPB relative cost per byte

RCPUT relative cost per unit of time
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RIF routing information field

RIP routing information protocol

RTP rapid transport protocol

SATF shared access transport facility

SBS subset

SDLC synchronous data link control

SNA Systems Network Architecture

SNMP simple network management protocol

SOC sphere of control

SVC switched virtual circuit

TCP transmission control protocol

TG transmission group

TOA type of address

TRP token-ring processor

TRS transmission control protocol

TTL time to live

UDP user datagram protocol

VC virtual circuit

VGA video graphics adapter

VTAM Virtual telecommunications Access
Method
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 Glossary

This glossary explains some of the terms used in this
guide.

A
action bar.  Also known as the menu bar. The area at
the top of the primary window containing selectable
keywords that gives the user access to actions in that
window. When the user selects a keyword on the
action bar, a pull-down menu is displayed.

action bar pull-down menu.  An extension of the
action bar that displays a list of choices related to the
keyword that was selected on the action bar. Also
known as a menu.

assigned focal point.  A focal point where a SOC
(sphere of control) is included, by explicit definition at
the focal point or the SOC node. If a node’s inclusion
in the SOC is defined at the focal point, the focal point
is known as an explicit focal point for that SOC node. If
a node’s inclusion in the SOC is defined at the SOC
node, the focal point is known as an implicit focal point
for that node.

B
backup focal point.  A focal point that provides
specific management services for a node if
communications with the primary focal point fail. Both
of the assigned focal points (explicit and implicit) and
the default focal points can also have backup
counterparts.

C
Channel Path Identifier.  The address assigned to
each installed channel path of a system which uniquely
identifies that path. The CHPID is “connected” either to
a Host Link Address on an ESCD or directly to an
ESCC (if there is no ESCON Director).

connection network.  A representation within an
APPN network of a shared access transport facility
(SATF), such as a token-ring, that allows nodes
identifying their connectivity to the SATF by a common
virtual routing node, to communicate without having
individually defined connections to one another.

D
default focal point.  A focal point that provides
management services for nodes that have not been
assigned a focal point. The set of nodes in the SOC
(sphere of control) of a default focal point is not defined
at the focal point itself, or at the SOC nodes. A default
focal point exchanges management services with all the
network nodes known to it. Only those nodes that have
not established a relationship with another focal point
can accept the request.

E
ESCON Multiple Image Facility.  A host mode that
allows ESCON channels to be shared across PR/SM
logical partitions.

ESCON Channel Coupler.  This is a communication
controller that provides the interface between the
ESCON channel processor (ESCP) and the ESCON
fiber optic cable.

Only one ESCC can be defined for each ESCP. It must
be installed in the leftmost slot of the ESCP.

All ESCCs of the communication controller must be
defined in the same subset.

ESCON Director.  This is a switching device that can
be attached to processors with ESCON channels and to
ESCON control units. It permits dynamic channel link
switching.

Enterprise System Connection..  A set of IBM
networking communications products that use fiber-optic
technology.

ESCON Channel Processor.  This is a
communications controller that provides the channel
data link control for the ESCON channel adapter.

I
IOCP.  Input/Output Control Program, defines and
controls all the available I/O devices and channel paths.

IPL port.  Initial Program Load port
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L
LEN node.  Low entry networking node. A node that
supports independent LU protocols but which does not
support CP-CP sessions. LEN nodes can be one of the
following:

� A peripheral node attached to a boundary node in a
subarea network

� An end node attached to an APPN network node in
an APPN network

� A peer connected node directly attached to another
LEN node or APPN end node

link station.  1) The hardware and software
components in a node that represent the connection to
an adjacent node over a specific link. For example, if
node A is the primary end of a multipoint line that
connects to three adjacent nodes, node A will have
three link stations representing the connections to the
adjacent nodes.

2) In VTAM, a named resource within an APPN or
subarea node that represents the connection to another
APPN or subarea node which is attached by an APPN
or subarea link. In the resource hierarchy in a subarea
network, the link station is subordinate to the subarea
link.

LU.  Logical unit. A network accessible unit (NAU) that
enables users to access network resources and to
communicate with other users.

LU-LU session.  Logical unit-logical unit session. A
logical connection between two logical units in a
network that provides communication capabilities for
two users.

LU name.  Logical unit name.

M
Medium access control.  The sub-layer of the data
link control layer that supports medium dependent
functions and which uses the services of the physical
layer to provide services to the logical link control (LLC)
sub-layer. The MAC sub-layer includes the process for
determining when a device has access to the
transmission medium.

Maintenance and Operator Subsystem - Extended.
A licensed, internal program which resides on the
service processor’s hard disk. It is designed to provide
system maintenance and operation functions for
end-users or IBM service representatives.

N
network identifier.  Part of a network address that
defines the network. The network ID is a 1 to 8 byte
name selected by the user or an 8 byte IBM registered
name that uniquely identifies a specific subnetwork.

network node.  A node that offers a broad range of
end user services. An APPN network node can provide
distributed directory services, optimal routing, session
services and intermediate routing services.

P
port.  An access point for data entry or exit which is
also the representation of a physical connection to the
link hardware.

primary focal point.  The central control point for any
management services element which is responsible for
handling the network management data.

primary window.  The top level window in an
application program that can be minimized or
represented by an icon.

S
Synchronous Data Link Control.  A process that
manages synchronous, code-transparent, serial-by-bit
data transfer over a link connection. Data transmission
can be duplex or half duplex over switched or
nonswitched links. The link connection can be
configured as point-to-point, multipoint or loop.

secondary window.  A window that can be moved and
sized. Secondary windows are always associated with
a primary window.

SNA network.  The part of a user application network
that conforms to the SNA formats and protocols. It
enables reliable transfer of data among end users and
provides protocols for controlling the resources of the
network.

station.  The input or output point of a system that
uses telecommunications facilities; for example, one or
more systems, computers, terminals, devices, and
associated programs at a particular location that can
send or receive data over a telecommunication line.

subarea.  A portion of the SNA network consisting of a
subarea node, attached peripheral nodes, and
associated resources. Within a subarea node, all
network accessible units (NAUs), links, and adjacent
link stations (in attached peripheral or subarea nodes)
that are addressable within the subarea, share a
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common subarea address and have distinct element
addresses.

subset.  The part of an EGA (ESCON Generation
Assistant) output file which is specific to all ESCON
channel adapters on a communications controller. this
information is placed in the EGA .SDS output file.
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 Index

Numerics
2080, configuring station(s) for 59
3745/3746

information 125
parameters 58

A
activate a configuration 18
APPN parameters

general 123
backup focal point 124
coupler/port 2080 stations 125
network node characteristics 124
network nodes, focal points, DLURs 124
rapid transport protocol/path switch 124

specific
adjacent node remote LUs 126
COS 126
MLTG 127
node rows 126
session mode COS 126
specifying MLTG stations 127
TG rows 127

B
becoming familiar with the main panel 10
beginning a CCM configuration 57
BGP view commands 170

active neighbors 170
path description database 170
routing table 170
size of BGP databases 170

buttons 23

C
CCM 8

installing 5
levels 5
main panel 10
password 8
product information 8
starting in the service processor 9
stopping and exiting 9

CCM configuration, remote workstation 35
CCM remote “light” configuration application

requirements 48
CCM remote “light” configuration application on

OS/2 48

CCM remote configuration application
activating a configuration 45
checking a configuration 44
commands 46
connecting to a service processor 42
connecting to the server 42
creating a configuration 44
downloading the files 43
extracting the ASCII files 44
interactive mode 45
listing the files 43
local environment 43
options 171
remote environment 43
requirements 40
script commands 171
script mode 45
selecting a controller 42
starting the application 42
starting the server 42
uploading a configuration 45
variables 171

CCM remote configuration application on AIX 40
CDF-E 30

clearing coupler type 32
loading 33
setting coupler type 32

changes since last edition xvii
comparing CCM configuration with reference

CDF-E 31
comparing reference CDF-E to CCM configuration 31
configuration 26

activate 18
activation 29
beginning 57
copy 18
create 17
create in service processor 20

service processor environment 20
create in Stand-alone 21

stand-alone environment 21
creating a new 26
creation in different environments 19
export/import 18
generic tasks 26
importing CCM 28
importing ESCON 26
migration 29
modify 17
open and modify 28
saving to diskette 29
saving to hard disk 29
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configuring 115
controller 18
ESCON coupler 61
IP parameters 115

access controls 116
areas 118
ARP 121
BGP aggregate routes 121
BGP general and excluded AS parameters 120
BGP neighbors 121
BGP originate policies 121
BGP receive policies 120
BGP send polices 120
bootp forwarding parameters 116
enable SNMP access to service LAN while

filtering packets 122
filters 116
general 115
OSPF general and multicast parameters 117
OSPF imported and default routes 118
OSPF parameters for each IP address 117
OSPF virtual links 118
PPP NCP default 115
RIP general parameters 119
RIP parameters for each IP address 119
SNMP 121
static routes 116

MAE resources
serial line coupler 77
serial line coupler for frame relay 83
serial line coupler for PPP 95
stations on 2080 59
token-ring coupler 69
with CCM 15
X.25 resources

configuring MAE 107
controller configuring 18
copy

configuration 18
resources 23

coupler icons 11, 12
create a configuration 17

D
DCAF 35
different environments, configuration creation 19
dynamic activation 131

after adding a resource 134
after deleting a resource 137
after modifying a resource 134
after viewing a resource 133
dynamically activating modifications while

saving 131
network traffic disruption 133

E
environment

operating 4
service processor 4
stand-alone 4

ESCON coupler configuration 61
ESCON station parameters 65
host link parameters 64
port APPN parameters 64
port IP parameters 67
port parameters 61
station APPN parameters 65

exiting from CCM 9
export/import a configuration 18

F
frame-relay configuration 83

acknowledgement timer 92
APPN station parameters 91
configuring APPN over frame-relay stations 91
configuring FRFH sets 94
defining a DLCI with CIR 89
defining DLCI using COMRATE 88
defining DLCIs and stations 88
discard eligibility 92
inactivity timer 92
IP over frame relay 86
number of retries 92
panel decrement (DYNWIND dwc) 92
panel increment (DYNWIND - nw) 92
port APPN parameters 84
port DLC parameters 84
port parameters 83
reply timer 92
station DLC parameters 92

frame-relay frame handler set configuration 125

G
general IP commands 166

dump router routing table 166
pinging 166
restart IP router 166
tracing the route to a resource 167
viewing

route to a resource 167

H
hardware requirements 4
header information 10
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I
icons, coupler 11, 12
information area 12
installing

CCM 5
CCM in service processor environment 8
CCM in stand-alone environment 8

IP resource status 145
possible IP resource statuses 146
related MOSS-E IP commands 146

IP-specific port/processor commands 153
available commands depend on IP resource

DLC 154
CCM IP results display 154
clearing ARP statistics 161
clearing statistics 160
find frame-relay DLCI IP address 159
general port statistics 160
PPP

error information 160
IP control protocol statistics 160
link control protocol information 159
link IP information 160

view
all parameters of a X.25 port 156
all statistics for an interfaces 158
all X.25 port statistics 157
ARP cache 162
ARP registered address protocols 162
ARP registered networks 162
current processor memory use 155
error information 156
ESCON and token-ring port dumps 155
frame-relay physical line parameters 158
frame-relay port COMRATE parameters 158
interface information 157
interface queue length 155
IP access controls 161
IP control protocol information 159
IP counters 161
IP routing table cache 161
LMI information 158
packet buffer use and size 155
processor up-time statistics 160
protocol and port configurations 155
router IP addresses 161
router status information 160
statistics about ARP 162
statistics for a DLCI 158
SVC information 159
X.25 frame level port parameters 156
X.25 frame level port statistics 157
X.25 IP address table 159
X.25 packet level port parameters 156
X.25 packet level port statistics 157
X.25 physical level port parameters 156

IP-specific port/processor commands (continued)
view (continued)

X.25 physical level port statistics 157
X.25 PVC information 159

J
Java console 35

M
MAE 107

configuration panel 110
configure menu 109
navigating through the MAE configuration

program 112
navigation panel 108
options menu 108
pop-up menu 109
selecting multiple items in a list 114
understanding the navigation and configuration

panels 107
using the keyboard 113
using the mouse 112

main panel
becoming familiar with 10
CCM 10, 12
menu choices 12
working in 12

managing IP router resources 165
menu 10

choices in main panel 12
pull-down 13

modify a configuration 17
MOSS-E aping 164

O
online help 23, 25
operating environments 4
OSPF commands 167

adding router to multicast group 168
changing cost of an OSPF interface 169
removing router from multicast group 168
viewing

area 167
area link state database 168
AS-external information 167
details of active OSPF neighbors 169
interface statistics 168
link state advertisement 167
link state advertisement database statistics 169
multicast cache 168
OSPF multicast routing statistics 169
OSPF router routes 169
OSPF routing statistics 169
router OSPF membership groups 168
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P
PPP configuration 95

bandwidth reservation 96
port parameters 95

pull-down menus 13
pushbuttons

cancel 25
copy 23
modify 24
save as defaults 24
search 23
sort 23

R
remote workstation 35, 40, 48

CCM configuration 35
CCM remote “light” configuration application on

OS/2 48
CCM remote configuration application on AIX 40

requirements, hardware and software 4
resource management 139

managing ports 141
activate/deactivate 143
details of a port 142
port list 141
resource list 141

managing stations 148
activate/deactivate 149
session list 149
station details 149
station list 148

using resource filters 140

S
screen resolution, 600x800 107
SDLC configuration 77

port 77, 78, 79
APPN parameters 78
DLC parameters 79
parameters 77

station 80, 81
APPN parameters 81
parameters 80

searching resources 23
serial line coupler X.25 configuration 99

APPN 100
DLC 100
IP over X.25 port 101
LAPB 101
PLP 101
port parameters 99

service processor
environment 4
installing CCM in 8

service processor (continued)
starting CCM 9

session display 152
software requirements 4
sorting resources 23
stand-alone environment 4

installing CCM in 8
starting CCM

in service processor environment 9
in stand-alone environment 9
new configuration 58

station parameters 103
stopping and exiting from CCM 9

T
token-ring coupler configuration 69

port
APPN parameters 70, 73
connection network parameters 72
DCL parameters 71
DLC parameters 74
IP parameters 70
parameters 69

station parameters 73

U
user interface 10

V
viewing 139, 163

available configurations 27
BGP active neighbors 170
BGP path description database 170
BGT routing table 170
configuration 27
connection networks 164
details of active OSPF neighbors 169
HPR connections 164
MOSS-E aping 164
network directories 163
network nodes 163
network topology 163
OSPF area link state database 168
OSPF AS-external information 167
OSPF interface statistics 168
OSPF link state advertisement database

statistics 169
OSPF membership groups 168
OSPF multicast cache 168
OSPF multicast routing statistics 169
OSPF router routes 169
OSPF routing statistics 169
OSPF.area 167
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viewing (continued)
OSPF.link state advertisement 167
product information for CCM 8
route to an IP resource 167
router routing tabledump 166
size of BGP databases 170

W
what you can do with a CCM configuration 17
working in the main panel 12
worksheets 23

Y
Year 2000

microcode levels required xvii
readiness xvii
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3746 Nways Multiprotocol Controller
Models 900 and 950
(For CCM Version F64810)
Controller Configuration
and Management
User's Guide

Publication No. SH11-3081-08

We hope you find this publication useful, readable, and technically accurate, but only you can tell us!
Your comments and suggestions will help us improve our technical publications. Please take a few
minutes to let us know what you think by completing this form. If you are in the USA, you can mail this
form postage free or fax it to us at 1-800-253-3520. Elsewhere, your local IBM branch office or
representative will forward your comments or you may mail them directly to us.
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